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FOREWORD

The National Curriculum Framework (NCF), 2005, recommends that
children’s life at school must be linked to their life outside the school.
This principle marks a departure from the legacy of bookish learning
which continues to shape our system and causes a gap between the
school, home and community. The syllabi and textbooks developed on
the basis of NCF signify an attempt to implement this basic idea. They
also attempt to discourage rote learning and the maintenance of sharp
boundaries between different subject areas. We hope these measures
will take us significantly further in the direction of a child-centred
system of education outlined in the National Policy on Education (1986).

The success of this effort depends on the steps that school princi-
pals and teachers will take to encourage children to reflect on their
own learning and to pursue imaginative activities and questions. We
must recognise that, given space, time and freedom, children generate
new knowledge by engaging with the information passed on to them by
adults. Treating the prescribed textbook as the sole basis of examina-
tion is one of the key reasons why other resources and sites of learning
are ignored. Inculcating creativity and initiative is possible if we per-
ceive and treat children as participants in learning, not as receivers of
a fixed body of knowledge.

These aims imply considerable change in school routines and mode
of functioning. Flexibility in the daily time-table is as necessary as
rigour in implementing the annual calendar so that the required num-
ber of teaching days are actually devoted to teaching. The methods
used for teaching and evaluation will also determine how effective this
textbook proves for making children’s life at school a happy experi-
ence, rather than a source of stress of boredom. Syllabus designers
have tried to address the problem of curricular burden by restructur-
ing and reorienting knowledge at different stages with greater consid-
eration for child psychology and the time available for teaching. The
textbook attempts to enhance this endeavour by giving higher priority
and space to opportunities for contemplation and wondering, discus-
sion in small groups, and activities requiring hands-on experience.

The National Council of Educational Research and Training (NCERT)
appreciates the hard work done by the textbook development commit-
tee responsible for this book. We wish to thank the Chairperson of the
advisory group in Social Sciences Professor Hari Vasudevan and the
Chief Advisor for this book, Professor G.C. Maheshwari, Dean, Institute
of Management Studies, M.S. University Baroda for guiding the work of
this committee. Several teachers contributed to the development of this
textbook; we are grateful to their principals for making this possible.
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We are indebted to the institutions and organisations which have gen-
erously permitted us to draw upon their resources, material and per-
sonnel. We are especially grateful to the members of the National Moni-
toring Committee, appointed by the Department of Secondary and Higher
Education, Ministry of Human Resource Development under the
Chairpersonship of Professor Mrinal Miri and Professor G.P. Deshpande,
for their valuable time and contribution. As an organisation is com-
mitted to the systemic reform and continuous improvement in the qual-
ity of its products, NCERT welcomes comments and suggestions which
will enable us to undertake further revision and refinement.

Director

New Delhi National Council of Educational
December 2009 Research and Training
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OVERVIEW OF

COMPUTERISED

ACCOUNTING SYSTEM

Introduction
After studying this chapter you will be

able to:

• Understand the need of

Computerised Accounting

System.

• Appreciate the impact of

Information Technology on

Financial Accounting System.

• Describe the major

functions of Accounting

Information System (AIS).

1

In modern business accounting transactions are
processed through computers. Usage of computers
and Information Technology (IT) enables a business
to quickly, accurately and timely access the
information that helps in decision-making. This
sharpens the competitive edge and enhances
profitability.  The computer systems (Figure 1.1)
works with the data which is processed by the
hardware commanded by the user through
software. The Computerised Accounting System
(CAS) has the following components:

Procedure : A logical sequence of actions to
perform a task.

Data : The raw fact (as input) for any
business application.

People : Users.

Hardware : Computer, associated peripherals,
and their network.

Software : System software and Application
software.

These are the five pillars on which Computerised
Accounting System rests. This chapter discusses
the concept and components of CAS alongwith its
advantages and disadvantages. It is followed by
the discussion of software packages on CAS.  In
this chapter we will also discuss the concept about
grouping of accounts and codification methods to
be used for CAS.
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Computerised Accounting System

1.1 COMPUTERISED ACCOUNTING SYSTEM

Computerised Accounting System refers to the processing of accounting
transaction through the use of hardware and software in order to
produce accounting records and reports. CAS takes accounting

transactions as inputs that are processed through Accounting Software
to generate the following reports:

• Day books/Journals

• Ledger

• Trial Balance

• Position Statement (Balance Sheet)

• Statement of Profit and Loss (Profit and Loss Account)

          Basic flow of Accounting Transaction

Figure 1.2 :::::  Data to Information by Business Application Software

Figure 1.1 :  Components of Computer
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3

The transaction transaction transaction transaction transaction is a record of inflow and outflow of resources.

Data and Information

Various elements (items) of accounting transactions are essentially
the data items, which are processed through an accounting software
to generate different sets of information in the form of accounting reports
such as journals, ledger, etc.

A data-item (data element) is the smallest named unit of data in
the information system. In accounting, a transaction consists of four
data elements, such as name of account, accounting code, date of
transaction and amount.

We may observe (Figure 1.3) how data (days worked and rate per day)
is being (multiplied together) converted into information (amount to
pay). The information may be viewed as data at one level; and when it
is processed keeping in view the requirements of decision maker, it
becomes the information at another level.

1.2 COMPONENTS OF CAS

The manual system of accounting is
traditionally most popular method of keeping
records of financial transactions of an
organisation. Financial statements are the end
products of the accounting process, which are
prepared in accordance with Genera l lyGenera l lyGenera l lyGenera l lyGenera l ly

Accepted Accounting PrinciplesAccepted Accounting PrinciplesAccepted Accounting PrinciplesAccepted Accounting PrinciplesAccepted Accounting Principles (GAAP)(GAAP)(GAAP)(GAAP)(GAAP). The
accounting cycle means the processes involved
in identifying, measuring and communicating
the information. The basic phases of the cycle
are as follows:

• Business transactions are analysed.

• The transactions are recorded in the journal.

• Journal entries are posted to the ledger accounts.

• A trial balance is prepared from balances of accounts.

• Accounts are reviewed and the necessary adjustments made.

• Adjustments are posted in the ledger to prepare adjusted trial
balance.

• Adjusted trial balance is used to prepare the balance sheet and
profit and loss account.

• Financial Statements are prepared from the finally adjusted ledger
and balancing the accounts.

The above accounting cycle can be processed through the use of
computers.

Figure 1.3
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Computerised Accounting System

1.3 SALIENT FEATURES OF CAS

Following are the salient features required for CAS software:

1.3.1 SIMPLE AND INTEGRATED

CAS is designed to automate and integrate all the business operations,
such as sales, finance, purchase, inventory and manufacturing. CAS
is integrated to provide accurate, up-to-date business information
rapidly. The CAS may be integrated with enhanced MIS (Management
Information System), Multi-lingual and Data Organisation capabilities
to simplify all the business processes of the organisation easily and
cost-effectively.

1.3.2 TRANSPARENCY AND CONTROL

CAS provides sufficient time to plan, increases data accessibility and
enhances user satisfaction. With computerised accounting, the
organisation will have greater transparency for day-to-day business
operations and access to the vital information.

1.3.3 ACCURACY AND SPEED

CAS provides user-definable templates (data entry screens or forms)
for fast, accurate data entry of the transactions. It also helps in
generalising desired documents and reports.

1.3.4 SCALABILITY

CAS enables in changing the volume of data processing in tune with
the change in the size of the business. The software can be used for
any size of the business and type of the organisation.

1.3.5 RELIABILITY

CAS makes sure that the generalised critical financial information is
accurate, controlled and secured.

1.4 GROUPING OF ACCOUNTS

The increase in the number of transaction changes the volume and
size of the business. Therefore it becomes necessary to have proper
classification of data. The basic classifications of different accounts
embodied in a transaction are resorted through accounting equation.

Accounting Equation

The modern accounting is based on double-entry system, which implies
equality of assets and equities (liabilities and capital), i.e.

A = E

Where E = L + C

Now A = L + C

Where A = Assets
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E = Equities

C = Capital

L = Liabilities

Thus, Assets = Liabilities + Capital

In this equation the Liabilities means claims on the firm by creditors

and the Capital means claims of owners.  The claims of owners keep on
changing due to success (profit) or failure (loss) of the firm. This is
reflected by the income statement, which provides the summary of
income and expenses of business for a given accounting period. Keeping
this in view, the above equation can be re-written as:

Assets = Liabilities + Capital + (Revenues – Expenses)

Each component of the above equation can be divided into groups of
accounts as follows:

• EQUITY AND LIABILITIES

 Shareholder’s Funds

 Share Capital

 Reserves and Surplus

 Money Received against Share Warrents

 Share Application Money Pending Allotment

 Non-Current Liabilities

 Long Term Borrowings

 Deferred Tax Liabilities (net)

 Other Long Term Liabilities

 Long Term Provisions

 Current Liabilities

 Short Term Borrowings

 Trade Payables

 Other Current Liabilities

 Short Term Provisions

RevenueRevenueRevenueRevenueRevenue means inflow of resources, which results from the sale of goods or

services in the normal course of business and increase in capital. Expenses

imply consumption of resources in generating revenues.
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Computerised Accounting System

• ASSETS

1. Non-Current Assets

 Fixed Assets

 Tangible Assets

 Intangible Assets

 Capital Work-in-Progress

 Intangible Assets Under Development

 Fixed Assets held for Sales

 Non Current Investments

 Deferred Tax Assets (net)

 Long Term Loans and Advances

 Other Non-Current Assets

2. Current Assets

 Current Investments

 Inventories

 Trade Receivables

 Cash and Cash Equivalents

 Short Term Loans and Advances

 Other Current Assets

• REVENUES

 Sales

 Other Income

• EXPENSES

 Material Consumed

 Salary and Wages

 Manufacturing Expenses

 Depreciation

 Administrative Expenses

 Interest

 Selling and Distribution Expenses

There is a hierarchical relationship between the groups and its
components. In order to maintain the hierarchical relationships between
a group and its sub-groups, proper codification is required to ensure
neatness of classification.

1.4.1 CODIFICATION OF ACCOUNTS

According to Concise Oxford Dictionary, the term code means “a system
of letter or figure with arbitrary meaning for brevity and for machine
processing of information”. Thus, code is an identification mark.

2018-19
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Method of Codification

The coding scheme of Account-heads should be such that it leads to
grouping of accounts at various levels so as to generate Position Statement
(Balance Sheet) and Statement of Profit and Loss (Profit-Loss Account).
For example, we may allot the codes for top-level grouping of accounts
(forming the 1st digit of the Account Code) as follows:

1 Equity and Liabilities

2 Assets

3 Revenues

4 Expenses

Under Equity and : 11 Shareholder’s funds

Liabilities 13 Non-Current Liabilities

14 Current Liabilities

Under Assets : 21 Non-Current Assets

23 Current Assets

Note: The gap in code in the 2nd digit2nd digit2nd digit2nd digit2nd digit (e.g. after 1, 3 instead of 2) is used to provide

flexibility.

The above codification scheme utilizes the hierarchy present (used)
in grouping of accounts. Major advantage of such coding is that if the
account codes are listed in ascending (i.e. increasing) order, these will
be automatically listed as per the desired hierarchy.

1.4.1.1 Sequential Codes

In Sequential Code, numbers and/or letters are assigned in consecutive
order. These codes are applied primarily to source documents such as
cheques, invoices, etc. A sequential code can facilitate document
searches. This process enables in either identification of missing codes
(numbers) relating to a particular document or a relevant document
can be traced on the basis of code.

For examples:

CODES ACCOUNTS

CL001 GCERT LTD

CL002 XYZ LTD

CL003 ARIL CORPORATION OF INDIA

1.4.1.2 Block Codes

In a block code, a range of numbers is partitioned into a desired number
of sub-ranges and each sub-range is allotted to a specific group. In
most of the uses of block codes, numbers within a sub-range follow
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Computerised Accounting System

sequential coding scheme, i.e. the numbers increase consecutively.
As an example, dealer codes for a trading firm could be as follows:

CODES DEALER-TYPE

 100 - 199 Small Pumps

 200 - 299 Medium Pumps

 300 - 399 Pipes

 400 - 499 Motors

1.4.1.3 Mnemonic Codes

A mnemonic code consists of alphabets or abbreviations as symbols to
codify a piece of information. SJ for “Sales Journals”, HQ for “Head
Quarters” are examples of mnemonic codes. Another common example
is the use of alphabetic codes in Railways in identifying railway stations
such as DLH for Delhi, NDLS for New Delhi, BRC for Baroda, etc.

1.4.2 METHODOLOGY TO DEVELOP CODING STRUCTURE AND CODING

Let us assume that we have to do coding for students in one of seven
schools run by a trust. The first step is to develop a coding structure
(scheme), which will be used to develop individual codes for each
student. Development of coding structure requires identification
(finalisation) of hierarchy of schooling system and that of various
attributes (parameters) associated with a student. A hierarchy in such
a situation could be as follows:

Trust →→→→→ School →→→→→ Entry-year →→→→→ Stream →→→→→ Class →→→→→ Section →→→→→ Student

The “Stream” could be science stream, commerce stream or general
Stream. A class may be divided into more than one section when the
number of admitted students increases the class capacity. We can
decide the coding structure after the following considerations:

• As there is only one Trust, no provision is required in the coding
structure to accommodate for Trust. Had there been multiple trusts
under one organisation running a number of schools, the provision
of Trust code would have been necessary in the coding structure.

• Assuming that the maximum number of Schools is not likely to
exceed 99, we can allocate 2 digits for School.

• Two digits can be allocated for the Entry-year. Entry-year is
necessary to maintain records of old students.

• For Stream, 1 digit is sufficient. If Stream is not relevant
(applicable) as is the case for primary and secondary classes, the
value 0 will be considered for Stream.

• To accommodate Classes, 2 digits are sufficient.
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• Number of Sections in a class will not exceed 9. Hence, 1 digit is
sufficient for Section.

• Two digits will be sufficient for number of Students within a section
of a class, assuming that not more than 99 Students will ever be
put in a section of a class.

The coding structure for Students will be as follows based on the
above considerations:

School 2 Digits

Entry-year 2 Digits

Stream 1 Digit

Class 2 Digits

Section 1 Digit

Student 2 Digits

Thus, if we allocate 10 digits codes to a student, we shall be able to
get the following details of a student right from the code itself :

• Which stream in which school the student is studying (had studied)?

• What were the class and its section and in which year the student
had entered this class?

• List of all students who has entered a school in a given year, etc.

Once the coding structure is decided as described above, allotting
of code becomes easy. For example, if a student with a Roll No. 54 had
entered Section-B of Class XII in Year 2008 opting for Science Stream
(Non-Biology Group) (Stream Code: 1) in the 6th School run by the
Trust. Its code would be as follows:

06 08 1 12 2  54

Roll No of the Student in the Section of Class XII

Section Code (2 for Section-B)

Current Class (XII)

Stream (i.e. Science – Non-Bio)

Entry-year to Current Class (i.e. XII)

School Code
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1.5 USING SOFTWARE OF CAS

There are two basic activities in using software of CAS – One time activities
and recurring activites. One time activities include creation of
Organisation details, accounting year,  type of ledger (also called “creation
of master files” ), etc. While reccuring activities include entry of
transactions and generation of reports. The transactions are recorded on
the basis of Cash Vouchers, Bank Vouchers, Purchase Vouchers, Sales
Vouchers, Journal Vouchers, etc. Reports include generation of Day books,
Ledgers, Trial Balance, Statement of Profit and Loss, Position Statement
and Cash Flow Statement. (Please refer to Chapter 5  for details)

SECURITY FEATURES OF CAS SOFTWARE

Every accounting software ensures data security, safety and
confidentiality. Therefore every, software provides the following:

• Password Security

• Data Audit

• Data Vault

Password Security: Password is a mechanism, which enables a user
to access a system including data. The system facilitates defining the
user rights according to organisation policy. Consequently, a person
in an organisation may be given access to a particular set of a data
while he may be denied access to another set of data.

Data Audit:  This feature enables one to know as to who and what
changes have been made in the original data thereby helping and fixing
the responsibility of the person who has manipulated the data and also
ensures data integrity. Basically, this feature is similar to Audit Trail.

Data Vault: Software provides additional security through data
encryption.

1.6  ADVANTAGES OF CAS

Following are the advantages of Computerised Accounting System (CAS):

1. Timely generation of reports and information in desired format.

2. Efficient record keeping.

3. Ensures effective control over the system.

EncryptiEncryptiEncryptiEncryptiEncryptio no no no no n essentially scrambles the information so as to make

its interpretation extremely difficult (almost impossible). Thus,

Encryption ensures security of data even if it lands in wrong

hands, because the receiver of data will not be able to decode

and interpret it.

PasswordPasswordPasswordPasswordPassword is the key (code) to allow the access to the system.
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4. Economy in the processing of accounting data.

5. Confidentiality of data is maintained.

1.7  LIMITATIONS OF CAS

Following are the limitation of CAS software:

1. Faster obsolescence of technology necessitates investment in
shorter period of time.

2. Data may be lost or corrupted due to power interruptions.

3. Data are prone to hacking.

4. Un-programmed and un-specified reports cannot be generated.

1.8  ACCOUNTING INFORMATION SYSTEM (AIS)

Accounting Information System (AIS) and its various sub-systems may
be implemented through Computerised Accounting System. The
subsystems of AIS are briefly described below (Fig. 1.4)

1.8.1 CASH AND BANK SUB-SYSTEM

It deals with the receipt and payment of cash both physical cash and
electronic fund transfer. Electronic fund transfer takes place without
having the physical entry or exit of cash by using the credit cards or
electronic banking.

1.8.2 SALES AND ACCOUNTS RECEIVABLE SUB-SYSTEM

It deals with recording of sales, maintaining of sales ledger and
receivables. It generates periodic reports about sales, collections made,

Figure 1.4 :      The sub-systems of Accounting Information System
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overdue accounts and receivables position as also ageing schedule of
receivables/debtors.

1.8.3 INVENTORY SUB-SYSTEM

It deals with the recording of different items purchased and issued

specifying the price, quantity and date. It generates the inventory

position and valuation report.

1.8.4 PURCHASE AND ACCOUNTS PAYABLE SUB-SYSTEM

It deals with the purchase and payments to creditors. It provides for

ordering of goods, sorting of purchase expenses and payment to the

creditors. It also generates periodic reports about the performance of

suppliers, payment schedule and position of the creditors.

1.8.5 PAYROLL ACCOUNTING SUB-SYSTEM

It deals with payment of wages and salary to employees. A typical wage

report details information about basic pay, dearness allowance, and

other allowances and deductions from salary and wages on account of

provident fund, taxes, loans, advances and other charges. The system

generates reports about wage bill, overtime payment and payment on

account of leave encashment, etc.

1.8.6 FIXED ASSETS ACCOUNTING SUB-SYSTEM

It deals with the recording of purchases, additions, deletions, usage of

fixed assets such as land and buildings, machinery and equipments,

etc. it also generates reports about the cost, depreciation, and book

value of different assets.

1.8.7 EXPENSE ACCOUNTING SUB-SYSTEM

This sub-system records expenses under broad groups such as

manufacturing administrative, financial, selling and distributions and

others.

1.8.8 TAX ACCOUNTING SUB-SYSTEM

This sub-system deals with compliance requirement value-added tax

(VAT), excise, customs and income tax. This sub-system used in large

size organisation.

1.8.9 FINAL ACCOUNTS SUB-SYSTEM

This subsystem deals with the preparation of Profit and Loss accounts,

Balance Sheet and cash flow statements for reporting purposes.

1.8.10  COSTING SUB-SYSTEM

It deals with the ascertainment of cost of goods produced. It has linkages

with other accounting sub-systems for obtaining the necessary

information about cost of material, labour, and other expenses. This

system generates information about changes in the cost that takes

place during the period under review.
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1.8.11  BUDGET SUB-SYSTEM

It deals with the preparation of budget for the coming financial year as
well as comparison with the current budget of the actual performances.

1.8.12  MANAGEMENT INFORMATION SYSTEM

Management Information System (MIS) deals with generation and
processing of reports that are vital for management decision-making.
The Information system should be so flexible as to provide customised
reports to support various managerial functions such as planning,
organising, staffing, oversight, control and decision-making including
operational, functional and strategic nature.

SummarySummarySummarySummarySummary

• In Computerised Accounting System, accounting transactions are processed
using computer system. A computer system includes hardware and software.
Hardware includes Central Processing Unit (CPU), Random Access Memory
(RAM), Monitor (Screen), Keyboard, Mouse, Hard Disk and CD/DVD for mass
storage of data and Printer, etc. Software consists of set of instructions.
Software can either be a System Software (a part of Computer System) or an
Application Software. CAS uses Accounting Software. Accounting Software
(such as Tally) is an example of Application Software.

• Coding (for Account Head, Budget Head, Cost Centres, etc) is required in
CAS. Coding first requires development of its structure. Coding Structure
should be compatible with inherent structure of the element to be coded.
For example, Account Head coding requires a hierarchical structure to
progressively summarise the accounting information as per the requirements
of Balance Sheet and Profit and Loss Account.

• Advantages of CAS include speed, efficiency, arithmetic accuracy, cost saving,
confidentiality of data.

• Limitations of CAS include provision for (a) fast obsolescence of technology,
(b) data loss due to either power interruptions or damage to hard disk,
(c) virus and other security hazards.

• Accounting Information System is an integration of various sub-systems
such as: (i) cash sub-system, (ii) sales and accounts receivable sub-system,
(iii) inventory sub-system, (iv) purchase and accounts payable sub-system,
(v) payroll accounting sub-system, (vi) fixed asset accounting sub-system,
(vii) expense accounting sub-system, (viii) tax accounting sub-system,
(ix) final accounts sub-system, (x) costing sub-system, (xi) budget sub-system,
(xii) management information sub-system.
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EXERCISES

Q1. MULTIPLE CHOICE QUESTIONS

1. The components of Computerised Accounting System are :

(a) Data, Report, Ledger, Hardware, Software;

(b) Data, People, Procedure, Hardware, Software;

(c) People, Procedure, Ledger, Data, Chart of Accounts;

(d) Data, Coding, Procedure, Rules, Output.

2. The Computerised Accounting System refers to :

(a) Printing of Balance Sheet and Profit and Loss Accounts using computer;

(b) Processing of accounting transaction through computer and produce
records and reports;

(c) Processing of accounting related data and printing reports;

(d) None of the above.

3. The components of Computerised Accounting System refers to :

(a) Business transactions are analysed, transactions recorded, prepare trial
balance, preparation of balance sheet and profit and loss account;

(b) From data entry to preparation of final statements;

(c) Transformation of manual accounting system to CAS;

(d) None of the above.

4. The CAS should be

(a) Simple and integrated, transparent, accurate, scalability, reliability;

(b) Complex, Accurate, Transparent, Faster to work;

(c) Able to transform the manual accounting system to computerised
accounting system;

(d) None of the above.

5. The Grouping of Accounts means the classification of data from :

(a) Asset, liabilities and capital

(b) Asset, capital, liabilities, revenue and expenses

(c) Asset, owners equity, revenue and expenses

(d) None of the above.

6. Codification of Accounts required for the purpose of :

(a) Hierarchical relationship between groups and components

(b) Data processing faster and preparing of final accounts

(c) Keeping data and information secured

(d) None of the above.
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7. Method of Codification should be :

(a) Such that it leads to grouping of accounts

(b) An identification mark.

(c) Easy to understand, cryptic, and leads to grouping of accounts

(d) None of the above

8. The need of Codification is :

(a) The Encryption of data

(b) The Generation of mnemonic code

(c) To secure the accounts, reports, etc.

(d) Easy to process data, keeping proper records

9. What is the activity sequence of the basic information processing  model?

(a) Organise data, process data, and collect data

(b) Collect data, organise and process data, and communicate information

(c) Process data, organise data, and collect data

(d) Organise data, collect data, and communicate information

10. What are internal controls designed to do?

(a) safeguard assets and optimise the use of resource

(b) only achieve maximum revenue

(c) only safeguard assets

(d) only ensure accurate accounting records

11. What is a firm’s payment to a supplier for merchandise inventory recorded in?

(a) Cash payment journal

(b) Purchases journal

(c) Sales journal

(d) Cash receipts journal

12. Where are amounts owed by customers for credit purchases found?

(a) accounts receivable journal

(b) general ledger

(c) sales journal

(d) accounts receivable subsidiary ledger

Q2. ANSWER THE FOLLOWING QUESTIONS

1. Why the computerisation of Financial Accounting is required and why is it
useful?

2. What is coding? Why codification is required for an Accounting System?

3. What are the salient features of Computerised Accounting Software?
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4. What are the phases in an accounting cycle?

5. Write differences between data and information with examples?

6. Explain various types of coding methods and the situations where each coding

method is best suited?

7. Define the term transaction and elaborate with the help of examples how the
transaction will be shown in chart of accounts by hierarchical grouping?

8. What is a chart of accounts? How is it arranged?

9. What is meant by Revenue and Expenses?

10. What are the limitations of CAS?

11. What are the advantages of CAS?

12. What is encryption and how is it helpful in CAS?

Q3. SKILL REVIEW

1. Topic of debate: “Intentional manipulation of accounting records is much
easier in computerised accounting system than in manual accounting system”.

Do this exercise in the class forming group of 4 students to form a team and
do the presentation in the class?

2. Develop a coding structure for inventory items based on the following
information: There are around 7000 items, which are grouped under 37 major
categories. Each major category is further sub-divided into 15-40
sub-categories. Within a sub-category, the number of items will never
exceed 1000.

   ANSWERS

1. b 2. b 3. a 4. a 5. b 6. a

7. a 8. a 9. b 10. a 11. a 12. d
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SPREADSHEET

Introduction
After studying this chapter you will be
able to understand:

• Concept of  Spreadsheet and its
features.

• How to use a Spreadsheet.

2

 

A spreadsheet is a configuration of rows and
columns. Rows are horizontal vectors while
columns are vertical vectors. A spreadsheet is also
known as a worksheet. It is used to record,
calculate and compare numerical or financial data.
Each value can either be an independent (i.e. basic)
value or it may be derived on the basis of values of
other variables. The derived value is the outcome
of an arithmetic expression and/or a function
(i.e. a formula).

Spreadsheet application (sometimes referred to
simply as spreadsheet) is a computer program that
allows us to add (i.e. enter) and process data. We
shall understand spreadsheet with the help of
MS-Excel (or simply, Excel), which is one of the
Microsoft Office Suite of software.

The current version of Excel is Excel 2007 and
has a completely redesigned user interface. The
Excel 2007 is now designed with a series of
horizontal tabs known as “Ribbon” (Figure 2.1).
These tool bars are changed using tabs at the top.
This layout is very easy to use than the previous

Figure 2.1
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versions of Excel.  On clicking with left button of mouse at

“Office Button” ; we will be able to open an old workbook or create

a new one or can save the workbook or can print which were earlier
available in previous version of Excel in File menu.

2.1 BASIC CONCEPTS OF SPREADSHEET

A file in Excel is known as a “Workbook”. A workbook is a collection of
a number of “Worksheets” (Figure 2.2). By default, three sheets, namely
Sheet 1, Sheet 2, and Sheet 3 are available to users. At a time, only
one worksheet can be made as “Active Worksheet” and that worksheet
is available to a user for carrying out operations. An active worksheet’s
name will be shown in bold letters in the “Sheet Tab” at the bottom left
of the screen. Additional sheets can be added, if required, by clicking

on the icon (which  works as Insert ! W ! W ! W ! W ! Worksheetorksheetorksheetorksheetorksheet).

The Sheet names can be
changed, if required, by right-
clicking the mouse over the Sheet1
or Sheet 2 or Sheet 3 after selecting
and pointing it on the sheet name
(which is to be changed) and selec-
ting “Rename” option.

Box 2.1Box 2.1Box 2.1Box 2.1Box 2.1

Basic and Derived VBasic and Derived VBasic and Derived VBasic and Derived VBasic and Derived Valuesaluesaluesaluesalues

If quantity (Q) of an item is

purchased at a price (P), the value

of that item (V) is derived as

follows:

V = Q × P

Here, the values P and Q are

Basic Values. While V is the

Derived Value as it is obtained

by multiplying Q with P. The

expression (Q×P) is called as

arithmetic expression. Addi-

tional examples of arithmetic
expressions are given later in this

chapter.

Note: In general, an arithmetic
expression may contain one or

more functions.
Figure 2.2
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Figure 2.3

RowsRowsRowsRowsRows are numbered numerically
from top to bottom while ColumnsColumnsColumnsColumnsColumns
are referred by alpha characters
from left to right. In Excel 2007,
there are 65536 RowsRowsRowsRowsRows which are
numbered as 1, 2, 3, … 65,536. These
numbers are shown on the left most
portion of the worksheet. ColumnsColumnsColumnsColumnsColumns
(total 256 in Excel) are identified
by letters, such as A, B, C,.. AA…
IV, and are shown on the horizontal
box just above Row 1. Thus, there
are 65,536  256 = 1,65,00,000,
approximately cells, which is indeed a huge work area, sufficient for
all application requirements (Figure 2.3) in one sheet.

In a spreadsheet, a value or function or an arithmetic expression is
recorded in a cellcellcellcellcell. The intersection of a rowrowrowrowrow and a columncolumncolumncolumncolumn is called a
cell. cell. cell. cell. cell.  A cellcel lcel lcel lcel l is identified by a combination of a letter and a number
corresponding to a particular location within the spreadsheet. For
example, the first cell of a worksheet is identified as A1 as it shown in
Figure 2.2 at row 1 and column (A). When we start Excel, the pointer
(cursor) points to the first cell, i.e. A1, and this cell is called the ActiveActiveActiveActiveActive
CellCellCellCellCell. We can move around a worksheet through four arrow keys (i.e.
left, right, up, down as shown in Figure 2.4). For example, the cell
having address as G8 correspond to 8th row under G column. Each
cell thus has a unique identification called as cell addresscell addresscell addresscell addresscell address.

Cell Reference — — — — — A cell reference identifies the location of a cell or
group of cells in the spreadsheet also referred as a cell address.  Cell
references are used in formulas, functions, charts, other Excel
commands and also refer to a group or range of cells. RangesRangesRangesRangesRanges are
identified by the cell references of the cells in the upper left (cell A1)
and lower right (cell E2) corners in Figure 2.3. The ranges are identified
using colon (:) e.g. A1: E2 which tells Excel to include all the cells
between these start and end points. By default cell reference is
relative; which means that as a formula or function is copied and
pasted to other cells, the cell references in the formula or function
change to reflect the new location. The other cell reference is absolute
cell reference which consists of the column letter and row number
surrounded by dollar ($) signs e.g. $C$4. An absolute cell reference is
used when we want a cell reference to stay fixed on specific cell,
which means that when a formula or function is copied and pasted to
other cells, the cell references in the formula or function do not change.
A mixed reference is also a cell reference that holds either row or
column constant when the formula or function is copied to another
location e.g., $C4 or C$4.
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The mouse is used for all the operations required
and for navigation in worksheet (or workbook) except
data entry; but some of the important operations and
common navigations can be performed by using key
strokes (as given below). It is better to understand
and know all the keys of keyboard and key strokes.
Pressing a key is called key stroke but to fulfill one
command for operation in the worksheet some time
we require pressing two keys together to get one key
stroke (Figure 2.4)

MovementMovementMovementMovementMovement Key Stroke (Press key)Key Stroke (Press key)Key Stroke (Press key)Key Stroke (Press key)Key Stroke (Press key)

One cell down Down arrow key ( ) or EnterEnterEnterEnterEnter key

One cell up Up arrow key ( )

One cell left Left arrow key ( )

One cell right Right arrow key ( ) or TabTabTabTabTab key

The other navigational and operational strokes are used for faster
cursor movement  than one cell at a time with cluster of filled cells.
Cluster of filled cells implies a set of consecutive cells in a row or in a
column having some data.

Figure 2.4

The data that is entered in a cell may be either numeric or alpha-
numeric or a date. As a data is typed in a cell, Excel is able to make
out its type (i.e. numeric or alpha-numeric or date) depending on the
nature of value typed in a cell.

MovementMovementMovementMovementMovement Key Stroke (Press key)Key Stroke (Press key)Key Stroke (Press key)Key Stroke (Press key)Key Stroke (Press key)

Top of Worksheet (cell A1) CTRLCTRLCTRLCTRLCTRL + HOMEHOMEHOMEHOMEHOME (i.e. Keep CTRLCTRLCTRLCTRLCTRL key
pressed and then press HOMEHOMEHOMEHOMEHOME key

The cell  at the intersection of the CTRLCTRLCTRLCTRLCTRL + ENDENDENDENDEND keys
last row and last column containing data

Moving consecutively to the first and the last CTRLCTRLCTRLCTRLCTRL + Right arrow key ( ) or
filled cells of clusters of filled cells in a row by else ENDENDENDENDEND + Right arrow key ( )
successive pressing of CTRLCTRLCTRLCTRLCTRL + Right arrow
key ( ) or else ENDENDENDENDEND + Right arrow key ( )

Moving consecutively to the first and the last CTRLCTRLCTRLCTRLCTRL + Down arrow key ( ) or
filled cells of a cluster of filled cells in a column else ENDENDENDENDEND + Down arrow key ( )
by successive pressing of CTRLCTRLCTRLCTRLCTRL + Down arrow
key ( ) or else ENDENDENDENDEND + Down arrow key ( )

Beginning of the Row HOMEHOMEHOMEHOMEHOME key

Beginning of the Column

Navigating In (i.e. Moving arNavigating In (i.e. Moving arNavigating In (i.e. Moving arNavigating In (i.e. Moving arNavigating In (i.e. Moving around) The Wound) The Wound) The Wound) The Wound) The Worksheetorksheetorksheetorksheetorksheet
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If the value is entered as 306, its type is automatically taken as Numeric;
if the value is entered as Asset, its type will be taken as alpha-numeric;
while if the value is entered as 12/07/08, its type is taken as Date.
(refer figure 2.5)

The first step required to use Excel
for a specific application is to decide
what values will be entered in which
cells and also the cells which will be
used for entering the relationships.
Once we have decided about the cells
which are to be used for the
relationships; the formulas (arithmetic
expressions) and data can be entered.
(See Box 2.1 at page18)

VVVVValuesaluesaluesaluesalues

A value can be entered from the computer keyboard by directly typing
into the cell itself. Alternatively, a value can be based on a formula
(derived), which might perform a calculation, display the current date or
time, or retrieve external data such as a stock quote or a database value.

The value rulevalue rulevalue rulevalue rulevalue rule according to computer scientist Alan KayAlan KayAlan KayAlan KayAlan Kay implies in
spreadsheet. It states that a cell’s value relies solely on the formula
that user has typed into the cell. The formula may rely on the value of
other cells, but those cells are likewise restricted to user-entered data
or formulas. There are no ‘side ef‘side ef‘side ef‘side ef‘side effects’fects’fects’fects’fects’ to calculating a formula: the
only output is to display the calculated result inside its occupying cell.
There is no natural mechanism for permanently modifying the contents
of a cell unless the user manually modifies the cell’s contents. Sometime
it is called a limited form of first-order functional programming.

A simple example of a spreadsheet application (Figure 2.6) is to
calculate compound interest and maturity amount to be paid on fixed
deposit. The first step (i.e. the Planning Step) is to define six cells with
column headings:

• Principal Amount (PA in column B)

• Rate of Interest (r in column C)

• Period in years (NY)

• Period of Compounding (CP in column D)

• Compound Interest (CI in column F)

• Maturity Amount (MA in column E)

The formula for Maturity Amount (MA) and
Compound Interest (CI) computations
considering yearly compounding of interest are
as follows:

Figure 2.5

Figure 2.6
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MA = PA * (1 + R / (100 * CP)) ^ (R * CP)
CI= MA – PA

Now, we can decide the layout of the worksheet for (compound)
interest calculation as shown in Figure 2.6.

It may be observed that the basic values are entered in cells (as in
figure 2.6 the cells are B4, C4 and D4); the derived values (as in Figure
2.6 the cells are E4 and F4) are automatically computed (using above
formula) and shown in forforforforformula barmula barmula barmula barmula bar. In case any basic values are
modified, the derived values as a result are revised accordingly. This
feature of Spreadsheets enables us to study various what-if scenarioswhat-if scenarioswhat-if scenarioswhat-if scenarioswhat-if scenarios.

A what-if scenariowhat-if scenariowhat-if scenariowhat-if scenariowhat-if scenario is used to generate a number of alternatives to
examine the cause (if) and effect (what). Thus, it helps in analysing the
impact of changes due to variations in one or more input values. Taking
the above example, if all the other values are kept same, one can see
how different rates of interest and different periods of compounding
would affect the Compound Interest and the Maturity Amount to be
received.

Before proceeding further for the above example we have to
understand some of the basic terminologies and features of the
spreadsheet such as:

2.1.1 LABELS

A text or especial character will be treated as labels for rows or columns
or descriptive information. Labels cannot be treated mathematically-
multiplied, subtracted, etc. Labels include any cell contents beginning
with A-Z e.g., in the above Figure 2.6  Principal Amount, Rate of
Interest, Maturity amount, etc. will be taken as labels.

2.1.2 FORMULAS

The formula means a mathematical calculation on a set of cells. Formulas
must start with an = sign (equal to sign), e.g. in the Figure 2.7 the cell
E3 will have formula = D1+E1/F1*G1 which gives value 16.

When a cell contains a formula, it often contains referencesreferencesreferencesreferencesreferences to
other cells. Such a cell referencecell referencecell referencecell referencecell reference is a type of variable. Its value is the
value of the referenced cell or some derivation of it. If that cell in turn
references other cells, the value depends on the values of those.

By convention, the left hand side of equal
to sign in a formula is normally considered
is calculated and displayed in cell E3.

A formula identifies the calculation
needed to place the result in the cell it is
contained within. A cell E3 containing a
formula, therefore it has two display

Figure 2.7
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components; the formula itself and the resulting value. The formula is
shown only when the cell is selected by “clicking” the mouse over a
particular cell; otherwise it contains the result of the calculation (in
this case 16).

The arithmetic operations and complex nested conditional (what-(what-(what-(what-(what-
if scenario)if scenario)if scenario)if scenario)if scenario) operations can be performed by spreadsheets which follow
order oforder oforder oforder oforder of mathematical (expression) operations rulesmathematical (expression) operations rulesmathematical (expression) operations rulesmathematical (expression) operations rulesmathematical (expression) operations rules.

A spreadsheet without any formulas is a collection of data which
are arranged in rows and columns (a database) like a calendar, timetable
or simple list, etc. There is a Formula tab on Excel ribbon (Figure
2.8(a) which contains four sections, functions library, defined names,
formula auditing and calculation.

2.1.3 FUNCTIONS

A function is a special key word which can be entered into a cell in
order to perform and process the data which is appended within
brackets.

Figure 2.8(a)

Order of mathematical operations (expressions)

Computer math uses the rules of Algebra..... Any operation(s) contained in brackets
will be carried out first followed by any exponents.

After that, Excel considers division or multiplication operations to be of equal
importance, and carries out these operations in the order they occur left to right
in the equation.

The same goes for the next two operations – addition and subtraction. They are
considered equal in the order of operations. Whichever one appears first in an
equation, either addition or subtraction is the operation carried out first.

Three easy ways to remember the order of operations is to use the acronym:

GEMS PEMDAS BEMDAS

( ) Grouping Please - ( )parenthesis ( ) Brackets

^ Exponents Excuse - ^ exponents ^ Exponents

* Multiplication : My - * multiply * Multiplication
/ or Division : Dear - / divide / Division

- Subtraction : Aunt - + add + Addition
+ or Addition : Sally - - subtract - Subtraction
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There is a function button on the formula toolbar (fffffx) (figure 2.8(b);
when we click with the mouse on it; a function offers assistance and
useful prompts into a spreadsheet cell. Alternatively we can enter the
function directly into the formula bar. A function involves four main
issues:

• Name of the function

• The purpose of the function

• The function needs what
argument(s) in order to
carry its assignment.

• The result of the function.

A function is a built in set of formulas which starts with an =
“equal to sign” such as = FunctionName(Data). The data (or argument
in proper terminology) includes a range of cells.

SUM (), AVERAGE () and COUNT () are common functions and
relatively easy to understand. They each apply to a range of cells
containing numbers (or blank but not text) and return either the
arithmetic total of the numbers, the average mean value or the quantity
of values in the range.

For Example: The SUM or AutoSum () function is the most basic
and one of the common user functions. It is used to get the addition of

various numbers or the contents of various cells. On the ribbon (Figure
2.9(a)) the AutoSum () button can be use directly for summation of
values from cells. Once we click the AutoSum () at cell H1, the function
adds the contents of cell range D1 to G1 and displays the answer that
we want to get the sum of. If we want answer in the cell G5 (Figure
2.9(b) use the mouse to click in the cell G5 and click AutoSum button
then from keyboard type range of the cells D1:G1; the answer 17 will
appear in cell G5; or we can write directly the complete function =
SUM (D1: G1) appears in the formula bar above the worksheet. The
AutoSum function also includes other series based functions such as
AVERAGE, MIN, MAX and COUNT.

Figure 2.8(b)

Figure 2.9(a) Figure 2.9(b)
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There are twelve different categories of functions available in Excel
2007 displayed on the ribbon (Figure 2.8) which are classified as per
the usage e.g. The Financial, Date and Time, Lookup and References,
Database, Text and Logical functions are useful in Computerised
Accountancy and will be explained later subsequently.

Naming Ranges – IF Functions – Nested IF Functions

As mentioned earlier, we will now learn the arithmetic operations and
complex nested conditional (what-if scenario)(what-if scenario)(what-if scenario)(what-if scenario)(what-if scenario) using name ranges,
absolute cell references and mixed references in following sections.

Naming Cells and Ranges

Naming ranges in Excel will save time for
writing complex formulas.  The name can be
used in place of cell range whenever reference
it e.g. in D3 we have = SUM (B1:F1)
(Figure 2.10)

The cell referenced in the function B1:F1
can be replaced with a descriptive name
say NumbersNumbersNumbersNumbersNumbers (name range) which is
easier to remember and in D3 it will be
= SUM (Numbers)

Behind the Numbers Numbers Numbers Numbers Numbers Excel is hiding cell references, we will see how
it works now.

The steps are for defining Name Ranges are as
follows:

1. Select the cell(s) which are to be named
(such as B1:F1 in Figure 2.10(a)).

2. Click on the ribbon on formula tab.

3. Select Define Name (Figure 2.10(b) option
on the ribbon and click it.

4. This will provide a dialogue box will be
opened as shown in Figure 2.10(c) to click
Define Name (another option Apply Names is for previously created
Range Names to select) (Figure 2.10(d)).

Figure 2.10

Figure 2.10(a)

Figure 2.10(b) Figure 2.10(c)
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5. This will display a dialogue box as New
Name shown in Figure 2.10(d). It will
provide a window “Name” in which type
“Numbers”  which will represent cell
ranges $B$1:$F$1 as shown in be
“Refers to” window.

6. Click OK on the New Name dialogue box
which returns to the spreadsheet. Notice
that the Name Box having our heading
“Numbers”.

7.  To apply this name in cell D3 for summation from
B1:F1 click on Apply Name and a dialogue box will
be opened  then click on a Name Range – Numbers
(Figure 10(e)). The D3 will be having =SUM (Numbers)
And will display the result (Figure 10(f)). The named
range can be used with other Functions such as
AVERAGE (), SUMIF () etc.

Now we will use a summation of numbers using condition
in the cell D3. Type the formula = SUMIF (Numbers,”<6)
and the answer will be 9 (for the Numbers less than 6 in
the named range B1:F1) (Figure 2.10(f)).

Let us understand with the help of another
example in which we will be using  two Named Ranges
(Figure 2.11) namely Monthly_Totals for cells B2:B5

Figure 2.10(d)

Figure 2.10(f)

Figure 2.10(e)

Figure 2.10(g)

Figure 2.11

and Monthly_Tax for cells C2:C5
respectively created as described above.

The cell B6 will have value 1158
by using function as =SUM
(Monthly_Totals).

Similarly in Figure 2.11(a) if we
use Autosum Function () from the
formula tab of the ribbon at the cell
C6; the function will include the
Named Ranges as an argument and
gives the result 238.
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We will now use these two Named
Ranges to calculate the Balance (in cell
B7) after using the formula tax from
monthly totals. Let us give
Total_of_Month is the Named Range for
cell B6 and similarly, the Total_of_Tax
is the Named Range for cell C6.  With these
two Named Ranges; the cell B7 will have
the difference of these two amounts and
will be written (Figure 2.11(b)) as
= Total_of_Month – Total_of_Tax .

To prevent its recalculation and
maintain the present calculated value as
shown in the cells B6, C6 and B7
respectively (Figure 2.11(b) we can freeze
the formula using Paste Special
command. The following steps are
required:

1. Select the cell (s) that contains the
formula e.g. B6:C6, B7 (Figure 2.11(b)

2. Click on Home Tab and select Copy
symbol (Figure 2.11(c)) to click, this
will copy the values and formulas of
the cells (Figure 2.11(d)).

3. Click on Paste tab and select Paste
Special.

4. In the Paste Special box (Figure 2.11
(d)), under paste select the radio
button next to Values and click OK.
This will permanently remove the
formula from the workbook.

In continuation to our need of what-if-
scenario now we will learn about an
important logical function IF Function.
This function can be evoked from formula
tab on the ribbon. This function returns
one value if a specified condition evaluated
to TRUE and another value if it evaluates
to FALSE.  We will learn more about the
usage of functions in the business
applications subsequently; there are a
large selection of if functions available.
An IF function has the following format:

IF (logical_test, value_if_ture,
value_if_false) where

Figure 2.11(a)

Figure 2.11(b)

Figure 2.11(c)

Figure 2.11(d)
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logical_test :  the value or expression that is determined to be true or
false; this requires the usage of a logical operator. A logical operator is
one used to perform a comparison between two values and produce a
result of true or false (there is no middle result: something is not half
true or half false or “Don’t Know”; either it is true or it is false).  For
example, A1 < 20 could be used as a logical test, where symbol “<“ is a
logical operator “less than”. (There are many more logical operators
such as =, <=, <>, >, >= etc.)

value_if_true :  The value returned if the test is determined to be true.
This value can be a value, text, or expression, formula, etc. or it can be
return the value of another cell.

value_if_false : The value returned, if the test is determined to be
false. This value can be a value, text, or expression, formula, etc. or it
can return the value of another cell.

e.g. i. = IF( A1 < 20, “Yes”, “No”)  this function will return Yes if cell
A1 < 20 and o for anything else.

ii. = IF (C2 > B2, (C2+D2)/2, (B2+D2)/2) this function will compare
both cell C2 > B2 and will calculate and return (C2+D2)/2 if it
is true else it will calculate and return (B2+D2)/2.

Example : Let us calculate the amount of saving (Cell address ”value”) on
the basis of percentage value (Cell address “saving”) shown in figure 2.12(a)

Creating IF function using the Formula Tab and dialogue box.

1. Select the cell F4 (Figure 2.12(a) where the function is to be introduce

2. Click at the Formula tab on the ribbon and click logical option.

3. Select IF function which will provide
Function Arguments dialogue box
(Figure 2.12(b).

4. Type an appropriate condition in the
logical_test box ( e.g.  E4 > 10000 )

5. In the value_if_true box type the
require value (e.g. 10%) if the logical
test condition is met.

6. In the value_if_false box type the
value (e.g. 5%) if the logical test
condition is NOT met.

7. Click OK, the answer for the
condition will be displayed (in cell
F4 it will be 5%). Copy the function
from F4 to all other cells F5:F11.

In the Formula Box the function will be displayed as

=IF (F4>10000, 10%, 5%)

This is simple use of IF function.  The nested IFs can be used to
look for several conditions and to look at different types of functions.

Figure 2.12(a)
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e.g. = IF (AVERAGE (A2:A6) > 10, SUM
(B2:B6), 0)

This function will be able to look at
the average of cells A2 to A6 and if the
average is higher than 10 it will sum
the value of the cells B2 to B6, if the
average is equal to or less than 10 it
will return to 0.

In some cases, we need to check
more than one condition. In other
words, check the first condition; if that
condition is false, check another
condition.  If a nested function is used as an argument it must return
the same type of value that the argument uses. For example, if the
argument returns a TRUE or FALSE value, then the nested function
must return a TRUE or FALSE otherwise MS Excel will display an
error message #Value! in the cell.

This way we can check as many conditions as we need to. The
truthfulness of each condition would lead to its own statement. If none
of the conditions is true, then it executes the last statement. To
implement this scenario include an IF() function inside of another.
Such as :

= IF (logical_test, value_if_true, value_if_false) simple if statement.

Let us substitute other IFs

IF (logical_test, IF (logical_test, IF (logical_test, value_if_true,
value_if_false), value_if_false), value_if_false)

e.g.  Suppose E2 cell contains marks of a test and cell F2 will have
result based on following nested IF () condition.

= IF (E2<96, IF (E2<91, IF (E2<55,”Fail”,”C Grade”), “B Grade”),
“A Grade”)

2.1.4 OTHER USEFUL FUNCTIONS

In business applications the input
of data usually contains dates (date
of invoice preparation, date of
payment, payment received date, or
due date etc.), rate of interest, tax
percentage and output information
may require age calculation,
duration, delays in payment,
accumulated interest, depreciation,
future value, net present value, etc.

The MS Excel provides library of
such functions in which input data

Figure 2.12(b)

Figure 2.13
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can be worked as arguments and result available from the function
will be output information. On the ribbon of MS Excel, the formula tab
contains categorised function libraries (Figure 2.13).

a. Date and Time Function.

b. Mathematical Function.

c. Text Manipulation function.

d. Logical Function (other than IF).

e. Lookup and Reference Function.

f. Financial Function.

The complete details of each function from a
range of above categories including examples are
available through Help (?) on the Ribbon. The
quickest way to get help on a function whose name
(e.g. SUMIF) when we entered on formula bar
followed by equal to sign then double-click the

function’s name that appears in the strip (as shown in the figure 2.14).
We will learn some of the useful function with the help of examples.

2.1.4.1  Date and Time Function

1. TODAY () is the function for today’s date in the blank worksheet.

TODAY – Returns the serial number of the current date. The serial
number is the date-time code used by Excel for date and time
calculations. Times are represented as fractions of a day. By default
January 1, 1900 is serial number 1. Thus, January 1, 2009 is serial
number 39814 (because it is 39814 days after January 1, 1900).

2. NOW () is similar function but it includes the current time also
(Figure 2.15).

3. DAY(serial_number) function returns the day of a date as an integer
ranging from1 to 31. For example, if A5 = 16-Apr-2009 then = DAY (A2)
will be 16. Similarly, two other functions MONTH(serial_number)
returns month of a date as an integer ranging from 1 (January) to 12
(December) (Figure 2.16) and YEAR(serial_number) returns the year
corresponding to a date as an integer ranging from 1900 – 9999.

4. DATEVALUE (date_text) converts a date in the form of text to a
serial number e.g.  =DATEVALUE(“16-04-2009”)  will return a value
39919.

Figure 2.14

Figure 2.15 Figure 2.16
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Example: To find out the age of an employee
as on today is a very simple mathematical
calculation in the spreadsheet, e.g. the age
of a person on 16-Apr-2009 whose Date of
Birth is 16-Apr-1980 can be calculated as
per Figure 2.17. The difference of two dates
(in D3) is divided by 365.25 to convert days
into years (considered the fractional value
for leap years).

2.1.4.2  Mathematical Function

In business applications some of the
Mathematical Functions are very useful,
such as:

1. SUMIF is the function which adds the cells as per given specified
criteria the syntax of this is as follows:

SUMIF (range, criteria, sum_range) where

Range it is the range of cells to evaluate.

Criteria it is the criteria in the form of a
number, expression, or text that defines which
cells will be added, e.g. criteria can be
expressed 1500, “1500”, “>1500” or “Books”.

Sum_range  are the actual cells to sum.

e.g. There are sum Asset Values (D2:D5)
and related to each asset values there
are deprecation values (E2:E5). Using
SUMIF function we have to calculate the
sum of depreciation for those Asset Values which are more than 1,
70,000/-.
The function is written in the cell E7 like =SUMIF (D2:E5,”>150000,
E2:E5) which gives result 63,000/- (Figure 2.18)

2. ROUND is the function to rounds a number to specified number of
digits. The syntax of this function is as follows:

ROUND (number, num_digits) where

Number Is the number to round (preferably
fractional number)

Num_digits specifies the number of digits to
round the Number. There may be some
different situations for Num_digits as follows:

a. If Num_digits is greater than 0 (zero),
then number is rounded to the specified
number of decimal places.

b. If Num_digits is 0, then number is
rounded to the nearest integer.

Figure 2.17

Figure 2.18

Figure 2.19
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c. If Num_digits is less than 0, then number is rounded to the left of
the decimal point.

ExaExaExaExaExamplemplemplemplemple - refer Figure 2.19

i. to round the number 21.5 by 1 digit ( result is 2.2)

ii. to round the number 2.149 by 1 digit ( result is 2.1)

iii. to round the number  -1.475 by 2 digits ( result is -1.48)

vi. to round the number 21.5 by -1 digit ( result is 20.0)

To round a number to the nearest whole number because decimal
values are not significant or round a number to multiples of 10 to
simplify an approximation of amounts. There are several ways to round
a number other than ROUND are:

ROUNDUP (number, num_digits) which rounds a number up, away
from 0 (zero) e.g.

= ROUNDUP (3.2, 0) Rounds 3.2 up to zero decimal
places and the value is 4.

= ROUNDUP (76.9, 0) Rounds 76.9 up to zero decimal
places and value is 77.

= ROUNDUP (3.14159, 3) Rounds 3.14159 up to three
decimal places; value 3.142.

= ROUNDUP (-3.14159, 1) Rounds -3.14159 up to one
decimal place; value -3.2.

= ROUNDUP (31415.92654,-2) Rounds 31415.92654 up to 2
decimal places to the left of the
decimal; value 31500.

ROUNDDOWN (number, num_digits)  which rounds a number down,
toward zero.

= ROUNDDOWN (3.2, 0) Rounds 3.2 down to zero decimal
places; value 3.

= ROUNDDOWN (76.9, 0) Rounds 76.9 down to zero
decimal places; value 76.

= ROUNDDOWN (3.14159, 3) Rounds 3.14159 down to three
decimal places; value 3.141.

= ROUNDDOWN (-3.14159, 1) Rounds -3.14159 down to one
decimal place; value -3.1.

= ROUNDDOWN (31415.92654, -2) Rounds 31415.92654 down to 2
decimal places to the left of the
decimal; value 31400.

3. COUNT

This function counts the number of cells that contain numbers and
counts numbers within the list of arguments. COUNT is use to get the
number of the entries in a number field (including date also) i.e. in a
range or array of numbers.
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In Excel other than counting function COUNT; other functions are
COUNTA, COUNTBLANK, and COUNTIF —
which  enable us to count the number of
cells that contain values, are nonblank (and
thus contain entries of any kind), or count
only the cells in a given range that meet
the user defined criteria.

The syntax for COUNT is COUNT (value1,
value2…..,) where value1, value2, ...   are
1 to 255 arguments that can be a variety
of different types of data(logical values
represented in numbers, numbers, dates,
or text representation of numbers), but only
numbers are counted.

Arguments that are error values or text
that cannot be translated into numbers are ignored.

If an argument is an array or reference, only numbers in that array or
reference are counted. Empty cells, logical values, text, or error values
in the array or reference are ignored.

COUNTA function will be count logical values, text, or error values.
The Figure 2.20 contains a named range for cells A1:B9 as Count_Data

There are other functions also such as ROWS and COLUMNS are used.
The syntax is as follows:

ROWS (array)

The function returns the number of rows in a reference or array; where
an Array   is an array, an array formula or a reference to a range of
cells for which we want the number of rows.

COLUMNS (array)

This function returns the number of columns in an array or named
range reference; where an Array   is an array or array formula or a
reference to a range of cells for which we want the number of columns.

Figure 2.20

ArrayArrayArrayArrayArray: Used to build single formulas that produce multiple results or that operate on
a group of arguments that are arranged in rows and columns. An array range shares
a common formula; an array constant is a group of constants used as an argument.

Array forArray forArray forArray forArray formulamulamulamulamula: A formula that performs multiple calculations on one or more sets of
values, and then returns either a single result or multiple results. Array formulas are
enclosed between braces { } and are entered by pressing CTRL+SHIFT+ENTER.CTRL+SHIFT+ENTER.CTRL+SHIFT+ENTER.CTRL+SHIFT+ENTER.CTRL+SHIFT+ENTER.

COUNTIF (range, criteria) (Figure 2.21)

This function counts the number of cells within a range that meet the
given criteria; in this function the Range is one or more cells to count,
including numbers or names, arrays, or references that contain
numbers. The blank cells and text values are ignored. (e.g. A2:B5)
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Criteria are the form of a number, expression,
cell reference, or text that defines which cells
will be counted. For example, criteria can be
expressed as 32, “32”, “>32”, “apples”, or B4.

2.1.4.3 Text Manipulation Function

1. TEXT

This function converts a numeric value to text
in a specific number format; and the syntax is :

TEXT (value, format_text) where,

Value   is a numeric value, a formula that evaluates to a
numeric value, or a reference to a cell containing a numeric value.

Format_text   is a numeric format as a text string enclosed in quotation
marks. We can see various numeric formats by clicking the Number,
Date, Time, Currency, or Custom in the Category box of the Number
tab in the Format Cells dialog box, and then viewing the formats
displayed.

This function is useful in situations where we want to display
numbers in a more readable format, or want to combine numbers with
text or symbols. For example, suppose cell L1 contains the number
23.5. Suppose we want to format this number by adding with “Rs.”
and convert into amount using this function:

=TEXT L1,”Rs. 0.00")   which will be displayed as Rs. 23.50 (Figure
2.22).

We can also format numbers by using the
commands in the Number group on the Home
tab of the Ribbon. However, these commands work
only if the entire cell is numeric. Refer Figure
2.22(a); you will find in cell A5(A6) using
function combined with ‘$’ sign which can be

used with other functions (such as logical).

2. CONCATENATE

This function joins two or more text strings into one text string and its syntax is
:

CONCATENATE (text1,
text2,...) where

text1, text2,   …. are  2 to 255
text items to be joined into a
single text item. The text items
can be text strings, numbers, or
single-cell references.

Example combining First Name,

Figure 2.21

Figure 2.22

Figure 2.22(a)
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Middle Name and Surname of the employees into Full Name using
CONCATENATE Function (Figure 2.22(b).

2.1.4.4 Logical Function

We have learned earlier about
IF functions in this chapter. Let us
understand two more other logical
functions which are very useful.
When a situation arises to compare
more than one condition and the
result of joint conditions is used
for further operations.

Figure 2.22(b)

1. AND function gives only a TRUE or FALSE answer.

To determine whether the output will be TRUE or FALSE, the AND
function evaluates at least one mathematical expression located in
another cell in the spreadsheet. The syntax for the AND function is:

= AND (logical-1, logical-2, ... logical-255 )

where logical-1 , logical-2 , ... - refers to the cell reference that is
being checked. Up to 255 logical values can be entered into the function.
Returns TRUE if all its arguments evaluate to TRUE; returns FALSE
if one or more arguments evaluate to FALSE.

ExampleExampleExampleExampleExample

1.  In the following example the outcome of two logical values is given
in Result

Formula Description Result

a.= AND (TRUE, TRUE) all arguments are TRUE TRUE

b.= AND (TRUE, FALSE) One argument is FALSE FALSE

c.= AND (2+2=4, 2+3=5) all arguments evaluate to TRUE TRUE

2.  In these example there are two cell values cell A2 contains 50 and
cell A3 contain 104 then :

Formula Description Result

a. =AND (A2>1, A2<100) Displays TRUE if the number  TRUE
in cell A2 is between 1 and 100.
Otherwise, it displays FALSE.

b. =IF(AND(A3>1, A3<100), Displays the number in cell “The value is
  A3,“The value is out of if it is between 1 and 100. out of range.

Otherwise, it displays the
message

c. =IF(AND(A2>1, A2<100), Displays the number in cell A2, 50
A2, “The value is out of if it is between 1 and 100.
range.”) Otherwise, it displays a message.

A logical valuelogical valuelogical valuelogical valuelogical value (true or false) outcome is the comparison of data values
or results of arithmetic expressions  compared  with another data values
or results of  another arithmetical expressions using logical operator.
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One common use for the AND function is to expand the usefulness of
other functions that perform logical tests.

In the above example, the IF function performs a logical test and then
returns one value if the test evaluates to TRUE and another value if the
test evaluates to FALSE. By using the AND function as the logical_test logical_test logical_test logical_test logical_test
argument of the IF function, we can test many different conditions.

2. OR function is like other logical functions, the OR function gives
only a TRUE or FALSE answer. To determine whether the output will
be TRUE or FALSE, the OR functions evaluates at least one
mathematical expression located in another cell in the spreadsheet.
This function returns TRUE if any argument is TRUE; returns FALSE
if all arguments are FALSE.

The syntax for the OR function is:

= OR (logical-1, logical-2, ... logical-255 )

Logical-1, logical-2 … - refers to the cell references that are being
checked. Up to 255 logical values can be entered into the function.

ExampleExampleExampleExampleExample

Formula Description Result

a.= OR (TRUE, FALSE) One argument is TRUE TRUE

b.=OR ((1+1)=1,(2+2)=5) All arguments evaluate to FALSE FALSE

c.=OR (TRUE,FALSE,TRUE) At least one argument is TRUE TRUE

2.1.4.5 Lookup and References Function

The LOOKUP function returns a value either from a one-row or one-
column range or from an array. The LOOKUP function has two syntax
forms: vector and array.

The Look Up function can be used as an alternative to the IF function
for elaborate tests or tests that exceeds the limit for nesting of IF
functions.

The vector forvector forvector forvector forvector formmmmm of LOOKUPLOOKUPLOOKUPLOOKUPLOOKUP looks in a one-row or one-column range (known as a
vector) for a value, and then returns a value from the same position in a second one-
row or one-column range.

The array forarray forarray forarray forarray formmmmm of LOOKUPLOOKUPLOOKUPLOOKUPLOOKUP looks in the first row or column of an array for the
specified value, and then returns a value from the same position in the last row or
column of the array.

1.  LOOKUP 1.  LOOKUP 1.  LOOKUP 1.  LOOKUP 1.  LOOKUP (Vector Form)

The syntax is LOOKUP (lookup_valuelookup_valuelookup_valuelookup_valuelookup_value, lookup_vectorlookup_vectorlookup_vectorlookup_vectorlookup_vector, rrrrresult_vectoresult_vectoresult_vectoresult_vectoresult_vector)

• Lookup_value is a value that LOOKUP searches for in the first
vector. Lookup_value can be a number, text, a logical value, or a
name or reference that refers to a value.
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• Lookup_vector is a range that contains only one row or one
column. The values in lookup_vector can be text, numbers, or
logical values.

It is important to know that the values in lookup_vector must be placed
in ascending order. For example, -2, -1, 0, 1, 2 or A-Z or FALSE, TRUE
else LOOKUP may not give the correct value.

• Result_vector is a range that contains only one row or column. It
must be the same size as lookup_vector.

• If LOOKUP cannot find the lookup_value, it
matches the largest value in lookup_vector that
is less than or equal to lookup_value.

• If lookup_value is smaller than the smallest value
in lookup_vector, LOOKUP gives the #N/A error
value.

ExampleExampleExampleExampleExample (Figure 2.23)

Column (A) and Column (B) dipicts the frequency and
name of Colour respectively. The results of the use of
LOOKUP function.

Function Description (Result)

=LOOKUP (4.19, A2:A6, B2:B6) Looks up 4.19 in column (A), and returns
the value from column (B) that is in the
same row (orange).

=LOOKUP (5.00, A2:A6, B2:B6) Looks up 5.00 in column (A), and returns
the value from column (B) that is in the
same row (orange).

=LOOKUP (7.66, A2:A6, B2:B6) Looks up 7.66 in column (A), matches the
next smallest value (6.39), and returns the
value from column (B) that is in the same

row (blue).

=LOOKUP (0, A2:A6, B2:B6) Looks up 0 in column (A), and returns an
error because 0 is less than the smallest
value in the lookup vector A2:A7 (#N/A).

2.  LOOKUP2.  LOOKUP2.  LOOKUP2.  LOOKUP2.  LOOKUP (Array Form)

The syntax is LOOKUP (lookup_valuelookup_valuelookup_valuelookup_valuelookup_value, arrayarrayarrayarrayarray)

• Lookup_value is a value that LOOKUP searches for in an array.
Lookup_value can be a number, text, a logical value, or a name
or reference that refers to a value.

 If LOOKUP cannot find the lookup_value, it uses the largest
value in the array that is less than or equal to lookup_value.

 If lookup_value is smaller than the smallest value in the first
row or column (depending on the array dimensions), LOOKUP
returns the #N/A error value.

A B

1 Frequency Colour

2 4.14 red

3 4.19 orange

4 5.17 yellow

5 5.77 green

6 6.39 blue

Figure 2.23
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• Array is a range of cells that contains text, numbers, or logical
values that we want to compare with lookup_value.

 If array covers an area that is wider than
it is tall (more columns than rows),
LOOKUP searches for lookup_value in the
first row.

 If array is square or is taller than it is the
wide (more rows than columns), LOOKUP
searches in the first column.

Example Example Example Example Example (Figure 2.23(a))

Column (A) contains a, b, c, d some text values and Column (B)
contain 10, 20, 30, and 40 some numbers. The Array is A1:B4.

The LOOKUP function used for different alpha character as follows:

Function Description (Result)

=LOOKUP (“c”, A1:B4) Looks up “C” in first row of the array
and returns the value in the last
row that is in the same column (30).

=LOOKUP (“b”, A1:B4) Looks up “b” in first row of the array
and returns the value in the last column

that is in the same row (20).

3.  VLOOKUP3.  VLOOKUP3.  VLOOKUP3.  VLOOKUP3.  VLOOKUP

The VLOOKUP function, which stands for vertical lookup, helps us to
find specific information in large data tables such as an inventory list
of parts or a large employee contact list. The VLOOKUP function
searches and matches first the required value from the column of a
range of cells, and then returns a value from any cell on the same row
of the range. The syntax is

VLOOKUP (lookup_value, table_array,  col_index_num, range_lookup)
where

Lookup_value - The value to search in the first column of the table.
Lookup_value can be a value or a reference. If lookup_value is smaller
than the smallest value in the first column of table_array, VLOOKUP
returns the #N/A error value.

Table_array  - Two or more columns of data. Use a reference to a
range or a range name. The values in the first column of table_array
are the values searched by lookup_value. These values can be text,
numbers, or logical values. Uppercase and lowercase texts are
equivalent.

Col_index_num  – The column number in table_array from which the
matching value must be returned. A col_index_num of 1 returns the
value in the first column in table_array; a col_index_num of 2 returns

A  B

1 a 10

2 b 20

3 c 30

4 d 40

Figure 2.23(a)
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the value in the second column in table_array, and so on. If
col_index_num is:

• Less than 1, VLOOKUP returns the #VALUE! error value.

• Greater than the number of columns in table_array, VLOOKUP
returns the #REF! Error value.

Range_lookup – A logical value that specifies whether we want
VLOOKUP to find an exact match or an approximate match:

• If TRUE or omitted, an exact or approximate match is returned.
If an exact match is not found, the next largest value that is less
than lookup_value is returned. The values in the first column of
table_array must be placed in ascending sort order; otherwise,
VLOOKUP may not give the correct value.

• If FALSE, VLOOKUP will only find an exact match. In this case,
the values in the first column of table_array do not need to be
sorted. If there are two or more values
in the first column of table_array that
match the lookup_value, the first
value found is used. If an exact match
is not found, the error value #N/A is
returned.

In the following examples we will explain
the steps how the VLOOKUP function to
find the specific information from the
spreadsheet table.

Example -1Example -1Example -1Example -1Example -1 (Refer Figure 2.24) to find out
employee’s Basic Pay

=VLOOKUP (A3, A1:D7, 4, FALSE)

Lookup the Basic Pay for Employee Code
3456 (A3) in the first column and return
the matching value in the same row of the
fourth column i.e. 3453.00(d3).

Example - 2Example - 2Example - 2Example - 2Example - 2 (Refer Figure 2.25)

In this example we search the column Item-
ID of baby products from the table A2 :D6
and match the values in the Cost (column
number 3) and Markup (column number 4) columns to calculate prices
and with different test conditions. The final result of the function is
also given after description.

Function Description

= VLOOKUP (“DI-328”, A2:D6, 3, Calculates the retail price of diapers by
FALSE) *  (1 + VLOOKUP  (“DI-328”, adding the markup percentage to the
A2:D6, 4, FALSE)). cost.    Result Rs. 28.96

Figure 2.24

Figure 2.25
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= (VLOOKUP (“WI-989”, A2:D6, 3, Calculates the sale price of wipes by
FALSE) *  (1 + VLOOKUP (“WI-989”, subtracting a specified discount  4,
A2:D6, FALSE))) * (1 - 20%). from the retail price  Result .Rs. 5.73

= IF(VLOOKUP(A2, A2:D6, 3, If the cost of an item is greater than
FALSE) >= 20, “Markup is” and or equal to Rs. 20.00, displays the
100 * VLOOKUP (A2, A2:D6, 4, string “Markup is nn%”; otherwise,
FALSE) and ”%”, “Cost is under displays the string “Cost is under
Rs.20.00”). Rs. 20.00”.

        Result: Markup is 30%

= IF (VLOOKUP (A3, A2:D6, 3, If the cost of an item is greater than
FALSE) >= 20, “Markup is:” and or equal toRs.20.00, displays the string
100 * VLOOKUP (A3, A2:D6, 4, Markup is nn%”; otherwise, displays
FALSE) and”%”, “Cost is Rs.” and the string “Cost is Rs.n.nn”.
VLOOKUP (A3, A2:D6, 3, FALSE))        Result: Cost is Rs. 3.56

4. HLOOKUP4. HLOOKUP4. HLOOKUP4. HLOOKUP4. HLOOKUP

The HLOOKUP function (short name of Horizontal Lookup), searches
for a value in the first row of a table array and returns the corresponding
value in the same column from another row of the same table array.
The syntax for HLOOKUP is as follows:

HLOOKUP(lookup_value, table_array, row_index_num,
range_lookup)  where

• Lookup_value – The value to search for in the first row of the
table array.

• Table_array – Two or more rows of data. The values in the
first row of the table_array are the values searched for the
lookup_value. These values can be text, numbers, or logical
values. Uppercase and lowercase texts are equivalent.

• Row_index_num – The row number in table_array from which
the corresponding value must be returned. A row_index_num
of 2 returns the value in the second column in table_array; a
row_index_num of 3 returns the value in the third column in
table_array, and so on.

• Range_lookup – A logical value that specifies whether we
want HLOOKUP to find an exact match or an approximate
match. If set to “FALSE”, a corresponding value will be returned
only if an exact match is found. If set to “TRUE”, the nearest
match will be considered if an exact one is not found.

Let us take a simple example to understand the HLOOKUP function:
In the following two different worksheets:

Example Example Example Example Example (Figure 2.26 and 2.27)

Worksheet 1 - The values for Budget are in Row 2 corresponding to
each Quarter in Row 1.
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Worksheet 2 - Corresponding to each Quarter
(column (C)); some part of budget is Spent
(column (E)) – which is listed vertically. We
want to pick the budget for each quarter from
the Worksheet 1 and put it in column (D) of
Worksheet 2 and then calculate the amount
Pending (column (F)) correspondingly. In cell
D2:D5 we will enter the HLOOKUP function
as follows: (as shown for D4 cell) = HLOOKUP
(C4; Budget! $A$1:$E$2; 2; FALSE) where in
this function.

C4 lookup value, for the
quarter

budget!$B$1:$E$2 Table array, found in worksheet 1:  named
budget.

2 Row_index_num, is the row 2 in worksheet
1: named Budget

FALSE We want to find an exact match

Pending = D4-E4    Copy both the functions from
D4 to the Cells D2, D3 and D5 and from
F4 to Cells F2, F3 and F5 can be copied.

It is important to note that whenever any table array (or array) is
referred in lookup functions the cell address referred (normally it is
relative) must be converted in to absolute cell addresses.

2.1.2.6 Financial Functions

1. ACCRINT1. ACCRINT1. ACCRINT1. ACCRINT1. ACCRINT

This function returns the accrued interest for a security that pays
periodic interest. The syntax of this is as follows:

ACCRINT (issue, first_interest, settlement, rate, par, frequency, basis,
calc_method)

Dates should be entered by using the DATE function, or as results
of other formulas or functions. For example, use DATE (2008, 5, 23) for
the 23rd day of May, 2008. Problems can be occur if dates are entered
as text.

Issue is the security’s issue date.

first_interest is the security’s first interest date.

Settlement  is the security’s settlement date. The security
settlement date is the date after the issue date when
the security is traded to the buyer.

Rate is the security’s annual coupon rate.
Par is the security’s par value. By default Par is 1000

Figures 2.26 and  2.27
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Frequency is the number of coupon payments per year.
For annual payments, frequency = 1; for Semi-
annual, frequency = 2; for quarterly, frequency = 4.

Basis is the type of day count basis to use.

Excel stores dates as sequential serial numbers so they can be
used in calculations. By default, January 1, 1900 is serial number 1,
and January 1, 2008 is serial number 39448 because it is 39,448 days
after January 1, 1900; in Excel for the ACCRINT is calculated as follows:

1

1

NC

1

rate A
ACCRINT par   

frequency NLλ

= × ×

2. CUMIPMT2. CUMIPMT2. CUMIPMT2. CUMIPMT2. CUMIPMT

This function returns the cumulative interest paid between two periods
(Refer Figure 2.28). The syntax of the function is:

CUMIPMT (rate, nper, pv, start_period, end_period, type)

Rate is the interest rate.

Nper is the total number of
payment periods.

Pv is the present value.

Start_period is the first period in the
calculation. Payment
periods are numbered
beginning with 1.

End_period  is the last period in the
calculation.

Type  is the timing of the payment (which may be either 0 or 1)

0 (zero) means Payment at the end of the period

1 means Payment at the beginning of the period.

3. PV3. PV3. PV3. PV3. PV

This function returns the present value
of an investment. The present value is
the total amount that a series of future
payments is worth now. For example,
when we borrow money, the loan amount
is the present value (Figure 2.29). The
syntax of the function is :

PV (rate, nper, pmt, fv, type) where

Rate   is the interest rate per period.
For example, for an automobile loan at a

Figure 2.28

Figure 2.29
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10% annual interest rate and installments are made the monthly
payments, then the interest rate per month is 10%/12, or 0.83%. The
value for rate into the function will be 10%/12, or 0.83%, or 0.0083.

Nper   is the total number of payment periods in an annuity. For
example, if this loan is a four-year car loan and makes monthly
payments, then loan has 4*12 (or 48) periods. The value for nper will
be 48.

Pmt   is the payment made each period and cannot be change over
the life of the annuity. Typically, pmt includes principal and interest
but no other fees or taxes. For example, the monthly payments on an
Rs.10, 000, for four-year car loan at 12 per cent are Rs. 263.33. We
have to enter -263.33 into the function as the pmt. If pmt is omitted,
then fv must be included in the argument.

Fv   is the future value, or a cash balance to attain after the last
payment is made. If fv is omitted, it is assumed to be 0 (the future
value of a loan, for example, is 0). For example, if we want to save
Rs. 50,000 to pay for a special project in 18 years, then Rs. 50,000 is
the future value. Then it is necessary to guess an interest rate and
determine how much to save each month. If fv is omitted, then pmt

must be included as the argument.

Type   is the number 0 or 1 and indicates when payments are due.
The fv and type arguments are optional. The fv argument is the future
value or cash balance that we want to have after making last payment.
If we omit the fv argument, Excel assumes a future value of zero. The
type argument indicates whether the payment is made at the beginning
or end of the period: (0 or omit the type argument when the payment is
made at the end of the period and use 1 when it is made at the beginning
of the period).

When using financial functions, keep in mind that the fv, pv, and
pmt arguments can be positive or negative, depending on whether we
are receiving the money or paying out the money. It may be noted that
if we want to express the rate argument in the same units as the nper

argument, so that if we make monthly payments on a loan and we
express the nper as the total number of monthly payments, as in 360
(30×12) for a 30-year mortgage, we need to express the annual interest
rate in monthly terms as well. Excel solves for one financial argument
in terms of the others. If rate is not 0, then:

If rate is 0, then:

(pmt * nper) + pv + fv = 0

nper

nper

pv * (1 rate ) pmt(1 rate * type) *

(1 rate ) 1
                 fv C

rate

+ + +

 + −
+ = 
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An annuityannuityannuityannuityannuity is a series of constant cash payments made over a
continuous period. For example, a car loan or a mortgage is an annuity.

4.  FV4.  FV4.  FV4.  FV4.  FV

This function returns the future value of an investment based on
periodic, constant payment and a constant interest rate (Figure 2.30).
The syntax of the function is :

FV (rate, nper, pmt, pv, type) where

Rate is the interest rate per period.

Nper is the total number of payment periods in an annuity.

Pmt is the payment made each period; it cannot change over
the life of the annuity. Typically, pmt contains principal
and interest but no other fees or taxes. If pmt is omitted,
then include the pv value in the argument.

Pv is the present value, or  the lump-sum  amount that a
series of future payments is  worth right  now. If  pv is
omitted, it is assumed to be 0 (zero), and then include
the pmt value in the argument.

Type is the number 0 or 1 and indicates when payments are
due. If type is omitted, it is assumed to be 0.

ExampleExampleExampleExampleExample

Figure 2.30

In the function FV (rate, nper, pmt, pv, type); the values are
substituted as given in different cells of the worksheets and the result
cell A8 is having Rs. 2581.40 first worksheet  for type is 1 while in
second worksheet  shows the value of  result  Rs. 2571.18 for type is 0.

2018-19



Spreadsheet

45

5.  PMT5.  PMT5.  PMT5.  PMT5.  PMT

The PMT function calculates the periodic payment for an annuity,
assuming equal payments and a constant rate of interest (Figure
2.26(d)). The syntax of PMT function is as follows:

= PMT(rate, nper, pv, [fv], [type]) where

rate is the interest rate per period,

nper is the number of periods,

pv is the present value or the amount the future payments
are worth presently,

fv is the future value or cash balance that after the last
payment is made (a future value of zero when we omit this
optional argument)

type is the value 0 for payments made at the end of the period
or the value 1 for payments made at the beginning of the
period.

The PMT function is often used to calculate the payment for mortgage
loans that have a fixed rate of interest.

ExampleExampleExampleExampleExample (Figure 2.31)

In the sample worksheet that contains a
table using the PMT function to calculate
loan payments for interest rate 8% per
annum and principal amount  Rs. 1000/-

Here we have used both values of type
= 0 and 1

6.  RATE6.  RATE6.  RATE6.  RATE6.  RATE

This function returns the interest rate per period of an annuity. RATE
is calculated by iteration and can have zero or more solutions. If the
successive results of RATE do not converge to within 0.0000001 after
20 iterations, RATE returns the #NUM! error value (2.32). The syntax
of the function is as follows:

RATE (nper, pmt, pv, fv, type, guess) where.

Nper is the total number of payment
periods in an annuity.

Pmt is the payment made each period
and cannot change over the life
of the annuity. Typically, pmt
includes principal and interest
but no other fees or taxes. If pmt
is omitted, then include the fv
as argument.

Figure 2.31

Figure 2.32
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Pv is the present value — the total amount that a series of
future payments is worth now.

Fv is the future value, or a cash balance attain after the last
payment is made.

If fv is omitted, it is assumed to be 0 (the future value of a
loan, for example, is 0).

Type is the number 0 or 1 and indicates when payments are due.

0 or omitted means payment is due at the end of the period 1
means payment is due at the beginning of the period.

Guess is the guess for what the rate will be. If omitted, it is assumed
to be 10 per-cent.

7.  NPV7.  NPV7.  NPV7.  NPV7.  NPV

This function calculates the net present value of an investment by
using a discount rate and a series of future payments (negative values)
and income (positive values). The syntax for the function is:

NPV (rate, value1, value2,…. ) where

Rate is the rate of discount over the length of one
period.

Value1, value2, ...  are 1 to 254 arguments representing the
payments and income. Value1, value2, ... must
be equally spaced in time and occur at the end
of each period. NPV uses the order of value1,
value2 …., to interpret the order of cash flows.
It is essential that entry for payment and income
values are in the correct sequence.

The NPV investment begins one period before the date of the value1
cash flow and ends with the last cash flow in the list. The NPV
calculation is based on future cash flows.

If n is the number of cash flows in the list of
values, the formula for NPV is:

NPV (Figure 2.33) is similar to the PV
function (present value). The primary
difference between PV and NPV is that
PV allows cash flows to begin either at
the end or at the beginning of the period.
Unlike the variable NPV cash flow values,
PV cash flows must be constant
throughout the investment.

NPV is also related to the IRR function
(internal rate of return). IRR is the rate for
which NPV equals zero: NPV (IRR (...),) = 0.

n
i

i
i 1

values

(1 rate )−

=
+

NPV

Figure 2.33
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2.2 DATA ENTRY, TEXT MANAGEMENT AND CELL
FORMATTING

In any computerised business application, the basic requirement is to
input data; which may be either for processing parameters e.g. input of
data parameters such as month number and name of the month or number
of working days, DA%, etc.  for the  processing of payroll  of the company
or to update various data elements. In both the cases data   should be
correct, accurate and should be in proper format. This means that data
should be validated, corrected and can be display in proper format.

By default in spreadsheet the numbers are right aligned and texts
are left aligned. The spreadsheet can distinguish different types of
numbers; recognise a date, a currency, or a percentage value or text
etc.  For example, if we type 16/04/1980 in a cell, spreadsheet will
recognise it as a date and act accordingly. The software processes the
data and generates the output; which should be in specific format.
For example 1.5 might represent a value for one and half teaspoon in
one spreadsheet while the same 1.5 would represent constant multiplier
for age in another spreadsheet etc.

2.2.1  DATA ENTRY

Excel also facilitates fast data entry; and automatically repeats data
or can fill data in different cells (column wise or row wise.) For example,
if we repeatedly type the days of the week in different cells instead of
that we could use the built-in data fill options to fill the different
cells with the days automatically. Some of the methods for data entry
are mentioned below:

2.2.1.1 The data fill options

The Fill command can be used to fill data into
worksheet cells (Figure 2.36 & 2.37. The Excel
provides for entering data automatically to
continue a series of numbers, number and text
combinations, dates, or time periods, based on
a pattern that we require. However, to fill
quickly in several types of data series, we select
cells and drag the fill handle  ( A Fill
handle is the small black square in the lower-
right corner of the selection. When we point to
the fill handle, the pointer changes to a black
cross (Refer Figure 2.34 and 2.35).

The fill handle is displayed by default, Click the Microsoft
Office Button , and then click Excel Options.

1. Click Advanced, and then under Editing options, clear or select
the Enable Fill handle and cell drag-and-drop check box to hide or
display the fill handle.

Figure 2.34

Figure 2.35
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2. To avoid replacing existing data when we drag the fill handle, to
make sure that the Alert before overwriting cells check box is
selected. If we don’t want to receive a message about overwriting
non-blank cells, we can clear this check box.

After we drag the fill handle, the Auto Fill Options button appears

so that we can choose how the selection is filled. For example, we can
choose to fill just cell formats by clicking Fill Formatting Only, or we
can choose to fill just the contents of a cell by clicking Fill Without
Formatting.

Option -1 Drag the fil l  handle to fil l  data into adjacent cellsOption -1 Drag the fil l  handle to fil l  data into adjacent cellsOption -1 Drag the fil l  handle to fil l  data into adjacent cellsOption -1 Drag the fil l  handle to fil l  data into adjacent cellsOption -1 Drag the fil l  handle to fil l  data into adjacent cells
(Figure 2.38)

For example, we  want to enter
data in A1:A10 starting value
from 10 and in step of 10 we
will get 10, 20, … 100 by using
drag option as shown in the
Figure 2.34 and Figure 2.35
respectively.

1. Select the cells that contain the data that we want to
fill (A1:A2) into adjacent cells (A3:A10).

2. Drag the fill handle across the cells that we want to
fill.

3. To choose how we want to fill the selection, click Auto Fill
Options, and then click the option that we want.

Figure 2.36

Option - 2 fill the active cell with the contents of an adjacent cellOption - 2 fill the active cell with the contents of an adjacent cellOption - 2 fill the active cell with the contents of an adjacent cellOption - 2 fill the active cell with the contents of an adjacent cellOption - 2 fill the active cell with the contents of an adjacent cell

1. Select an empty cell (A1) enter the value 10.

2. On the Home tab, in the Editing group, click Fill, and then click
on Series option.

Figure 2.38

Figure 2.37
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3. The option window provides direction (row wise i.e., B1:J1 or column
wise i.e., A2:A10) selection. The main option is Step Value (i.e.
increment to the previous cell values in linear form) it is 10 in this
example with respect to cell A1 and while another option is  Stop
Value ( i.e. last value of the data when it is achieved the data fill
stops) is 100 which may be in cell A10.

4. Once we enter the all the options and click OK, we get data filled in
the series A1:A0 as 10:100 in step of 10.

Observe the another example  for Date data we can use fill handle
(it is important to note that all the cells of the columns or rows should
be defined in (required) date data format using Format Cells). In this
example we will enter date 24-11-1952 (or 24-Nov-1952) in cell A1 and
24-12-1952 (or 24-Dec-1952) in cell A2 and then use Auto Fill Options
button  between cells A3:A10; find the changes?

2.2.1.2 Import/Copy Data from other sources

One more method for data entry for any application we can use the
following easiest method which will transfer data into required cells
by copying or importing to Excel worksheet. These data files may be
either in text files or non-text files format.

Text files can be directly read using a text editor such as Note pad
in MS Windows. These files often have extension .txt but can have
other extensions (such as .csv known as Comma Separated Values
text file), easily read into Excel.

To import the data from a text file following steps are important for
Figure 2.39.

1. Create data file using Notepad program of MS Windows (to get
Notepad screen on desktop; click on Start button -> All Programs -
> Accessories -> Notepad).

2. A comma-separated data values in one line of this text file is a row
in a spreadsheet and each entry, separated by a comma, is a column
entry for that row.

3. In the first line provides names for
the columns of the spreadsheet.

4. In the next line onward start
entering the data separate by
comma as per the names given in
first line.

5. It may possible that every data
may not be of similar length but
each data (even a blank data)
should be separated by comma as
per the names of the column.

6. Open a new Excel worksheet from the Office Button.

Figure 2.39
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7. Select Data Tab on the Ribbon.

8. On Data tab; an option Get External Data having From Text option.

9. Click on “From Text” which will allow selecting a Notepad file (Figure
2.40 & 2.41) saved as .cvm into Excel format directly and data will
be copied into respective columns and rows.

10. Each and every data from Notepad file can be saved as an Excel
data file This provides a lead that Excel worksheet consists of four
types of data in cells: labels, values, date and formulas and data
validation.

Figure 2.41Figure 2.40

• Labels (text) are descriptive data such as names, months and
usually include alphabetic characters. Excel aligns text to the
left side of the cell.

• Values (numbers) are generally raw numbers or dates.

 Whole value: If the data is a whole value, such as 34 or 5763,
Excel aligns the data to the right side of the cell.

 Vale with a decimal: If the data is a decimal value, Excel
aligns the data to the right side of the cell, including the
decimal point, with the exception of a trailing 0. For example,
if we enter 246.75, then 246.75 displays; such as 246.70, will
display as 246.7. We can change the display appearance,
column width, and alignment of data.

• Formulas are instructions for Excel to perform calculations.

• Date: If we enter a date, such 16/12, Dec 16, or 16 Dec, Excel
automatically returns 16-Dec in the cell, but the Formula bar
displays 16/12/2008. (The Date format is dependent to Country
Specific Format selection).

2.2.2 DATA VALIDATION

Data validation is a feature to define restrictions on type of data entered
into a cell. We can configure data validation rules for cells data that
will not allow users to enter invalid data, There may be warning
messages when users tries to type wrong data in the cell. The messages
also guide users to what input is expected for the cell, and instructions
to correct any errors.
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Data validation is invaluable because it is necessary that data must
be accurate and consistent. The different methods for data validation
are as follows:

• Create a Drop down List – By this option pre-defined items names
list is referred and restrict the users to select accordingly – e.g. In
the organisation for a business application we want to restrict the

Figure 2.42

users not to enter the names of departments other than Sales,
Finance, R&D, Operation, HR and IT, etc.; for qualification of each
employee not to enter other than MBA, PHD, CA, MCA, ARCHITECT
and MBBS, etc., and the Sex Code should be either “Male” or
“Female” for the employees. Following are the steps described how
to use drop down list: A drop-down list can be prepared in three
different ways which can be used for data validation (Figure 2.42).

• Type a list of values separated by commas, i.e. using delimited
list e.g. Male, Female

• Select the cells on the worksheet
whose values can be used directly
typed in a single row or single
column

• Select the data in cells and create
a Named Range to refer

 Open a blank worksheet

 Enter the column titles e.g
Employee Name (cell A1),
Department (cell B1), Quali-
fication (cell C1) and Sex Code
(cell D1) in the first row and four
different columns respectively
(Figure 2.42). Figure 2.43
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 Enter the Names of Employees in the
column (a) (cells A2:A10).

 Prepare a list of department names
some where in the worksheet  (say
G3:G9).

 Define the Named range ( using
Formula Tab ->Define Name on the
ribbon) say DEPT .

 Select the column (b) e.g. Department
(data to be validated in whole column).Figure 2.44

 In the Data Tab of the ribbon click Data Validation on Data
Tools opens three Data Validation Tabs (Figure 2.43). The first
tab is Setting Tab select List for drop down list option.

 This option will display Validation Criteria and to provide valid
data List in the Source where we have to type Name of the
Range as =DEPT (Figure 2.44). The two more options also

required clicking here one Ignore Blank box then empty or
blank values won’t be allowed and other is In-cell drop down.

 To display an input message when a cell (e.g. B2 later B3:B10) is
selected, click the second tab on data validation option, i.e. Input
Message Tab (Figure 2.45) and enter the desired text in the Title
(e.g. DEPT_T) and provide an input short message for the user
(e.g. SELECT/ENTER DEPARTMENT). Also tick the option to
display this message when the cell is selected (Figure 2.46).

 To set the response settings when invalid data is entered into
the cell click on the third tab of data validation option (Figure
2.46) i.e.  Error Alert Tab. This tab enables :

(a) To display the error alert after invalid data is entered in
the box.

(b) Enter message allows to type the desired message for
user and title for reference purpose.

Figure 2.46Figure 2.45

2018-19



Spreadsheet

53

(c) In Style drop-down menu select Information, Warning or
Stop as per the severity and accuracy requirement for
data where.

(i) Information: displays a message but will prevent
entry of invalid data.

(ii) Warning: displays a warning message but will not
prevent entry of invalid data.

(iii) Stop: will prevent invalid entry of data.

The steps discussed above are shown below in different diagrams
(Figures 2.47(a) to 2.47(d)) which are self explanatory when data for
Department are to be entered in the worksheet:

Figure 2.47 (a) Figure 2.47(b)

Figure 2.47(c) Figure 2.47(d)

To select data or reefing the limited number of data items we can
type the list in the Source Box, separated by commas (Figure 2.43) e.g.
as to enter the Sex Code either Male of Female for an Employee we can
type as =Male, Female. This method of data validation is case sensitive;
if a user types MALE, an error alert will be displayed.

• Setting Limits – As mentioned earlier in the Allow drop-down menu,
select Whole Number, Decimal, Date, Time, or Text Length.
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For example in the same worksheet we can restrict the minimum
age of an employee should be 18 and maximum age should be 58 (Age
can be entered as Whole Number or can be entered Date of Birth as
Date selection then age is calculated).

In this example if Age is a data
element to be entered for every
employee we will validate the Age
as whole number and  outside a
specified range in a particular cell
providing value in Setting tab
(Figure 2.48) and data in between
of minimum 18 and maximum 58
respectively.

Similarly we can check the
number of text characters required
in Employee Name column (for
every employee) i.e. the cell should

not contain blank data; and error message should be displayed e.g.,
we can limit the minimum number of characters in the Employee Name
cell to 10 or less.

• Setting Limits with a Formula – To validate data based on formulas
or values entered in other cells (Figure 2.49). The steps are  as:

• In the Allow drop-down menu, select Custom.

Figure 2.48

Figure 2.49 Figure 2.50

• In the Formula box, enter a formula that calculates a logical value.
If the formula calculates TRUE entry will be valid. If the formula
calculates FALSE entry will be invalid.  The cell gives error message
if the values are not meeting the conditions Some of the examples
are as follows:

 We can prevent duplicate entries in a range on the worksheet
(Figure 2.50) i.e. suppose we check duplicate employee number
or duplicate product code in the asset ledger or duplicate account
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code for the same item entered by user
it shows the error.

 We can limit the sum value for a range
which will cause error if sum of the
values exceeds the given total,  i.e.
suppose the total amount of budget is
fixed and sum of the distribution of
the amount for different items in the
range exceeds then it shows the error
(Figure 2.50(a)

 We can prevent user from adding
spaces before or after the text in entry. The TRIM function
removes spaces before and after the text. This formula checks
that the entry is equal to trimmed entry (Figure 2.50(b).

Figure 2.50(a)

 We can prevent entry of dates that falls on (weekends or
holidays) Saturday or Sunday (or any other day). The WEEKDAY
function returns the number for the date entered in the cell. If
the value is 1(it is Sunday) and 7 (it is Saturday) then data entry
is not allowed (Figure 2.50(c) and error message will be displayed.

2.2.3 DATA VALIDATION FORM

To input data into a spreadsheet, often we type the data into cells
directly. That’s where data validation comes in handy. Instead of typing
the same thing again and again, we can enter data into cells using

Figure 2.50(c)Figure 2.50(b)

A form, whether printed or online, is a document designed with a
standard structure and format that makes it easier to capture, organise,
and edit information.  A data form is a dialog box that displays one
complete record at a time. Data forms can be used to add, change,
locate, and delete records.
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drop-down lists or using data input form. Using a data form can make
data entry easier than moving from column to column when we have
more columns of data than can be viewed on the screen. To create
input data form it is necessary that all the data names must be entered
in the first row of the worksheet, because the input form refers these

data names. To create input data form we have to select the tool 

as Form button to the Quick Access Toolbar  .

The Form button has not been included on the user interface Ribbon,
but we can still use it in Excel 2007 by adding at Quick Access Toolbar
using following commands:

1. Click the arrow next to the Quick
Access Toolbar, and then click More
Commands.

2. In the Choose commands from box,
click All Commands.

3.  In the list box, select the Form
button, and then click Add.

The data form is useful, when data are
of in a simple form of text boxes that
list the column headings as labels is
sufficient and don’t required
sophisticated or custom form features,
such as a list box or spin button.

Excel automatically generates a built-in data form (Figure 2.51).
The data form displays all column headers as labels in a single dialog
box. Each label has an adjacent blank text box in which we can enter
data for each column, up to a maximum of  32 columns. In a data form,
we can enter new rows, find rows by navigating or (based on cell
contents) update rows and delete rows. If a cell contains a formula,
the formula result is displayed in the data form, but we cannot change
the formula by using the data form.

2.3  DATA FORMATTING

Formatting of spreadsheets makes easier to read and understand he
important information (e.g. conditional formatting, number formatting,
text and general spreadsheet formatting etc.). On the Ribbon there are
several tools and shortcuts to format spreadsheets effectively. Some of
them are described as follows:

2.3.1 FORMATTING TOOLS

The formatting tools for:

• Number formatting – Number formatting includes adding per cent
symbols (%), commas (,), decimal places, and currency signs ($,

Figure 2.51
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Rs. etc), date, time, scientific values and as well as some special
formats to a spreadsheet. The type of number format can be
determined once the data is entered into the cell. Here are some
examples:

 Currency: If we enter a financial
value complete with the dollar/
currency sign and two decimal
places, Excel assigns a Currency
format to the cell alongwith the
entry.

 Percentages: If we enter a value
representing a percentage as a whole
number followed by the per cent sign
without any decimal places, Excel
assigns to the cell the percentage
format that follows this pattern along with the entry.

 Dates: If we enter a date (dates are values, too) that follows one
of the built-in Excel number formats, such as 16-04-2009 or 16-
Apr-2009 the program assigns a Date format that follows the
pattern of the date.

Example – Explaining below the steps to format range B4:E7 as
currency with zero decimal places using negative preset format.
The sample unformatted worksheet is shown in the Figure 2.52(a)

Select the range to format, i.e.
B4:E7

From the Ribbon select, Home
Tab with Number option, click
on (Figure 2.52(b) to display
Format Cells dialog box and
choose Number tab.

The Category list shows all
the preset formats available
in Excel, grouped into
categories. A sample
corresponding to the current
selection is shown at the top
of the box.

Select the Category required
i.e. Currency. The right hand
side of the box shows the
different symbols of
currencies. It also shows the
preset for negative values
either minus sign (-) or red

Figure 2.52(a)

Figure 2.52(b)
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coloured number (if we do not want to display negative sign
data).

Change the number of decimal places to Zero (0).

Click OK accept this format.

The output of these steps is shown in the Figure 2.52(c).

Similarly if we select the Category for the range H4:H8 as
Percentage with Decimal Places to 2 digits. The Figure 2.52(d)
will show the effect of this change.

Figure 2.52(c) Figure 2.52(d)

• Special Format Category

Special category data (special numbers)
such as phone numbers, zip codes, and
Social Security numbers which require
different format in a certain way (Figure
2.52(e). From the Category option we select
Special and from corresponding drop-down
box under the Locale we select format special
numbers appropriate to specific countries.

Figure 2.52(e)
• Changing cell colours  -

Select the range to format (e.g. B4:E7 –
Figure 2.52(c).

From the Ribbon select Home Tab with
Number option, click on (Figure 2.42(b)
to display Format Cells dialog box and
choose Fill tab.

Fill tab provide Background Colour,
Pattern Colour and Pattern Style options
for the cell (or cell range to fill).

Select the colour required with desired
pattern style and pattern colour from the
Colour pallets (Figure 2.52(f).

Click OK and we see the result as given
in Figure 2.52(g).

Figure 2.52(f)
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There is other number a format tool on
the Ribbon for which allows number s to
format aesthetically such as :

In the Number section, click the Comma
Style button. Then the thousand digit
numbers or one hundred digit numbers will

be display with a comma
sign which makes it
easier to read. Excel also
allows more precise with these numbers, that’s why
it added two decimal values.

To remove the decimal values, in the Number
section of the Ribbon, click the Decrease Decimal
button. That removes one decimal value. Click the
Decrease Decimal button again  to remove another

decimal value. Similarly we can use to Increase Decimal button twice.

To create own custom format, from the
Format Cell dialog box, click the Custom
category (Figure 2.52(h), select one of the
existing formats, and then proceed to create
by adding appropriate or subtracting
undesired characters.

We can find out the format used in a cell
or some cells of unknown worksheet and can
be changed by using the Format Cells dialog.
In this case Right-click the mouse button
for appropriate cell (s) or column (s) and
choose Format Cells. In the Category list,
select one of the formats as per
characteristics from the right list or select
the custom format.

Adding text formatting – The text formatting is mostly required
for presentation of final output and aesthetically reading of the
information.  There may be display of the text or numbers in different
Fonts; Aligning in Cells,
Changing Colour of Fonts,
Merging of cell ranges to
accommodate data etc.
(Figure 2.52(i & j)) When we
insert a Text box, it looks
quite plain. We can format
text boxes to make them
stand out on the worksheet;
using the options from the
Ribbon; on Insert Tab with

Figure 2.52(g)

Figure 2.52 (i)

Figure 2.52 (j)

Figure 2.52(h)
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the Text dialog box. We can use these drawing tools in dressing them
up with special formatting commands (Figure 2.52(j)). These tools allow
us to add decorative and explanatory material to worksheet and chart.
How the Illustrations Tools or Text Tools can be used; let us
understand from the example using both the tools bars together.

• Change the font or font size in a worksheet (Figure 2.52(j)) and
Figure 2.52(j)

1. Select the cell, range of cells, text, or characters that we want to
format.

2. On the Home tab, in the Font group, we will do the following:

 To change the font, click the font
that we want in the Font box.

 To change the font size, click the
font size that we want in the Font
Size box , or click Increase Font

Size or Decrease Font Size

until the size we want is displayed in the Font Size box.

• Change the cell border (Figure 2.52(k))

1. On a worksheet, select the cell or range of cells that we want to add
a border to, change the border style on, or remove a border from.

2. On the Home tab, in the Font group, we will do one of the
following:

 To apply a new or different border style, click the arrow next

to Borders , and then click a border style.

 To remove cell borders, click the arrow next to Borders, and

then click No Border.

The Borders button displays the most recently used border style. We

can click the Borders button (not the arrow) to apply that style.

• Create a custom cell border (Figure 2.52(j) Figure 2.52(i)

We can create a cell style that includes a

custom border, and can apply to that cell style

when we want to display the custom border

around selected cells.

1. On the Home tab, in the Styles group,
click Cell Styles.

2. Click New Cell Style.

3. In the Style name box, type an appropriate name for the new
cell style.

4. Click Format.

Figure 2.52(k)

Figure 2.52(l)
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5. On the Border tab, under Line, in the Style box, click the line
style that we want to use for the border.

6. In the Colour box, select the colour that we want to use.

7. Under Border, click the border buttons to create the border
that we want to use.

8. Click OK.

9. In the Style dialog box, under Style Includes, clear the check
boxes for any formatting that we do not want to include in the
cell style.

10. Click OK.

11. To apply the cell style, do the following:

12. Select the cells that we want to format with the custom cell
border.

13. On the Home tab, in the Styles group, click Cell Styles.

14. Click the cell style that we want to apply.

• Conditional Formatting

Conditional formatting helps us for specific questions about data. We
can apply conditional formatting to a cell range, a table, or a PivotTable
report. There are important differences to understand when we use
conditional formatting on a PivotTable report (Figure 2.52(k).

• The benefits of conditional formatting (Figure 2.52m)

To analyse data, we often ask ourselves some questions,
such as:

Where are the exceptions in a summary of data
over the past five years?

What is the trend in data over the past two years?

Who is responsible for such results during this
month?

What is the overall age distribution of employees?

Which products have greater than 10% revenue
increases from year to year?

Who are the highest performing and lowest
performing students in the class?

Conditional formatting helps to answer these questions by making it
easy to highlight interesting cells or ranges of cells, emphasise unusual
values, and visualise data by using data bars, colour scales, and icon
sets. A conditional format changes the appearance of a cell range based
on a condition (or criteria). If the condition is true, the cell range is
formatted based on that condition; if the conditional is false, the cell
range is not formatted based on that condition.

Figure 2.52(m)
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• Format all cells by using a colour scale

Colour scales are visual guides that help us to understand data
distribution and their variation. A colour scale helps us to compare a
range of cells by using a gradation of different colours. The shade of
the colour represents higher or lower values. For example, in a green
colour are higher value cells and red colour for lower value cells.

If one or more cells in the range contain a formula that returns an
error, the conditional formatting is not applied to the entire range. To
ensure that the conditional formatting is applied to the entire range, use
an IS or IFERROR function to return a value other than an error value.

1. Select one or more cells in a range, table, or
PivotTable report.

2. On the Home tab, in the Styles group, click the
arrow next to Conditional Formatting, and then
click Colour Scales. (Figure 2.52(n).

3. Select a two-colour scale.

• More than the two colours (Figure 2.52(o)

1. Select one or more cells in a range, table, or
PivotTable report.

2. On the Home tab, in the Styles group, click the
arrow next to Conditional Formatting, and then
click Manage Rules.  The Conditional Formatting
Rules Manager dialog box is displayed. Do one of
the following:

 To add a conditional format, click New Rule. The New
Formatting Rule dialog box is displayed.

 To change a conditional format, do the following:

Figure 2.52(n)

Figure 2.52(o)
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1. Make sure that the appropriate worksheet, table, or PivotTable
report is selected in the Show formatting rules for list box.

2. Optionally, change the range of cells by clicking Collapse Dialog
in the Applies to box to temporarily hide the dialog box, by
selecting the new range of cells on the worksheet, and then by
selecting Expand Dialog.

3. Select the rule, and then click Edit rule. The Edit Formatting
Rule dialog box is displayed.

4. Under Select a Rule Type, click Format all cells based on
their values.

5. Under Edit the Rule Description, in the Format Style list box,
select 3-Colour Scale.

6. To select a Minimum and Maximum Type do one of the following:

 Format lowest and highest values Select Lowest Value and
Highest Value. In this case, we do not enter a Minimum and
Maximum Value.

 Format a number, date, or time value Select Number, and
then enter a Minimum and Maximum Value.

 Format a percentage Select Per cent, and then enter a
Minimum and Maximum Value. Valid values are from 0 (zero)
to 100. Do not enter a per cent sign. Use a percentage when
we want to visualise all values proportionally because the
distribution of values is proportional.

 Format a percentile Select Percentile and then enter a
Minimum and Maximum Value. Valid percentiles are from 0
(zero) to 100.

Percentile is usually used we want to visualise a group of high
values (such as the 20th percentile) in one colour grade proportion
because they represent extreme values that might skew the visualisation
of the data.

 Format a formula result Select Formula, and then enter a
Minimum and Maximum Value.

The formula must return a number, date, or time value. Start the
formula with an equal sign (=). It’s a good idea to test the formula in the
worksheet to make sure that the formula doesn’t return an error value.

• Changing the alignment of data in cells  (Figure 4.52(p)

There are several options to change the alignment of text (data) in cells

Text layoutText layoutText layoutText layoutText layout

Vertical alignment – To specify the vertical position of the text in a
shape, select an option from the list (or from the tool box).

Text direction – To specify the orientation of the text in a shape, select
an option from the list.
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2. Autofit2. Autofit2. Autofit2. Autofit2. Autofit

Resize shape to fit text - To increase the size of the shape vertically
so that the text fits inside of it, click this button.

3. Inter3. Inter3. Inter3. Inter3. Internal marnal marnal marnal marnal margingingingingin

The internal margin is the distance between the text and the outer
border of a chart element. We can increase or decrease the amount of
this space by using the following options.

Left – To specify the distance between the left border of the selected
chart element and the text, enter the margin number that we want in
the Left box.

Right – To specify the distance between the right border of the selected
chart element and the text, enter the margin number that we want in
the Right box.

Top – To specify the distance between the top border of the selected
chart element and the text, enter the margin number that we want in
the Top box.

Bottom – To specify the distance between the bottom border of the
selected chart element and the text, enter the margin number that we
want in the Bottom box.

Columns – To specify the number of columns of text in a chart element
and the spacing between the columns, click this button.

The commands for this

 Select the range.

 Click on Home tab  for Alignment options
which displays the dialog box and select
the alignment tab (Figure 2.38(n)(1).

 Select horizontal and vertical as alignment
required.

 There are other options to display text at
angular orientation or text to be control
within cell or to spread within the cell.

 Click OK.

• Merging a range of Cells

Merged cells are a single cell that is created by combining two or more
selected cells. The cell reference for a merged cell is the upper-left cell
in the original selected range. When two or more adjacent horizontal
or vertical cells are merged, the cells become one large cell and
displayed across multiple columns or rows. The contents of one appear
in the centre of the merged cell. 

Figure 2.52(p)
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1. Select two or more adjacent cells that we want to merge.

2. On the Home tab, in the Alignment group, click Merge and
Centre. (Or button).

3. The cells will be merged in a row or column, and the cell contents
will be centered in the merged cell. To merge cells without
centering, click the arrow next to Merge and Centre, and then
click Merge Across or Merge Cells. The cell address of merge
cells will be the address of lower active cell.

4. To change the text alignment in the merged cell,
select the cell; click any of the alignment buttons
in the Alignment group on the Home tab.

• Split a merged cell (Figure 2.52(q)

1. Select the merged cell.

2. When we select a merged cell, the Merge and Centre button
also appears selected in the Alignment group on the Home tab.

3. To split the merged cell, click Merge and Centre. The contents
of the merged cell will appear in the upper-left cell of the range
of split cells.

• Formatting a Table

There are predefined table styles (or quick styles) that we can use to
quickly format a table. If the pre-defined table styles don’t meet our
needs, we can create and apply a custom table style.

The table formatting by choosing Quick Styles options for table
elements, such as header and total rows, first and last columns, and
banded rows and columns.

• To choose a table style to create a table (Figure 2.52(r))

1. On the worksheet, select a range of cells that we want to quickly
format as a table.

Figure 2.52(r)

Figure 2.52(q)
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2. On the Home tab, in the Styles group, click Format as Table.

3. Under Light, Medium, or Dark, click the table style that we
want to use.

Apply a table style to an existing table

1. On the worksheet, select the table to which we want to apply a
table style.

2. On the Design tab, in the Table Styles group, do one of the
following:

 Click the More button, from the dropdown menu, click the
table style (Light, Medium or Dark) that we want to use.

• Using the NOW function to add the current date to the
spreadsheet

NOW ( ) is the function returns the serial number of the current date
and time. If the cell format was General before the function was entered,
the result is formatted as a date.

Excel stores dates as sequential serial numbers so they can be used
in calculations. By default, January 1, 1900 is serial number 1, and
January 1, 2008 is serial number 39448 because it is 39,448 days after
January 1, 1900.  Numbers to the right of the decimal point in the serial
number represent the time; numbers to the left represent the date. For
example, the serial number 0.5 represents the time 12:00 noon.

•  Adding Headers and Footers to Excel Spreadsheet

In spreadsheet, headers and footers are lines of text
that are printed at the top (header) and bottom (footer)
of each page in the spreadsheet. They contain
descriptive text such as titles, dates, and/or page
numbers and are used to add information to a printed
spreadsheet.

The headers and footers options are available in
Page Layout view (Figure 2.53(a). For other sheet
types, such as chart sheets or for embedded charts
we can work with headers and footers in the Page
Setup dialog box.

Add or change the header or footer text for a
worksheet in Page Layout view

1. Click the worksheet to which we want to add/change headers or
footers.

2. On the Insert tab, in the Text group, click Header and Footer.
(refer Figure 2.53(b)) Or  Do one of the following:

 To add a header or footer, click the left, centre, or right header or
footer text box at the top or at the bottom of the worksheet page.

Figure 2.53(a)
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 To change a header or footer, click
the header or footer text box at the
top or at the bottom of the worksheet
page that contains header or footer
text, and then select the text that we
want to change.

3. Type the text that we want.

• Use Format Painter

To copy quickly formatting from one cell or group of cells to another
part of the spreadsheet uses the format painter. This feature is
very useful when extending a spreadsheet and we need to format
the newly added cells to match the original ones.

• Use of AutoFormat Option

To quickly apply a number of formatting features to a spreadsheet
we can use one of the 17 AutoFormat styles available (in Excel
2007). These styles combine a number of formatting options that
will instantly give our spreadsheet a professional look.

2.4  OUTPUT REPORTS

We can print entire or partial worksheets and workbooks,
one at a time, or several at once. The MS Excel can
print just the Excel table or also it provides to:

(a) Print a partial or entire worksheet or
workbook.

(b) Print several worksheets at once.

(c) Print several workbooks at once.

(d) Print an Excel table.

(e) Print a workbook to a file.

(f) Print a graphic Charts and Pivot Tables.

We can also print a workbook to a file instead of to
a printer. This is useful when we need to print the
workbook on a different type of printer from the one to
another printer. The printing option is available to print
quickly or to preview the printout before printing, click
Microsoft Office Button, click the arrow next to Print, and then click
Quick Print or Print Preview (Figure 2.54).  To print worksheet or
table; basic preparation for printing is required and describe below:

2.4.1  DEFINING THE PRINT AREA

By default, Excel prints all data on the current worksheet but for
specific and formatted print we have to define print area from the Page
Setup dialog box or the Print Area command from the Page Layout
option of the Ribbon (Figure 2.55).

Figure 2.54

Figure 2.53(b)
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•   The Print Area using Dialog Box Option

1. Select the Page Layout command tab
on the Ribbon.

2. In the Page SetupPage SetupPage SetupPage SetupPage Setup group, click Page
Setup.  The Page SetupPage SetupPage SetupPage SetupPage Setup dialog box
appears.

3. Select the Sheet tab.

4. In the Print Area text box, type the
range of cells you want to print or to
select the area –

a. Click Collapse Dialog

b. Select the desired range of cells

c. Click Restore Dialog

5. Click OK and the print area is defined.

•   The Print Area using Print Area Option

Excel keeps the print area defined until it
is cleared or replaced. To set the print area:

1. Select the range of cells to print (e.g. A1:H10 of Figure 2.55)

2. Select the Page Layout command tab

3. In the Page Setup Page Setup Page Setup Page Setup Page Setup group, click Print Area» select Set Print
Area. The print area is set.

4. OPTIONAL: To add more data to the print area

a. select a range of cells

b. In the Page Setup group, click Print Area» select Add to Print
Area; the selected cells are added to any previously selected
data.

c. Repeat steps a and b as necessary.

• To clear the print area

1. In the Page Setup Page Setup Page Setup Page Setup Page Setup group, click Print Area» select Clear Print
Area

Printing Ranges of CellsPrinting Ranges of CellsPrinting Ranges of CellsPrinting Ranges of CellsPrinting Ranges of Cells

We can manually select ranges of cells for printing and also have the
option of selecting multiple non-contiguous ranges for printing.

• To select Print Range manually (using key board only)

1. Select the range of cells to be printed
or

From the Name Box pull-down list, select the range name to be
printed.

Figure 2.55
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2. In the top left corner of the Excel window, click the Office Button»
select PrintPrintPrintPrintPrint or Press [Ctrl] + [P] the Print dialog box appears.

3. In the Print what section, select Selection.Selection.Selection.Selection.Selection.

4. Click OK. The specified range of cells is printed.

• To select Print Multiple Ranges

Excel facilitates to print non-contiguous ranges. Selected ranges
will print on separate pages.

1. Select the first range to be printed.

2. Press [Ctrl] + select the second range to be printed .

3. For each additional range to be printed, repeat step 2.

4. In the top left corner of the Excel window, click the Office Button
– select PrintPrintPrintPrintPrint OR Press [Ctrl] + [P]. The Print dialog box appears.

5. In the Print what section, select Selection.Selection.Selection.Selection.Selection.

6. Click Print. The specified range of cells is printed.

2.5  PREPARATION OF REPORTS USING PIVOT TABLE

A Pivot Table is way to present information in a report format. A
PivotTable report often provides enhanced layout, attractive and
formatted report with improved readability. This report is prepared
from the spreadsheet once we add the fields with appropriate level of
details, calculations and group the data as per required information.
The Pivot Table uses a List Data Table (Database).

2.5.1  ONE-VARIABLE DATA TABLE

• C1 cell is an input cell. We will create one-variable data table
which calculates the increase in the budget corresponding to
each of the possible increase in costs.

• If the data table is column-oriented, type the formula (=A2*C1) in
the row (row number 4) above the first value (in cell B5) and one
cell to the right (in cell C4) of the column of values (Figure 2.56).

A data tabledata tabledata tabledata tabledata table is a range of cells that shows the results of substituting different values
in one or more formulas. There are two types of data table: One-variable and two-
variable.

One-variable data tableOne-variable data tableOne-variable data tableOne-variable data tableOne-variable data table (Figure 2.56(a) Formula used in a one-variable data table
must refer to an input cell. The input cell is a cell used by Excel in which each input
value from a data table is substituted (column-oriented, i.e. input cell down one
column or row-oriented, i.e. across one-row).

TTTTTwo-variable data tablewo-variable data tablewo-variable data tablewo-variable data tablewo-variable data table (Figure 2.56(b) use only one formula with two lists of input
values. The formula must refer two different input cells.
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• Enter a column of values from B5:B10.

• Select all cells in the range B4:C10(Fig 2.56(a).

• On the Data tab on the Ribbon, in the Data
Tools group, click What-if-Analysis, and
then click Data Table (Figure 2.56(b).

• In the Row input cell box no  entry.

• In the Column input cell box, enter  $C$1

• Click OK to generate table.

2.5.2 TWO-VARIABLE DATA TABLE (Figure 2.57)

This we will learn by one simplest example
generating a mathematical table in which two
input cells uses B1 and C1 to generate a 15×15
multiplication table by multiplying each other.

• In a cell B2 on the worksheet, enter the formula
(= B1 *C1) that refers to the two input cells.

Figure 2.56 Figure 2.56(b)

Figure 2.56(a)

Figure 2.57 Figure 2.57 (a)

2018-19



Spreadsheet

71

• Type one list of input values in the
same column below the (or fill the
series from  1 to 15 in B3:B17).

• Type the second list in the same row
( or fill the series from 1 to 15 in
C3:Q3), to the right of the formula.

• Select the range of cells that
contains the formula and both the
row and column of values i.e.
B2:Q17.

• On the Data tab on the Ribbon, in
the Data Tools group, click What-
if-Analysis, and then click Data Table.

• In the Row input cell box enter $B$1.

• In the Column input cell box, enter
$C$1.

• Click OK to generate table (Figure 2.57(a))

2.5.3  PIVOT TABLES

The Pivot Table feature allows us to create a
cross tabulation summary of data in which
heading can subsequently moved to give
different views of the data. We will understand
with the help of following example.

Example: A spreadsheet (Figure 2.58)
provides the data for consumption from D2:D37
(in Metric Tons) of three different vegetables
namely Carrot, Onions and Potatoes during the
three days of the week in four different metro
cities. The quota of consumption is fixed by
Food Department to supply of these vegetables
in the city. The spread sheet shows the Actual
Consumption and Surplus (i.e. = actual –
quota).

• Click the data from A1: E37

• On the Insert tab on the Ribbon, in the
Tables group, click Pivot Table, and
then click Pivot Table to start Pivot Table
Report interactive options (Figure 2.58(a)
as Create Pivot Report (Figure 2.58(b).

• Enter the data location

• Choose to place the Pivot table on an Existing worksheet (say
G19).

Figure 2.58(a)

Figure 2.58

Figure 2.58(b)
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• Click OK to display a blank Pivot table and filed list (Figure
2.58(c) and Excel displays the Pivot Table Toolbar

1. Drag the Field Names (From
location number 1) to the
require positions in the pivot
table (location Number 6).

2. Report Filter “Day”

3. Column Label “Vegetable”

4. Row Label “City”

5. Values “Sum of Actual” and
the final result will be
displayed (Figure 2.58(d).

6. In the above selections at Row
Label we give “City” and then
“Vegetable”; while in column
Label if we do not enter any
selection. The Pivot Report will
be as shown in Figure 2.58(e).

The Pivot Table tool bar (Figure 2.58(f) provides various flexibility to
work on data.

Figure 2.58(c)

Figure 2.58(d) Figure 2.58(e)

Figure 2.58(f) : Pivot Table Toolbar
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Advantages of Pivot Table (Report)

A PivotTable report is an interactive way to quickly summarise large
amounts of data. Use a PivotTable report to analyse numerical data in
depth and to answer unanticipated questions about data. A PivotTable
report designed for:

 Querying large amounts of data in user-friendly ways. Sub totaling
and aggregating numeric data, summarising data by categories and
subcategories, and creating custom calculations and formulas.

 Expanding and collapsing levels of data to focus on results, and
providing from details to the summary of data for areas of interest.

 Moving rows to column or columns to rows (or “pivoting”) to see
different summaries of the source data.

 Filtering, sorting, grouping, and conditionally formatting the most
useful and the interesting subset of data to enable us to focus on
the information that we want.

 Presenting concise, attractive, and annotated online or printed
reports.

 The use of a PivotTable report is to analyse related totals, when we
have a long list of figures to sum and to compare several facts
about each figure.

2.6. COMMON ERRORS (MESSAGES) IN SPREADSHEET

4.1.1  MARK COMMON FORMULA ERRORS

1. Click the Microsoft Office Button, click Excel Options, and then
click the Formulas category.

2. In the Error Checking section, select the Enable background error
checking check box.

3. To change the colour of the triangle that marks where an error
occurs, in the Indicate errors using the colour box, select a new
colour.

4. Select a cell with a triangle in the top-left corner of a cell.

5. Next to the cell, click the Error Checking button that appears, and
then click the option that we want. The commands are different for
each type of error, and the first entry describes the error. If we click
Ignore Error, the error is marked to be ignored for each consecutive
check.

6. Repeat the two previous steps.

• Correct an error value

If a formula cannot properly evaluate a result, e Excel will display an error
value. Each error type has different causes, and different solutions. Some
are discussed here to understand them properly before redo the operation

Figure 2.59
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• Correct a ##### error

This error occur when a column is not wide enough, or a negative date
or time is used.

Reason: The column is not wide enough to display the content

1. Select the column by clicking the column header.

2. On the Home tab, in the Cells group, click Format, and then
click AutoFit Column Width. Alternatively also we can double-
click the boundary to the right of the column heading.

3. Select the column.

4. On the Home tab, in the Cells group, click Format, click Format
Cells, and then click the Alignment tab.

5. Select the Shrink to fit check box.

Apply a different number format

In some cases, we can change the cell’s number format to
make the number fit within the existing cell width. For
example, we can decrease the number of decimal places
after the decimal point.

•  Correct a #DIV/0! Error

This error occurs when a number is divided by zero (0).

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it is appears.

Reasons

a. Entering a formula that contains explicit division by zero (0) —
for example, =5/0.

Dates and times are negative numbersDates and times are negative numbersDates and times are negative numbersDates and times are negative numbersDates and times are negative numbers

When a date or time is typed in a cell, it appears in a default date and time format.
The default date and time format is based on the Regional date and time settings that
are specified in Windows Control Panel, and changes when changes are made to
those settings. We can display numbers in several other dates and time formats, most
of which are not affected by Control Panel settings.

 If we are using the 1900 date system, dates and times in Excel must be positive
values.

 When we subtract dates and times, make sure that we build the formula correctly.

 If the formula is correct but the result is still a negative value, we can display the
value by formatting the cell with a format that is not a date or time format.

1. On the HomeHomeHomeHomeHome tab, in the CellsCellsCellsCellsCells group, click ForForForForFormatmatmatmatmat, click ForForForForFormat Cellsmat Cellsmat Cellsmat Cellsmat Cells, and
then click the NumberNumberNumberNumberNumber tab.

2. Select a format that is not a date or time format.

Figure 2.60
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b. Using the cell reference to a blank cell or to a cell that contains
zero as a divisor.

Solutions

 Change the cell reference to another cell.

 Enter a value other than zero in the cell used as a divisor.

 Enter the value #N/A into the cell referenced as the divisor,
which changes the result of the formula to #N/A from #DIV/0!
To denote that the divisor value is not available.

 Prevent the error value from displaying by using the IF worksheet
function. For example, if the formula that creates the error is
=A5/B5, use =IF (B5=0,””, A5/B5) instead. The two quotation
marks represent an empty text string.

•   Correct a #N/A error

This error occurs when a value is not available to a function or formula.

1. Optionally, click the cell that displays the error, click the button

that appears, and then click Show Calculation Steps if it appears.

Reasons and Solutions

a. Missing data, and #N/A or NA() has been entered in its place.

b. Giving an inappropriate value for lookup function as an argument
such functions may be HLOOKUP, VLOOKUP, MATCH or LOOKUP.

c. Using these lookup functions to locate the value in an unsorted
table.

d. Using an argument in the array formula that is not in the same
number of rows or columns as the range that contains the array
formula.

•   Correct a #NAME? Error

This error occurs when Excel doesn’t recognize text in a formula.

Reasons:

a. The EUROCONVERT function without the Euro Currency Tools
add-in being loaded.

Solutions
1. Click the Microsoft Office Button , click Excel Options, and

then click the Add-ins category.

2. Select Excel Add-ins in the Manage list box, and then click Go.

3. In the Add-Ins available list, select the Euro Currency Tools
check box, and then click OK.

•   Correct #NULL! Error

This error occurs when we specify an intersection of two areas that do
not intersect. The intersection operator is a space between references.
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1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Possible causes and solutions.

Incorrect range operator

 To refer to a contiguous range of cells, use a colon (:) to separate
the reference to the first cell in the range from the reference to
the last cell in the range. For example, SUM (A1:A10) refers to
the range from cell A1 to cell A10 inclusive.

 To refer to two areas that don’t intersect, use the union operator,
the comma (,). For example, if the formula sums two ranges
make sure that a comma separates the two ranges (SUM (A1:A10,
C1:C10)).

Ranges do not intersect

 If there are no squares at each corner of the colour-coded border,
then the reference is to a named range.

 If there are squares at each corner of the colour-coded border,
then the reference is not to a named range.

5. Double-click the cell that contains the formula we want to change.
Excel highlights each cell or range of cells with a different colour.

6. Do one of the following:

 To move a cell or range reference to a different cell or range,
drag the colour-coded border of the cell or range to the new cell
or range.

 To include more or fewer cells in a reference, drag a corner of
the border.

 In the formula, select the reference, and type a new one.

7. Press ENTER.

8. Do one of the following:

 Select the range of cells that contains formulas in which we
want to replace references with names.

 Select a single cell to change the references to names in all
formulas on the worksheet.

9. On the Formulas tab, in the Defined Names group, click the
arrow next to Define Name, and then click Apply Names.

10.In the Apply Names box, click one or more names.

•   Correct#NUM! Error

This error occurs with invalid numeric values in a formula or function.

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Review the following possible causes and solutions:
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 Using an unacceptable argument in a function that requires a
numeric argument.

 Make sure that the arguments (argument: The values that a
function uses to perform operations or calculations. The type of
argument a function uses is specific to the function. Common
arguments that are used within functions include numbers, text,
cell references, and names.) used in the function are numbers.
For example, even if the value we want to enter is $1,000, enter
1000 in the formula.

 Using a worksheet function that iterates, such as IRR or RATE,
and the function cannot find a result.

 Use a different starting value for the worksheet function.

 Change the number of times Microsoft Office Excel iterates
formulas.

1. Click the Microsoft Office Button , click Excel Options, and

then click the Formulas category.

2. In the Calculation options section, select the Enable iterative
calculations check box.

3. To set the maximum number of times that Excel will recalculate,
type the number of iterations in the Maximum Iterations box.
The higher the number of iterations, the more time that Excel
needs to calculate a worksheet.

4. To set the maximum amount of change that we will accept between
calculation results, type the amount in the Maximum Change
box. The smaller the number, the more accurate the result and
the more time that Excel needs to calculate a worksheet. Entering
a formula that produces a number that is too large or too small
to be represented in Excel.

•   Correct a #REF! Error

This error occurs when a cell reference (cell reference: The set of
coordinates that a cell occupies on a worksheet. For example, the
reference of the cell that appears at the intersection of column B and
row 3 is B3.) is not valid.

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Review the following possible causes and solutions:

 Deleting cells referred to by other formulas, or pasting moved
cells over cells referred to by other formulas.

 Change the formulas, or restore the cells on the worksheet by
clicking Undo immediately after we delete or paste the cells.

 Using an Object Linking and Embedding (OLE) link to a program
that is not running.

 Start the program.
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 Linking to a Dynamic Data Exchange (DDE) topic such as “system”
that is not available.

 Make sure that we’re using the correct DDE topic.

 Running a macro that enters a function that returns #REF!

•  Correct a #VALUE! Error

This error occurs when the wrong type of argument (argument: The
values that a function uses to perform operations or calculations. The
type of argument a function uses is specific to the function. Common
arguments that are used within functions include numbers, text, cell
references, and names.) or operand (operand: Items on either side of
an operator in a formula. In Excel, operands can be values, cell
references, names, labels, and functions.) is used.

1. Optionally, click the cell that displays the error, click the button
that appears, and then click Show Calculation Steps if it appears.

2. Review the following possible causes and solutions.

 Entering text when the formula requires a number or a logical
value, such as TRUE or FALSE.

 Microsoft Office Excel cannot translate the text into the correct
data type. Make sure that the formula or function is correct for
the required operand or argument, and that the cells that are
referenced by the formula contain valid values. For example, if
cell A5 contains a number and cell A6 contains the text “Not
available”, the formula =A5+A6 will return the error #VALUE!.

 Entering or editing an array formula, and then pressing ENTER.

 Select the cell or range of cells that contains the array
formula (array formula: A formula that performs multiple
calculations on one or more sets of values, and then returns
either a single result or multiple results. Array formulas are
enclosed between braces { } and are entered by pressing
CTRL+SHIFT+ENTER.), press F2 to edit the formula, and then
press CTRL+SHIFT+ENTER.

 Entering a cell reference, a formula, or a function as an array
constant.

 Make sure that the array constant (constant: A value that is not
calculated and, therefore, does not change. For example, the
number 210, and the text “Quarterly Earnings” are constants.
An expression, or a value resulting from an expression, is not a
constant.) is not a cell reference, formula, or function.

 Supplying a range to an operator or a function that requires a
single value, not a range.

 Change the range to a single value.

 Change the range to include either the same row or the same
column that contains the formula.
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SummarySummarySummarySummarySummary

• Setting up a spreadsheet can be fairly time consuming, although templates,
or sample spreadsheets, are available with most of software packages. The
computeried spreadsheet can be formatted with different print layouts. It
allows working with rows and columns of numbers and use formula to do
“what if” calculations. The spreadsheet gives considerable power and
flexibility in entering and editing information, setting up calculations with
formula and functions, and printing the results. It has rows that are
horizontal lines of information that are numbered on the left-hand side of
the Excel workbook. Columns are vertical lines of information and are
identified by letters along the top of the spreadsheet. Rows and columns
intersect to form cells.  A cell is addressed by the column and row position,
for example B4 is the intersection of column b and row 4.

• In the earliest spreadsheets, cells were a simple two-dimensional grid.
Over time, the model has been expanded to include a third dimension, and
in some cases a series of named grids, called sheets.

• In any worksheet or spreadsheet a cell is the smallest element which may
contain a value or a formula or a function or it may simply be left empty. To
use formula or function in the cell; usually begin with = sign by convention.

• A cell reference is the name cell in the spreadsheet. Most cell references
indicate another cell in the same spreadsheet, but a cell reference can also
refer to a cell in a different sheet within the same spreadsheet or to a value
from a remote application. A typical cell reference consists the column
followed by a row number is called relative cell reference. Both column
and row number; either part can be relative changes when the cell or
formula in it is moved or copied from other cell or absolute (indicated with
$ in front of the part concerned of the cell reference). The older “R1C1”
reference style consists of the letter R, the row number, the letter C, and
the column number; relative row or column numbers are indicated by
enclosing the number in square brackets. Most current spreadsheets use
the A1 style, some providing the R1C1 style as a compatibility option. When
the computer calculates a formula in one cell to update the displayed value
of that cell, cell reference(s) in that cell, naming some other cell(s), cause
the computer to fetch the value of the named cell(s).

• A reference to a range of cells is typically of the form (A1:A6) which specifies
all the cells in the range A1 through to A6. A formula such as “=SUM
(A1:A6)” would add all the cells specified and put the result in the cell
containing the formula itself.

• A function is a special key word which can be entered into a cell in order to
perform and process the data which is appended within brackets. There is
a function button on the formula toolbar (fffffx); which function offers assistance

2018-19



80

Computerised Accounting System

and useful prompts into a spreadsheet cell. Alternatively we can enter the
function directly into the formula bar. A function involves four main issues:

• Name of the function.

• The purpose of the function.

• The function needs what argument(s) in order to carry its assignment.

• The result of the function.

• Formatting of spreadsheets makes easier to read and understand the
important information (e.g. conditional formatting, number formatting, text
and general spreadsheet formatting etc.). A cell or range can optionally be
defined to specify how the value is displayed. The default display format is
usually set by its initial content if not specifically previously set, so that for
example “24/11/1952” or “24 Nov 1952” would default to the cell format of
“date”. Similarly adding a % sign after a numeric value would tag the cell
as a percentage cell format. The cell contents are not changed by this
format, only the displayed value.

• To print an entire spreadsheet choose Page Setup from the File Menu,
Choose the appropriate options in terms of horizontal (landscape) or vertical
(portrait) printing, Excel prints entire spreadsheet document, if the document
is too wide to fit on a page, Excel will print the remaining columns on
subsequent pages before continuing to print the remaining rows.

• We can save our document every 5 minutes. The first time we  save, go to
the File Menu and pull to Save, make sure the document is in the correct
folder and on the correct drive, type the name for what we want to save it
as, and click in the save box.
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EXERCISE

Q1. MULTIPLE CHOICE QUESTIONS

1. The best way to get started in Excel 2007 is to click the _____. 

a. View toolbar.

b. Home tab.

c. Microsoft Office Button.

d. None of the above.

2. Which key combination collapses the ribbon?

a. [Ctrl]+[F1]

b. [Ctrl]+[F3]

c. [Ctrl]+[F5]

d. [Ctrl]+[F7]

3. Which view shows margins and the rulers?

a. Normal

b. Page Layout

c. Page Setup

d. Review

4. As you type a number in a cell, what mode appears in the status bar?

a. Enter mode

b. Ready mode

c. Edit mode

d. Record mode

5. Where is the address of the active cell displayed?

a. Row heading

b. Status bar

c. Name Box

d. Formula bar

6. Which command reverses the last action performed in the worksheet?

a. Cut

b. Undo
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c. Redo

d. Paste

7. When navigating in a workbook, which command is used to move to the
beginning of the current row?

a. [Ctrl]+[Home]

b. [Page Up]

c. [Home]

d. [Ctrl]+[Backspace]

8. Which key when pressed displays the access keys?

a. [Alt]

b. [Ctrl]

c. [Shift]

d. [Esc]

9. Which command allows you to reverse an Undo command?

a. Redo

b. Repeat

c. Reset

d. Reverse

10. Which function results can be displayed in AutoCalculate?

a. SUM and AVERAGE

b. MAX and LOOK

c. LABEL and AVERAGE

d. MIN and BLANK

11. Which cell alignment is assigned to most values by default?

a. Right

b. Left

c. Centre

d. Decimal

12. Which function automatically totals a column or row of values?

a. TOTAL

b. ADD

c. SUM

d. AVG
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13. Which mathematical operator is represented by an asterisk (*)?

a. Exponentiation

b. Addition

c. Subtraction

d. Multiplication

14. Which step completes an entry and moves the pointer to the cell to the right?

a. Pressing [Enter]

b. Pressing [Tab]

c. Pressing [Shift]+[Tab]

d. Pressing [Shift]+[Enter]

15. How many blank worksheets are shown when a new workbook is created?

a. One

b. Two

c. Three

d. Four

Q2. ANSWER THE FOLLOWINGS QUESTIONS

1. Define spreadsheet and its salient features?

2. Write any five advantages using electronic spreadsheet in place of manual
spreadsheet.

3. Define workbook and worksheet. What is the difference between them?

4. Explain active worksheet?

5. Using Fill: Series command in Excel write down the steps to fill data from
120,320…..2300 in Column A.

6. Define Data Range, Name Range and How these are created and selected?

7. Write down the steps for the use of Custom Lists.

8. Explain the purpose of Format, Conditional Formatting and Auto Format.

9. What is Wrap Text feature of Excel, Merging of Cells and what will be the cell
address of merged cells?

10. Explain the purpose of using Print Preview?

11. Explain difference between relative reference and absolute reference?

12. Discuss IF function and nested IF functions giving example?

13. Write down examples for any two financial functions you know with their proper
syntax.
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14. What is the use of PMT function?

15. How many ways Data Entry is possible in Spread Sheet?

16. Define one-variable Table and Two-variable table. Explain these with examples.

17. Define Pivot Table and explain usage?

18. What are formulas and how they are created?

19. Write down the differences between formula and function?

Q3. SKILL REVIEW

A. You had started your own online business to sale and find out the sales for the
first week is as follows:

Monday Rs.120.45

Tuesday Rs.187.43

Wednesday Rs.106.87

Thursday Rs.143.69

Friday Rs.117.52

Saturday Rs.87.93

Sunday Rs.92.12

Use a function to work out how much you earned, on average, each day.

B. Use a Days360 function to work out how many days are left before your next
birthday. Instead of typing out the current date in say cell A2, you can use this
inbuilt function:

=Now (   )

The Now function doesn’t need anything between the round brackets. Once
you have today’s date, you can enter your birthday in say cell B2.

C. Create an Activity Report (Weekly) for a Sales Representative working in a
reputed home appliances manufacturing company. Details recorded should
contain Date of Visit, Day of Visit, Name of Shop/Dealer Visited, Address, Phone
Number, Name of Product (Dealing), Type of Response (by the Dealer), Demand
of Product and Duration Spent (in hrs)..

a. Fill data in Date of Visit, Day of Visit using Fill Series.

b. Name the worksheet created above as Weekly Visit Report.

c. Cerate Product-wise, Dealer-wise Monthly Report which should include Total
Hours Spent.

d. Count total number of dealers visited and dealers who gave positive
response.
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Create a worksheet to record sales of home appliances sold by M/s Home Maker
Ltd. In the following format:

Date of Name of Name of  Make Quantity Sales
Sales Customers Products      Amount

The product lists includes Television sets, Refrigerators, Micro wave ovens,
Water Coolers, Air Coolers, Geezers and Air conditioners of different Makes
(and models). The cost of price of television is ranging from Rs. 10,000 to
Rs. 56,000; refrigerator is Rs. 13,000 to Rs. 45,000, micro wave ovens, water
coolers, geezers and air coolers are from Rs. 8,000 to Rs. 25,000 and Air
Conditioners are from Rs. 18,000 to Rs. 55,000. The shopkeeper sales these
products adding 17.25% more on cost price. He provides a discount of 4.35%
on total amount if any customer purchases two products on the same date.
Enter 30 records of different dates (for a month) and different customers
accordingly. Calculate the following:

a. Product wise weekly sales and discount.

b. Calculate the profit of shopkeeper.

c. Product wise total sales of the month and discount offered.

D. Create a worksheet to keep track of revenue collected and expenses done in
conducting tour programs at different tourist places during 2004 to 2008.
Format the numeric data in currency format, prepare year wise columns for
revenue and expenses for each tourist place and calculate the difference. The
calculated difference may be negative, the format of negative balance may be
red coloured. Use conditional formatting for higher and lower values of revenue
and expenses. Align entire text in centre. The font of tourist place is Arial with
14 point while the font of year is Times Roman with 14 points.

(Amount in lacs)

Tourist 2004 2005 2006 2007 2008
 Place

Rev Exp Rev Exp Rev Exp Rev Exp Rev Exp

 Manali 123 55 234 123 345 333 333 365 365 453

 Kashmir 234 123 123 55 365 453 345 333 333 365

 Shilong 345 333 333 365 123 55 234 123 456 233

 Kerala 333 365 365 453 234 123 123 55 345 333
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   ANSWERS

1. c 2. a 3. b 4. a 5. c 6. b

7. c 8. a 9. a 10. a 11. b 12. c

13. d 14. b 15. c
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USE OF SPREADSHEET

IN BUSINESS

APPLICATIONS

Introduction
After studying this chapter you will be
able to use spreadsheet for:

• Computing employee’s gross
salary. Making necessary
deductions to calculate net
salary, payroll accounting.

• Calculation of deprecation by
various methods.

• Loan repayment, interest
calculation.

3

 

In the previous chapter, we have learned about
the spreadsheet and its several features that can
be used in business applications. In this chapter,
we shall discuss the applications of spreadsheet
(using Excel) to Payroll Accounting and some other
select applications (Asset Management, and Loan
Repayment).

3.1 PAYROLL ACCOUNTING
Every employee is paid salary on a pre-determined
date within the framework of employee contract
and related personnel policy in force from time to
time in an organisation.

The computation of salary payment is based
on the number of days an employee has worked,
rate per grade of pay, rate of applied allowances
and deductions to be made therefrom.

The preparation of salary bill should provide
for the following :

• Maintaining payroll related data such as
Employee No., Name, Attendance, Basic Pay,
applicable Dearness and other Allowances,
deductions to be made.

• Periodic payroll computations: the payroll
computation includes the calculation of various
earning and deduction heads, which are to be
derived from basic values (such as basic salary,
number of days under leave without pay (LWP)
and unauthorised absence, etc) as per the
formulae.
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• Preparation of salary statement and employees salary slips

• Generation of advice to bank: It contains the net salary to be
transferred to individual bank account of employees and other salary
related statutory payments such as provident fund, tax, etc.

3.1.1 PAYROLL COMPONENTS

Every employee is under contractual relationship of service with an
organisation, and is paid salary accordingly. The following elements
are important for salary computation and its payment:

• CURRENT PAYROLL PERIOD (MONTH AND YEAR)

• EARNINGS

 Basic Pay (BP) : It is the pay in the pay scale plus Grade Pay,
but does not include Special Pay.

 Grade Pay (GP) : It is the pay to be added to the Basic Pay
according to the Designation of the employee and applicable pay
band or scale of pay.

 Dearness Pay (DP) : It is that portion of Dearness Allowance,
which has been declared and deemed to have been merged with
the Basic Pay.

 Dearness Allowance (DA) : It is a compensation for erosion in
the purchasing power of wage earner due to price rise. It is granted
by the Government periodically as a percentage of (Basic Pay +
Dearness Pay, if applicable).

 House Rent Allowance (HRA) : It is an amount paid to facilitate
employee in acquiring on lease of residential accommodation.

 Transport Allowance (TRA) : It is an amount to facilitate commuting
to the the place of work, i.e. Delhi, Bhopal, Haridwar, etc.

 Any Other Earning : It may include any other allowance not
included above but declared from time to time, such as Education
Allowance, Medical Allowance, Washing Allowance, etc.

• DEDUCTIONS

 Professional Tax (Applicable in some states) (PT) : It is a
statutory deduction according to the legislature of the State
Government.

 Provident Fund (PF) : It is a statutory deduction, as part of
social security. It is decided by the Government under the
Provident Fund Act and is computed as a percentage of (Basic
Pay + Dearness Pay, if applicable).

 Tax Deduction at Source (TDS) : It is a statutory deduction,
which is deducted monthly towards Income Tax liability of an
employee. It is essentially an apportionment of yearly Income
Tax liability over 12 months.
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 Recovery of Loan Instalment (LOAN) : Any amount signified by
the employee for deduction on account of any loan taken up by
him/her.

 Any Other Deduction : It may include any other deduction not
included above such as Recovery of “Advance against Salary”,
deductions on account of “Food Grain Advance”, “Festival
Advance”, etc.

3.1.2 ELEMENTS USED IN PAYROLL CALCULATION

Basic Pay Earned (BPE) – Basic Pay Earned of an employee is the
Basic Pay calculated with reference to Number of Effective Days present
(NOEDP) during the month.

BPE = BP * NOEDP/NODM

Dearness Allowance (DA) –

DA = BPE *  (Applicable Rate of DA for the Month)

House Rent Allowance (HRA) –

HRA = BPE *  (Applicable Rate of HRA for the Month)

Transport Allowance (TRA) –

TRA = (Fixed Amount) or (On Percentage Basis)

Total Earnings (TE) – It is the aggregate of all the above earning
elements. Thus,

TE = BPE + DA + HRA + TRA

Provident Fund (PF) : This can be calculated as PF = BPE * PF RatePF = BPE * PF RatePF = BPE * PF RatePF = BPE * PF RatePF = BPE * PF Rate

Tax Deduction at Source (TDS) : It is usually a fixed amount deducted
every month on account of TDS. In the last quarter of a year, the
investment details, which are permissible for tax deduction, are
received from employees to compute the quarterly and yearly income
tax liability more accurately.

Recovery of Loan Instalments (LOAN) : It is a fixed amount to be
deducted on account of Loan Installment as part of loan recovery.

Total Deductions (TD) : It is the total of all the above deductions.
Thus,

TD = PF + TDS + LOAN

Number of Effective Days Present (NOEDP)Number of Effective Days Present (NOEDP)Number of Effective Days Present (NOEDP)Number of Effective Days Present (NOEDP)Number of Effective Days Present (NOEDP) – is the Number of Days
in a Month Minus Leave without Pay minus Unauthorised Absence, i.e.

NOEDP = (Number of Days in a Month)NOEDP = (Number of Days in a Month)NOEDP = (Number of Days in a Month)NOEDP = (Number of Days in a Month)NOEDP = (Number of Days in a Month) – (Leave without Pay) –
(Unauthorised Absence) ; where (Number of Days in a Month) may be
denoted by NODM.
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The Net Salary (NS) is the amount payable to an employee. It is obtained
by deducting Total Deductions (TD) from Total Earnings (TE) as given
below :

Net Salary (NS) = Total Earnings (TE) – Total Deductions (TD)Net Salary (NS) = Total Earnings (TE) – Total Deductions (TD)Net Salary (NS) = Total Earnings (TE) – Total Deductions (TD)Net Salary (NS) = Total Earnings (TE) – Total Deductions (TD)Net Salary (NS) = Total Earnings (TE) – Total Deductions (TD)

3.1.2.1 Template Design

Whenever we have to use a spreadsheet for any computations, the first
step is to plan its layout and the template specifying the sequence of
various columns, etc. The template also includes identification of cells,
which will contain formulae. The advantage of preparing the template

is that as a user puts in the values in the spreadsheet, the calculated
results are shown correspondingly. A table giving the contents of various
columns is a helpful tool to represent the template of a spreadsheet.
The following example will explain this process.

ExampleExampleExampleExampleExample

There are 14 employees in M/s XYZ Enterprise. The payroll calculations

of these employees are given in the spreadsheet shown in Figure 3.3 (a)
and Figure 3.3 (b). These figures show the layout of the spreadsheet. In

a column, either a value is entered directly or else it is computed using
a formula. Such data are given in Figure 3.1. The rules for computing

some of the payroll elements used above are given in Figure 3.2.

Different data elements are arranged in the spreadsheet as follows:

• No. of Days in a Month (NODM) is entered in the cell G3

• DA Rate (in %) is entered in the cell G4

• HRA Rates (in %) for Supervisory (Emp Type = “Sup”) and Non-
supervisory (Emp Type = “Nsup”) are entered in the cells G5 and
G6, respectively.

• Transport Allowance for Supervisory (Emp Type = “Sup”) and Non-
supervisory (Emp Type = “Nsup”) are entered in the cells G7 and
G8, respectively.

• PF Rate (in %) is entered in the cell G9.

NotesNotesNotesNotesNotes

• In columns I and J, nested-if function (i.e. an “IF” function within
another “IF” function) has been used. If function has been introduced
in Chapter 2.

• The formulae in column-F and column-G use absolute address ($G$3)
for cell G3 rather than using the relative address (G3). The absolute
address is used for those cells whose reference should not change
while the formula is to be copied into other cells. The concept of
relative and absolute addressing of cells has been explained in
Chapter 2 earlier. Absolute addresses are also used in the formulae
used in columns H, I, and J.
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ColumnColumnColumnColumnColumn Column HeadingColumn HeadingColumn HeadingColumn HeadingColumn Heading Abbrev RefAbbrev RefAbbrev RefAbbrev RefAbbrev Ref First line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows Required Fored Fored Fored Fored Formulamulamulamulamula
Second line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell content

A Employee No Emp No Value entered directly

B Employee Name Emp Name Value entered directly

C Employee Type Emp Type Value entered directly

D Deduction Days Ded Days Value entered directly

E Basic Pay BP Value entered directly

F No. of Effective Days NOEP = NODM – (Ded Days)

Present = $I$3-D12

G Basic Pay Earned BPE = BP * NOEP/NODM = E12*F12/$I$3

H Dearness Allowance DA = BPE * DA Rate (in %) = G12*$I$4

I House Rent Allowance HRA = If (Emp Typ = “Sup” then 40% of BPE
else if  (Emp Typ = “Nsup” then 30% of
BPE else 0))
= IF(C12=”Sup”, G12*$I$5,
IF(C12 =”Nsup”, G12*$I$6,0))

J Transport Allowance TRA = If (Emp Typ = “Sup” then 1000 else if
(Emp Typ = “Nsup” then 500 else 0))
= IF(C12=”Sup”,$I$7,IF(C12
=”Nsup”,$I$8,0))

K Gross Salary TE = BPE  + DA + HRA + TRA
= G12+H12+I12+J12

N Provident Fund PF = BPE * PF Rate (in %)
= G12*$I$9

O Tax Deduction at Source TDS Value entered directly

P Loan Repayment Inst. LOAN Value entered directly

Q Total Deductions TD = PF + TDS + LOAN= N12+O12+P12

R Net Salary NS = TE – TD= K12-Q12

Figure 3.1:  Spreadsheet Columns and the Cells Content in Spreadsheet shown in Figure 3.3 A

VVVVVariable/Tariable/Tariable/Tariable/Tariable/Type of Employeeype of Employeeype of Employeeype of Employeeype of Employee VVVVValue in % or Fix Value in % or Fix Value in % or Fix Value in % or Fix Value in % or Fix Valuealuealuealuealue RemarkRemarkRemarkRemarkRemark

Dearness Allowance (DA) 35% of Basic Pay I4

House Rent Allowance (HRA) –:

Supervisory Employee (Sup) 40% of Basic Pay I5

Non-supervisory Employee (Nsup) 30% of Basic Pay I6

Consultant or Contract Employee Nil

Provident Fund (PF) 12% of BP +DA I9

Figure 3.2: Rules for Computing Some of Payroll Elements
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The following spreadsheet shows columns A to K in Figure 3.3 a; while
columns L to P are shown in Figure 3.3 b. For reference, columns A
and B are repeated in columns L and M in Figure 3.3 b for reference
only.

Figure 3.3 a : Partial Spreadsheet Showing Payroll List upto Gross Salary

Figure  3.3 (b) : Partial Spreadsheet for calculation of Deductions & Net Salary
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3.2 ASSET ACCOUNTING

In this section, we shall be discussing the computation of amount of
depreciation to be charged on assets.

3.2.1 INTRODUCTION

Assets are resources of the organisation, which can be classified into
fixed and current assets. Fixed assets are long-term assets and provide
productive capability to the firm. The examples of fixed assets are
land, building, plant & machinery, etc. It includes both tangible and
intangible assets. Tangible assets are physical in nature, which have
form, shape and size. Intangible assets are resources capable of adding
value but do not have a physical dimension such as patents, copyrights,
trade mark, etc.

The depreciation on fixed assets is provided to recognise the cost of
the asset consumed during an accounting period since the life of such
assets extends beyond single accounting year. Usually, depreciation is
not provided on free hold land.

Total Amount of Depreciation = Acquisition Cost – Salvage Value
(Over Life of the Asset)

Year-to-date depreciation is the accumulated depreciation from the
date to which the asset is put to use till the current accounting year.

Depreciation is calculated according to the policy of the organisation.
There are basically two methods, namely the Straight Line Method
(SLM) and the Written Down Value Method (WDV). We had studied
depreciation in our previous standard (XIth Standard) in Accountancy
Book Part I.

We will recall that asset accounting requires maintenance of asset
register, computation of depreciation and preparation of schedule of
fixed assets for reporting in the balance sheet as part of the annual
accounts. In order to prepare this report the depreciation calculation
sheet is also to be prepared.

3.2.2 COMPUTERISED ASSET ACCOUNTING

Assets are classified into the following categories:

• Goodwill

• Land: Free-hold land and Lease-hold land

• Building: Factory building, Office building, and Residential building

Year-to-date depreciation is the accumulated depreciation from the
date to which the asset is put to use till the current accounting year.
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• Plant and Machinery

• Furniture and Fixtures

• Vehicles

• Capital work in progress

• Others

The Companies Act, 1956 in Schedule-14 lists the rate of depreciation

to be used for different class of assets under Straight Line Method

(SLM) and Written Down Value Method (WDV). The prescribed rates

are different under two methods. For reporting purposes, corporate

enterprises may use either of the method and applicable rates. Let us

now understand the computation of depreciation using the two methods.

3.2.2.1 Straight Line Method (SLM)

The following is the formula for computation of depreciation:

• Acquisition Cost = Purchase Value + Other expenses, such as
Transportation Expenses, Installation Expenses and Pre-operating
Expenses

• Total Depreciable Amount = Acquisition Cost - Salvage Value

•
Total Depreciable Amount

Straight Line Depreciaion  =  
Expected Useful Life

•
Straight Line Depreciation 

Rate of Depreciaion  =  × 100
Total Depreciable Amount

ExampleExampleExampleExampleExample

The depreciation calculation (using SLM) is done using the Excel

spreadsheet, which is shown in Fig. 3.5 a and Fig. 3.5 b in two parts

due to the limitation of the page width. In each of the spreadsheet

column, either a value is entered directly or else it is computed using

a formula. Such data are given in Figure 3.4.

Different data elements are arranged in the spreadsheet as follows:

• Year Beginning Date is entered in cell-C3

• Year End Date is entered in cell-F3

• First-Half Year End Date is entered in cell-E3

The salvage value of an asset is the value, which is realisable at the
end of its useful life.
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Figure 3.5(a) : Partial Spreadsheet Columns for Calculation of Depreiation by SL Method

The depreciation is computed by straightline method using the built-
in spreadsheet function SLN in column-K. The spreadsheets are shown
in Figure 3.5(a) and Figure 3.5(b).

The above-mentioned computations and spreadsheets (shown in two
parts due to the constraint in the page width) give an idea of the
process of depreciation calculation using SLM function. The spreadsheet

Figure 3.4:  Column Items and their contents referred to in the Spreadsheet

ColumnColumnColumnColumnColumn Column HeadingColumn HeadingColumn HeadingColumn HeadingColumn Heading Abbrev RefAbbrev RefAbbrev RefAbbrev RefAbbrev Ref First line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows Required Fored Fored Fored Fored Formulamulamulamulamula
Second line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell content

A Asset Name Asset Name Value entered directly

B Date of Purchase Pur. Date Value entered directly

C Date of Installation Inst. Date Value entered directly

D Cost of Purchase Pur. Cost Value entered directly

E Installation Expenses Inst. Exp. Value entered directly

F Pre-operating Pre-op Exp Value entered directly
Expenses

G Cost to Use Cost to Use = (Cost of Purchase) + (Installation Expenses)
+ (Pre-operating Expenses) = D5+E5+F5

H Salvage Value Salvage Val Value entered directly

I Life of Asset in Years Life in Yrs Value entered directly

K Depreciation Amount Depr. =SLN(G5,H11,I11)

Figure 3.5(b) : Partial Spreadsheet Columns for Calculation of Depreciation by SL Method

H    I J              K
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calculation includes “Salvage Value”, “Life in Years”, “Allowed
Depreciation”, and “Depreciation” Columns with previous spreadsheet
“Asset Name” Column for Reference.

3.2.2.2 Written Down Value (WDV) Method

Written Down Value (WDV) method uses the current book value as the
base for computing the depreciation for the next period. It is also called
Declining Balance (DB) method and uses the Excel function DB to
compute the depreciation. The parameters of the function DB are as
follows (Figure 3.6):

In a column, either a value is entered directly or else it is computed
using a formula. Such data are given in Figure 3.7.

Different data elements are arranged in the spreadsheet as follows:

• Year Beginning Date is entered in cell-C3

• Year End Date is entered in cell-F3

• First-Half Year End Date is entered in cell-I3

ColumnColumnColumnColumnColumn ParameterParameterParameterParameterParameter ExplanationExplanationExplanationExplanationExplanation

G Cost Initial cost of the asset

H Salvage Salvage value

I Life Life (in years) of the asset

J Period Period (in years) for which the depreciation
is calculated

K Month No. of months in the 1st year

Figure 3.6: Column Items and their contents referred in the Spreadsheet

ColumnColumnColumnColumnColumn ColumnColumnColumnColumnColumn Abbre. RefAbbre. RefAbbre. RefAbbre. RefAbbre. Ref First line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows Required Fored Fored Fored Fored Formulamulamulamulamula
HeadingHeadingHeadingHeadingHeading Second line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell content

A Asset Name Asset Name Value entered directly

B Date of Purchase Pur. Date Value entered directly

C Date of Instalation Inst. Date Value entered directly

D Cost of Purchase Pur. Cost Value entered directly

E Instalation Inst. Exp. Value entered directly
Expenses

F Pre-operating Pre-op Exp Value entered directly
Expenses

G Cost to Use Cost to Use =  (Cost of Purchase) + (Instalation
Expenses) + (Pre-operating Expenses)

=  D5+E5+F5

H Salvage Value Salvage Val Value entered directly
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ColumnColumnColumnColumnColumn ColumnColumnColumnColumnColumn Abbre. RefAbbre. RefAbbre. RefAbbre. RefAbbre. Ref First line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows Required Fored Fored Fored Fored Formulamulamulamulamula
HeadingHeadingHeadingHeadingHeading Second line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell content

I Life of Asset in Life in Yrs Value entered directly
Years

J Period (in Years) Period If (Instalation of asset was done after
for which Depr. March) then take (Current Year) – (Year of
is to be computed Instalation) else take one addl. Year.

= IF (MONTH(C5) > 3,(YEAR($F$3)-
YEAR(C5)),(YEAR($F$3)-YEAR(C5))+1)

K Months in 1st Year Months in No. of months between (Yr-End-Dt in 1st Yr)
(i.e. the year of 1st Yr & (Inst.Date)
installation) = ROUND((L5-C5)/30,0)

L Year-end Date in Yr-End-Dt If (Inst. Date) was Between Jan and Mar,
1st Year (Reqd. in 1st Yr Take it as 31st Mar of (Year of Inst. Date)
to compute Else Take it as Next Year.
column-K) = IF(AND(MONTH(C5)>0,MONTH(C5) <4),

DATE(YEAR(C5),3,31),
DATE(YEAR(C5)+1,3,31))

M Depreciation Depr. Parameters of DB function as explained
above
= DB(G5,H5,I5,J5,K5)

Figure 3.7: Column Items and their Contents used in Spreadsheet (in Figure 3.8 a and b)

The spreadsheet is divided in two parts; first part shows columns A to
G in Figure 3.8 a; while second part shows columns H to M are shown
in Figure 3.8 b. The “Asset Name” is repeated in both the figures:

Figure 3.8 b : Partial Spreadsheet Columns for Calculation of Depreciation by WDV Method

Figure 3.8 a : Partial Spreadsheet Columns for Calculation of Depreciation by WDV Method
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The above-mentioned computations and spreadsheets (shown in two
parts due to the constraint in the page width) give an idea of the
process of depreciation calculation using WDV function. The
spreadsheet calculation includes “Salvage Value”, “Life in Years”,
“Allowed Depreciation”, and “Depreciation” Columns with previous
spreadsheet “Asset Name” Column for Reference.

3.2.2.3 Schedule Forming Part of the Balance Sheet

The details of various columns are given in the following table:

The spreadsheet is divided in two parts; first part shows columns A to
E in Figure 3.10 a; while second part shows columns F to K are shown
in Figure 3.10 b. The “Asset Name” is repeated in both the figures:

ColumnColumnColumnColumnColumn ColumnColumnColumnColumnColumn UnderUnderUnderUnderUnder First line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows Required Fored Fored Fored Fored Formulamulamulamulamula
HeadingHeadingHeadingHeadingHeading Second line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell content

A Description Value entered directly

B As at Apr 1, 2008 Gross Block Value entered directly

C Additions/Adjustments Gross Block Value entered directly

D Deductions/Adjustments Gross Block Value entered directly

E As at Mar 31, 2009 Gross Block = Op. Bal + Additions/Adjustments
= B8+C8-D8

F As at Apr 1, 2008 Depreciation Value entered directly

G Additions Depreciation Value Transferred from Depreciation
Computation Spreadsheet

H Deductions Depreciation Value entered directly

I As at Mar 31, 2009 Depreciation = Op. Bal + Additions – Deductions
= F8+G8-H8

J As at Apr 1, 2008 Net Block = Gross Block – Depreciation as on
Apr 1, 2008

= B7–F7

K As at Mar 31, 2009 Net Block = Gross Block – Depreciation as on
Mar 31, 2009

= E7-I7

Figure 3.9: Column Items and their Contents used in Spreadsheet (in Figure 3.10 a and b)

Figure 3.10 a: Spreadsheet Containing Fixed Asset Schedule Showing Gross Block
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Figure 3.10 b: Spreadsheet Containing Fixed Asset Schedule
       Showing Depreciation and Net Block

The above-mentioned computations and spreadsheets (shown in two
parts due to the constraint in the page width) give an idea of the
process of Schedule Forming Part of the balance sheet.

3.3 LOAN REPAYMENT SCHEDULE

3.3.1 LOAN

Loan is a sum of borrowed money (termed as principal amount) for a
specified period at a pre-specified rate of interest. The loan is repaid
through a number of periodic (usually monthly) repayment instalments
over the loan repayment period.

3.3.1.1 Calculating Interest and Repayments of Loan

Computation of repayment installments is an iterative process. The
Excel’s built-in function, PMT can be used to compute monthly
instalments of repayment of loan. The parameters of the function PMT
are as follows:

The layout of the spreadsheet for loan repayment calculation is given
in Figure 3.13. In each column of the spreadsheet, either a value is
entered directly or else it is computed using a formula. Such data are
given in Figure 3.12.

ParameterParameterParameterParameterParameter ExplanationExplanationExplanationExplanationExplanation

Rate Interest rate per period for the loan

Nper Total number of payments for the loan. Its unit (e.g. year)
should match with the unit of the interest rate.

Pv Present value, i.e. the loan amount

Fv Future value, which is taken as 0, is the balance at the
end of the loan period

Type Whether payment is made at the beginning (value=1) or
at the end (value=0) of the period

Figure 3.11 Explanation of Parameters of Excel’s PMT Function
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The following two examples are considered for computation of repayment
schedule in the spreadsheet shown in Figure 3.13.

Example 1Example 1Example 1Example 1Example 1

A bank has given loan of Rs. 1, 00,000 to a customer for the purchase
of a Plasma TV on April 1, 2007 @ 10% interest rate for a period of two
years. The loan is to be repaid in 24 monthly instalments.

Example 2Example 2Example 2Example 2Example 2

Ajay has been sanctioned the bank loan of Rs. 2, 50,000 for the purchase
of a car on May 15, 2008. The loan carries the rate of interest @ 11%
and it is to be repaid in 36 monthly instalments.

Figure 3.12: Column Items and their Contents in Spreadsheet

ColumnColumnColumnColumnColumn Column HeadingColumn HeadingColumn HeadingColumn HeadingColumn Heading First line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows RequirFirst line shows Required Fored Fored Fored Fored Formulamulamulamulamula
Second line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell contentSecond line refers the cell content

A Loan Amt. Value entered directly

B Loan Disbursement Date. Value entered directly

C Period of Loan (in Yrs). Value entered directly

D Rate of Interest. Value entered directly

E Future Value. Value entered directly

F Yearly Installment Amt. = PMT(D6,C6,-A6,0,1)

G Monthly Installment Amt. =F6/12

Figure 3.13: Spreadsheet Containing Loan Repayment Schedule

Why is FV taken as zero (0) in the above calculations?

At the end of the loan period, the (balance) amount payable will be
zero assuming that the repayments are made on regular basis.
Therefore, the future value (FV) is taken as zero.
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SummarySummarySummarySummarySummary

• MS-Excel is an easy and useful tool for various calculations carried out on spreadsheets.
In this chapter, three examples have been taken to illustrate the ease and utility of
spreadsheets. These examples are Payroll Calculation, Fixed Asset Accounting, and Loan
Repayment Schedule.

• The first step in using spreadsheet is to list out the elements of the application. For each
element, it is determined whether a direct value is to be entered or else it is to be computed
using a formula.

• Excel has a rich library of various built-in functions including financial functions, which
can be directly used to carry out various (otherwise complex) calculations. A formula may
use one or more such functions.

• In these applications, some of the formulae use absolute address. The absolute address is
used for those cells whose content should not change while the formula containing such
cells is copied to other cells.

• If-function is also used in these applications. If-function is used to implement different
action corresponding to different conditions.

• The Excel functions SLN and DB are used for computation of depreciation using Straight
Line Method (SLM) and Written Down Value Method (WDVM), respectively. WDV Method is
also termed as declining balance (DB) method.

• The function PMT is used to compute the loan repayment schedule.

EXERCISE

Q1. MULTIPLE CHOICE QUESTIONS

1. Which of the following options in a financial function indicates the interest for
a period?

a. FV.

b. PV.

c. Nper.

d. Rate.

2. Which of the following arguments in a financial function represents the total
number of payments?

a. FV.

b. PV.

c. Nper.

d. Rate.
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3. What category of functions is used in this formula:
=PMT(C10/12,C8,C9,1)

a. Logical.

b. Financial.

c. Payment.

d. Statistical.

4. When Extend Selection is active, what is the keyboard shortcut for selecting
all data up to and including the last row?

a. [Ctrl]+[Down Arrow].

b. [Ctrl]+[Home].

c. [Ctrl]+[Shift].

d. [Ctrl]+[Up Arrow].

5. Which formula would result in TRUE if C4 is less than 10 and D4 is less than
100?

a. =AND(C4>10, D4>10).

b. =AND(C4>10, C4<100).

c. =AND(C4>10, D4<10).

d. =AND(C4<10, D4<100).

6. Which of these is not an argument of the IF function?

a. Logical_test.

b. Value_if_false.

c. Value_when_false.

d. Value_if_true.

7. In what cell is the Rate for PMT function where = PMT (C8, C9, C10, C11,
C12)?

a. C8.

b. C9.

c. C10.

d. C12.

Q2. ANSWER THE FOLLOWING QUESTIONS

1. What is the meaning of PV?

2. State the usage of FV?

3. What is the purpose of DB function?
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4. If an investment of Rs. 1,000 is made today, ascertain its Future Value (FV)
after 2 years if the rate of interest is taken as 10%?

5. If a sum of Rs. 1000 is likely to be earned after 3 years, calculate its present
value (PV).

6. What is the difference between WDV method and SLM method of depreciation?

7. Describe the two basic methods of depreciation. What functions of Excel are
used for computation of depreciation?

8. Explain the importance of absolute and relative addresses. What is the basis
of using relative address and absolute address?

SKILL REVIEW
1. In columns F, G, H, I, J, and N of the Payroll spreadsheet shown in Figure

3.3 (a) and Figure 3.3 (b) the absolute addresses are used. What will happen
if relative addresses are used instead of absolute addresses?

2. In columns g of the spreadsheet shown in Figure 3.8 b for the depreciation
calculation using WDV method (i.e. using DB function), the absolute addresses
of cell F3  is used. Taking relative address of F3 instead of its absolute address
will lead to wrong result when the formula is copied. Explain the reason and
write down the values copied along with the correct values, which should
have been copied.

3. Prepare attendance record in a spreadsheet for a class of 25 student’s month
wise for 10 months. Calculate the percentage of presence for each student
every month. Prepare a month wise summary of every student and calculate
the overall percentage of presence.

4. Use spreadsheet to prepare class timetable. It should compute and check the
total number of lectures, tutorials and lab practical sessions allocated for
each subject. It should also compute and check the total number of hours of
engagement for each teacher.

5. Prepare the worksheets yourself for examples used in sections 3.1, 3.2, 3.3
and 3.4 respectively. Add two new more records in each worksheet (with your
own assumed values) and verify whether the computations are correct.

6. Create a worksheet to keep a record of employees of M/s Opportunities
Company. Employee details should include Name of Employee, Designation
and Basic Salary. Enter 50 records. Calculate Dearness Allowance (DA) as
37.5% of Basic Salary, House Rent Allowance (HRA) 22.5% of Basic Salary,
Provident Fund (PF) as 12% of Basic Salary, Gross Salary as Basic Salary +
DA+HRA. The Income Tax (IT) as 20% of Gross Salary and Net Salary is Gross
Salary – (PF+IT) for each employee. Calculate also Total Salary, Average Salary,
Maximum Salary and Minimum Salary paid by the company.

7. In Section-3.3, the loan instalment is computed for a given amount of loan
repayable over a specified period at a specified rate of interest. Modify this
exercise by fixing the loan instalment amount and compute the loan period
using the PMT function.
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   ANSWERS

1. b 2. c 3. b 4. c 5. d 6. c 7. a
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GRAPHS AND CHARTS

FOR BUSINESS DATA

Introduction

4

 

In the previous chapter, you were introduced to

the basic features of spreadsheet and use of

spreadsheet in accounting.  Quite often, we have

to present the data for communication of the

accounting information. If mass of data is presented

in the raw form, it may not be easily

understandable. It is rightly said, “A picture is

worth more than thousand words”. This chapter

seeks to explain the method of preparing graphs,

charts and diagrams showing the data through

the use of Excel as a tool.

4.1 GRAPHS AND CHARTS

A graph is a pictorial representation of data, which

has at least 2 dimensional relationship. Therefore,

a graph has at least two axes, X and Y. X-axis is

usually horizontal while Y-axis is vertical. A graph

may either be a singleline graph or a multiple-

line graph. For ease and enhancing of clarity,

different types of lines and different shades of

Colours can be used for preparing a multiple-line

graph.

A pie chart represents multiple sub-groups of

single variable. A bar diagram depicts two or more

variables.

After studying this chapter, you will be

able to:

• represent data in graphical form

in charts & diagrams through

Excel.

• use accounting data for graphical

representation.
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Figure 4.1 shows different types of graphs and charts which can be

prepared with the help of the commands or standard tools given in

toolbar.

Figure 4.1:  Various types of graph and charts

Using the MS Excel 2007 we can create a basic chart by clicking
the chart type that we want on the Microsoft Office Fluent user interface
Ribbon, as shown in Figure 4.2. Remember these following steps which
are already explained in previous chapter.

Figure 4.2: Tools for various types of graphs
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1. On the screen of the computer mouse

click on  Start Icon

2. On clicking of Start symbol we will get
Programs option; which will provide us
access to a list of programs installed on
the computer.

3. On selecting MS Excel 2007 program it
will provide a blank workbook with a
Ribbon displayed at the top as shown in Figure 4.2.

4. Click on Insert tab to get tools for chart as shown in Figure 4.3.

We will learn how to draw graphs, charts and diagrams for the
following worksheet data see Figure 4.4.

Using the following two steps we can create any type of chart /
graph that displays the details that we want.

4.2 BASICS STEPS FOR
GRAPHS/CHARTS/
DIAGRAMS USING
EXCEL

Step - 1

To create a chart in Excel; we will enter
sales related data for each quarter
sales (namely QTR1 to QTR4) of the
year 2007-08 for six different products
manufactured by ABC Manufacturing
Company Ltd. (as given in Figure 4.4)
The row totals (row number 11) gives the quarter wise total sales of
products and the column totals (column number G) gives product wise
total sales. The cell G11 gives over all total sales of the
products for the year are entered in a worksheet.

Step - 2a

In this step we will select to plot the data Product wise
Total sales (see in Figure 4.4 and independently shown
as Step 2a) into a chart by selecting the chart type that
we want to use from the Ribbon. The steps are also
described earlier in section 4.1 (use Insert tab and
click on Charts group). Let us draw the Bar Chart for
the data of step - 2a.

Step - 2b

To draw a chart/graph for the given data by Excel
the above steps are essential and important. From the
tab on the ribbon we can see that Excel supports many

Figure 4.3  Tools for various types of graphs

Figure 4.4  Quarterly Sales of Product

1

No caption ???
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types of charts to display data in
meaningful ways.

Let us prepare a new chart from the
same worksheet to display total sales for
each quarter. The data in the worksheet is
to be reorganised for the purpose of chart
preparation and as mentioned above,
graph/chart will be prepared in similar two
steps as described above (Figure 4.5).

Period Total Sales

 Qtr1 25844

 Qtr2 11295

 Qtr3 14744

 Qtr4 21886

 Total 73769

To create a chart
or to change an
existing chart, we
select variety of
chart types (such as

a column chart or pie chart) and their sub-types (such as a stacked
column chart or a pie in 3-D chart) from the ribbon. We can also create
a combination of chart by using more than one chart type in any chart.
This could be possible once we understand the elements of the chart
and the formatting of the chart.

4.2.1 ELEMENTS OF A CHART/GRAPH

Figure 4.5

A chart/graph are a pictorial
presentation of data. To understand
and explain the chart/graph we will
learn all basic  elements of the
chart. These chart/graph elements
are given in Figures 4.6 and 4.7.

1. The chart area: The entire chart
including all elements.

2. The plot area: In a 2-D chart,
the area is bounded by the X and Y
axes. In a 3-D chart, the area is
bounded by the three (X, Y and Z)
axes.

Figure 4.6
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3. The data points: Individual values plotted in a chart and represented
by bars, columns, lines, pie or various other shapes are called data
markers. Data markers of the same colour constitute a data series.
The data series are related data points that are plotted in the chart/
graph. Each data series in a chart is shown in a unique colour or
pattern or both. Its identification is given by the legend.  There may be
more than one data series in a chart/graph.

4. The horizontal (category) and vertical (value) axis: The x-axis is
usually the horizontal line which contains categories (independent
values or categories) and y-axis is usually the verticals which contains
data (dependent values).

5. The legend: It is an identifier of a piece of information shown in the
chart/graph. The legends are assigned to the data series or different
categories in a chart (Figure 4.7).

6. A chart and axes titles: Descriptive text for chart title (6-A) and
axis title (6-B) as shown in Figure 4.6.

7. A data label: This provides additional information about a data
marker to identify the details of data point in a data series.

Some of the elements are displayed by default when we prepare the
chart/graph; others can be added as needed. It is also possible to
change the format or display of the chart/graph as desired.

Figure 4.7

4.2.2 FORMATTING OF CHART

4.2.2.1 Formatting the Chart (using design option)

As referred in earlier section 4.2.1 above; in this section we will learn
how the elements of a chart such as plot area, X-axis, Y-axis, data,
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titles, labels, legends and gridline as shown in Figure 4.7 can be
formatted and edited as per the requirement. Click anywhere in the
chart. This will display the Chart Tools, adding the Design, Layout,
and Format tabs (Figure 4.8a).

Using Design option we can change the look of a chart. In the
Design dialog box, we can click to change chart type, chart layouts
and chart styles. One of the options provide for 2-d chart to swap the
column data to row data and row data to column data. The steps are
as follows:

In a chart (Figure 4.7) click the chart element to change, or do the
following to select the chart element from a list of chart elements:

Figure 4.8 (a)

1. Click anywhere in the chart
(Figure 4.7).  This will display
the Chart Tools, adding the
Design, Layout, and Format
tabs.

2. On the Design tab, in the
Data group, click the arrow
at the Switch Row/Column
box.

3. This will swap the chart/
graph from X-axis (Product)
to X-axis (Quarterly)(Figure
4.8(b).

4.2.2.2 Changing the format of a selected chart element

In the same chart, click the chart element to change, or do the following
to select the chart element from a list of chart elements:

Figure 4.8 (b)

Figure 4.8 (c)

1. Click anywhere in the chart.  This will display the Chart Tools,
adding the Design, Layout, and Format tabs (Figure 4.8(c).
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2. On the Format tab, in the Current Selection group,
click the arrow next to the Chart Elements box, and
then select the chart element which requires to
format.

3. On the Format tab, in the Current Selection group,
click the Format Selection (Figure 4.8(d)).

4. In the Format <Chart Element> dialog box, click a
category, and then select the formatting options.

Changing the shape styleChanging the shape styleChanging the shape styleChanging the shape styleChanging the shape style

1. On the Format tab, in the Shape Styles group, do one of the
following:

• To see all available shape styles,
click the More button.

• To apply a pre- defined shape
style, in the shape style box, click
the style that we want.

• To apply a different shape fill, click Shape Fill, and then do one
of the following: (Figure 4.8(e))

 To use a different fill Colour, under Theme Colours or Standard
Colours, left click the select Colour.

 To remove the Colour from the selected chart element, click
No Fill.

 To use a fill Colour that is not available under Theme Colours
or Standard Colours click More Fill Colours. In the Colours
dialog box, specify the Colour that we want to use on the
Standard or Custom tab, and then click OK.  Custom fill
Colours are added under Recent Colours can also be used.

 To fill the shape with a picture, click Picture. In the Insert
Picture dialog box, click the picture to use, and then click
Insert.

 To use a gradient effect for the selected fill Colour, click
Gradient, and then under Variations, click the gradient style
to be used. For additional gradient styles, click More
Gradients, and then in the Fill category, click the gradient
options that to use.

 To use a texture fill, click Texture, and then click the texture
to use.

Changing the Shape OutlineChanging the Shape OutlineChanging the Shape OutlineChanging the Shape OutlineChanging the Shape Outline

• To apply a different shape outline, click Shape Outline, and then
do one of the following:

 To use a different outline Colour, under Theme Colours or
Standard Colours, click the Colour to use.

Figure 4.8 (d)

Figure 4.8 (e)
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 To remove the outline Colour from the selected chart element,
click No Outline. If the selected element is a line, the line will no
longer be visible on the chart.

 To use an outline Colour that is not available under Theme
Colours or Standard Colours click More Outline Colours. In
the Colours dialog box, specify the Colour that to use on the
Standard or Custom tab, and then click OK. Custom outline
Colours are added under Recent Colours can be used again.

 To change the weight (thickness) of a line or border, click Weight
option, and then select the line that we wish to use. For additional
line style or border style options, click on More Lines, and then
click the line style or border style options.

 To use broken line (dash–dash) or border, click Dashes, and
then click the dash type to use. For additional dash-type options,
click on More Lines, and then click the selected dash.

 To add arrows to lines, click Arrows, and then click the arrow
style for borders cannot be used. For additional arrow style or
border style options, click More Arrows, and then click the arrow
setting.

To apply a different shape effect, click Shape Effects, click an
chosen effect, and then select the type of effect.

The shape effects depend on the chart element that we select such
as Pre-set, reflection, and bevel. The shape effects are not available
for all chart elements.

Changing the text forChanging the text forChanging the text forChanging the text forChanging the text formatmatmatmatmat

To format the text in chart elements, we can use regular text formatting
options, or we can apply a WordArt format.

1. Click the chart element that contains the text to format.

2. Right-click the text or select the text to format, and then do one of
the following:

 Click the formatting options that we want on the Mini toolbar.

 On the Home tab, in the Font group, click the formatting buttons
that we want to use.

To use WordArt styles to format text use chart elements in the
following steps: (Figure 4.8(f)

1. In a chart, click the chart element that
contains the text to be changed, or do the
following to select the chart element from a
list of chart elements:

2. Click anywhere in the chart.

3. This displays the Chart Tools, adding the
Design, Layout, and Format tabs.

Figure 4.8 (f)
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4. On the Format tab, in the Current Selection group, click the arrow
next to the Chart Elements box, and then select the chart element
that to format.

5. On the Format tab, in the WordArt Styles group, do
one of the following: (Figure 4.8(g))

• To see all available WordArt styles, click the More
button.

We get options for Text related formatting

 Text Fill

 Text Outline

 Shadow

 3-D Format

 3-D Rotation

 Text Box

4.2.2.3 Changing the layout of the chart element

In the same chart, click the chart element to change, or do the following
to select the chart element from a list of chart elements:

1. On the Layout tab, we can insert different Clip Arts, Picture, data
labels, grids etc.

2. In the Format <Chart Element> dialog box, click a category, and
then select the formatting options.

4.2.3  CHANGE THE CHART TYPE

A chart can be changed to another type of
chart to get different look and purpose. For
example, the chart shown in Figure 4.5 can
be changed to Pie a chart (Figure 4.9) by
using the chart tool as given on the Ribbon
interface and in Figure 4.2. The every Pie of
the chart represents the size of total sales in
each quarter proportionately and whole Pie
chart displays sum of all the Pies equals to
100%.

This is the easiest method to change from
column chart or bar chart to Pie chart because

Figure 4.8 (h)

Figure 4.9

Figure 4.8 (g)
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• Only one data series is
used to plot.

• The plotted data values
are positive.

• The data values are not
equal to zero also.

Note that in Excel software Pie chart cannot plot
more than seven catgories. The categories represent
the parts of whole Pie.

Steps for creating a Pie ChartSteps for creating a Pie ChartSteps for creating a Pie ChartSteps for creating a Pie ChartSteps for creating a Pie Chart

1. Enter the data in a worksheet.

2. Select the data from two (consecutive) columns
only.

3. Select the chart type Pie from the ribbon.

4. Under Pie types select 3-D Pie option

5. Click the plot are of Pie chart this displays the
Chart Tools, adding the Design, Layout, and
Format tabs.

6. On the Design tab, in the Chart Layouts group,
select the layout to use.

7. On the Design tab, in the Chart Styles group,
click the chart style.

8. On the Format tab, in the Shape Styles group,
click Shape Effects, and then click Bevel.

9. Click 3-D Options, and then under Bevel, click
the Top and Bottom bevel options.

10.In the Width and Height boxes for Top and
Bottom bevel options, type the point size.

11.Under Surface, click Material, and then click
the material option.

12.Click Close.

13.On the Format tab, in the Shape Styles group,
click Shape Effects, and then click Shadow.

14.Under Outer, Inner, or Perspective, click the
shadow option.

15.To rotate the chart for a better perspective, select
the plot area, and then on the Format tab in the
Current Selection group, click Format
Selection.

Figure 4.9 (a)

Figure 4.9 (b)

Figure 4.9 (c)

Figure 4.9 (d)

Figure 4.9 (e)

Figure 4.9 (f)

Figure 4.9 (g)
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16.Under Angle of first slice, drag the slider to the degree of rotation
that you want, or type a value between 0 (zero) and 360 to specify
the angle of the first slice to appear, and then click Close.

17.Click the chart area of the chart.

18.On the Format tab, in the Shape Styles group, click Shape Effects,
and then click Bevel.

19.Under Bevel, select the bevel option.

20.To use theme colors that are different from the default theme that
is applied the workbook, do the following:

a. On the Page Layout tab, in the Themes group, click Themes.

b. Under Built-in, click the theme to use.

4.2.4  RESIZING OF CHART/GRAPH

Resizing of the chart means changing size of the chart as desired. This
option can be used independently for the fonts, title, legends easily.
The first step is to select the chart by clicking the left button of the
mouse.  Move the cursor on the corners or middle of the borders of the
chart/graph which will provide the figure (the cursor will take the
shape of a two headed arrow). By pressing the left button and drag/
pull as desired to resize the chart as shown by the red circle in the
Figure 4.9a.

4.2.5  2D - 3D CHARTS/GRAPHS

To create graphs we use data which are plotted in two
dimensional (2D) format ( X- axis and Y-axis) as shown
in the Figure 4.7. Where as

• Horizontal dimension is X-axis(contains categories)

• Vertical dimension is Y-axis(contains data)

When we plot the data on 2-D type of graph; the
known value goes on the X-axis (independent) and
derived (dependent variable) value on Y-axis. For
example monthly demand of products (in Rs.); then on
X-axis we will put Month and on Y-axis we will put the
data values for demand.

In the graph sometimes we have to present negative
values also, which can be put on the opposite side of the
axes from origin (Figure 4.10). The intersection of both
the axes (X-axis and Y-axis) is called the origin (O) of the
graph. We can put on the right side of the origin positive
values and on left side of the origin negative values of
data on X-axis. Similarly upper ward side of origin shows
positive values and down ward side of the origin shows
negative values of data Y-axis. For example, if we have
data about monthly profit and loss to be plotted on graph;

Figure 4.10

Figure 4.11(a)
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here profit will be positive data
values and loss will have negative
data values.

2-D types of graphs/charts are
line graphs, bar, area, surface
column (horizontal or vertical),
multiple line charts, radar chart,
XY (scatter) or bubble chart.

The 2-D Charts typically have
two axes (axis: A line bordering the
chart plot area used as a frame of
reference for measurement. The Y
axis is usually the vertical axis and
contains data. The X-axis is usually
the horizontal axis and contains

categories.) that are used to measure and categorise data: a vertical
axis (also known as derived value axis or Y axis), and a horizontal axis
(also known as category axis or X axis).

Sometimes graphs/charts can be prepared with three dimensional
(3-D) effects. 3-D charts have a third axis, the depth axis (also known
as series axis or Z axis), so that data can be plotted along the depth of
a chart. In this type the third dimension is represented by Z-axis (Figure
4.11(a) & (b)).

For example to represent the volume we require three parameters
height (Y-axis), length (X-axis) and breadth (Z-axis).

Figure 4.11(b)

Product  Lowest  Highest

Toothpaste 2345 12344

Toothbrush 500 5415

Hair Oil 988 3678

Shampoo 2900 3770

Toilet Soap 1122 3861

Bath Soap 952 2344

Total 8807 31412

1. Vertical (derived value) axis –
(Y-axis).

2. Horizontal (category) axis –
(X-axis).

3. Depth (series) axis – (Z-axis).

Sometime we would like to draw
the charts for comparison of
values. Data that is arranged in
columns or rows on a worksheet
can be plotted in a radar chart.
Radar charts do not have

horizontal (category) axes, and similarly pie and doughnut charts do
not have any axes. In Figure 4.12 radar chart is drawn for the
comparison of highest and lowest values of sales of different products.
Radar charts compare the aggregate values of a number of data
series (data series: Related data points that are plotted in a chart.
Each data series in a chart has a unique color or pattern and is
represented in the chart legend. You can plot one or more data series
in a chart. Pie charts have only one data series.).
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Similarly data can be arranged in columns
or rows only on a worksheet and can be plotted
in a doughnut chart. Like a pie chart, a doughnut
chart shows the relationship of parts to a whole,
but it can contain more than one.

Doughnut charts (Figure 4.13) are not easy
to read. We may use a stacked column or stacked
bar chart instead.

Doughnut charts have the following chartDoughnut charts have the following chartDoughnut charts have the following chartDoughnut charts have the following chartDoughnut charts have the following chart

subtypessubtypessubtypessubtypessubtypes

Doughnut   Doughnut charts display data in
rings, where each ring represents a data series.
For example, in the previous chart, the inner
ring represents gas tax revenues, and the outer
ring represents property tax revenues.

Doughnut ChartDoughnut ChartDoughnut ChartDoughnut ChartDoughnut Chart

Exploded Doughnut Much like exploded pie
charts, exploded doughnut charts display the
contribution of each value to a total while
emphasising individual values, but they can
contain more than one data series.

4.3  ADVANTAGES IN USING
GRAPH/CHART

Help to Explore:  Many times we would like to see if there is a
relationship between variables. Suppose, that we wanted to determine
if there is a relationship between: a country’s GNP and the infant
mortality rate, between age and between genders.  It may be quicker
and easier to create a chart immediately to see the possible relationship
of variables to one another, rather than paging through raw data.

Help to Present:  We want to provide information in as little time
as possible. Graphing plays a key role.  It seems that there is no longer
any time to sit and read a newspaper in order to find out what is going
on.  However, newspapers, such as The Economics Times and India
Today magazines (which were early users of charting techniques), seem
to understand this phenomena and provide graphs to convey and sum
up ideas that they are making in their articles.

Help to Convince:  The same way that a graph can be used to
present and explore different characteristics of data, it can also be
used to convince.  Graphs have the ability to take large amounts of
information and make them into exhibitions that are easily used to
persuade.

Figure 4.13

Figure 4.12
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SummarySummarySummarySummarySummary

• A graph is a pictorial representation of data. Graphs are usually
2-dimensional. Sometimes 3-dimensional graphs are also used.

• A graph may be either a singleline graph or a multi-line graph. Multi-line
in a graph are distinguished either by using different shapes of line or
different shapes and colors.

• Other popular pictorial representations include Pie Chart and Bar Chart.
Pie charts depict relative share of different elements. Bar charts are used
to depict the comparison of absolute values of data (e.g. sales, production,
etc.) at discrete points (e.g. time intervals, products, etc.).

• MS-Excel 2007 (or simply Excel) provides a convenient facility to draw graphs
and charts. The nomenclature used in Excel for charts (charts include
graphs) is as follows:

a. The Chart Area,

b. The Plot Area covering the plot of values in the selected type of chart,

c. The Data Points,

d. The Horizontal (Base Values, e.g. category) and Vertical (Derived Values)
Axes,

e. The Legend to specify distinguishing criteria in case of multiple lines,
pies, bars, etc.

f. Chart and Axes Titles

g. Data Labels

• Every elements of a chart – such as plot area, X-axis, Y-axis, data, titles,
labels, legends, and gridlines – can be formatted using the Design, Layout
and Format dialog box in Excel.

• Chart’s size can also be changed as per requirements.

• For multiple visualisations of the same data through different typs of charts,
we can change the chart type (say, from line graph to barchart, or bar
chart to pie chart, etc) wherever required for better presentation as per the
nature of data.

• Graphs and charts help in easy visualisation of any trends present in data.
In highly random data such as stock prices, textual description may not be
easily possible to explain the price or other fluctuations, but graphs and
charts overcome this constraint as they can be comprehended more easily
by human beings.
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Following are the steps prepare a chart :

Step – 1: Enter data in a worksheet with proper column and row titles.

Step – 2: Create a basic chart using the pattern from the panel available on
top of worksheet in Chart groups’ option.

Step – 3: Change the layout or style of chart.

Apply a predefined chart layout.

Apply a predefined chart style.

Change the layout of chart elements.

Change the format of chart elements.

Step – 4: Add or remove titles or data labels.

Add (Remove) a chart title.

Add (Remove) axis titles.

Link a title to a worksheet cell.

Add (Remove) data labels.

Step – 5: Show or hide a legend.

Step – 6: Display or hide chart axes or gridlines.

Display (hide) primary axes

Display (hide) secondary axes

Display (hide) gridlines

Step – 7: Move (resize) a chart

Step – 8: Save a chart
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EXERCISE

Q1. MULTIPLE CHOICE QUESTIONS

1. To change the location of a chart, right-click the chart and select:

a. Chart Type.

b. Source Data.

c. Chart Options.

d. Move here.

2. The Ribbon allows us to:

a. Create either an embedded chart or a chart sheet chart:

b. Create only an embedded chart.

c. Create only a chart sheet chart.

d. Change the data values used to create the chart.

3. Once we have created a chart we may change _____:

a. the formatting for text like titles and data labels.

b. only by going back through the ribbon.

c. everything about the chart.

d. the data series patterns only.

4. In Excel the chart tools provides three different options ______, ________ and
_______ for formatting:

a. Layout, Format, Data Marker.

b. Design, Layout, Format.

c. Chart Layouts, Chart Style, Label.

d. Format, Layout, Label.

5. Pie chart don’t have more than ________ categories:

a. Ten.

b. Twenty Five.

c. Seven.

d. Three.

6. Column charts are useful for ____________________:

a. Showing data changes over a period of time.

b. Illustrating comparisons among items.

c. Both a and b.

d. None of the above.
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7. Doughnut charts:

a. Contains more than one data series.

b. Comparable with Pie chart.

c. Both a and b.

d. None of the above.

8. The 2D graph using _______ , _________ axes and in 3D graph ______ axis is

also used.

a. Category, value, vertical.

b. Horizontal, vertical, depth.

c. Category, value, series.

d. b and c both.

9. Excel automatically redraws the chart ___________:

a. If any change is made in data.

b. If any change is made in the range data.

c. a and b both.

d. None of the above.

10. Legend can be repositioned on the chart:

a. anywhere.

b. on right side only.

c. on the bottom of X-axis.

d. on the corner only.

11. Which chart element details the data values and categories below the chart?

a. Data point.

b. Data labels.

c. Data marker.

d. Data table.

12. From what command tab is the font size for an axis in a chart changed?

a. Home.

b. Insert.

c. Format.

d. Design.
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13. Which of these purposes does not pertain to charts?

a. Identifying trends.

b. Selecting values.

c. Recognising patterns.

d. Making comparisons.

14. What do you see if you move over the mouse over a chart object?

a. KeyTip.

b. ScreenTip.

c. ChartTip.

d. ChartKey.

15. Which group on the Chart Tools Format tab shows the name of the selected

element?

a. Arrange Objects.

b. Chart Objects.

c. Choose Selection.

d. Current Selection.

Q2. ANSWER THE FOLLOWING QUESTIONS

1. Define charts, graphs and how they are useful in business decisions?

2. Write down the usage and purpose of column chart, pie chart and line chart.

3. Describe about data series, legend, and data labels??

4. Describe use of Excel for preparation of chart.

5. Differentiate between pie charts, line charts and column charts respectively?

6. Described the steps to move, resizing and reposition a chart.

7. What does percentage in chart represent and how it being calculated by the

software?

8. What are the differences between

a. Area, XY chart and doughnut

b. 2-D Charts  and 3-D Charts

9. What is pie chart and what are percentage values means in pie chart?

10. Different types of charts which can be prepared using Excel?
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Q3. SKILL REVIEW

A. Create a trend chart after filling data in to the worksheet.

(Population of India/State in Millions to be enter)

Year Male(1) Female (2) Total(3)

Literate Illiterate Literate  Illiterate  Literate   Illiterate

2001

2002

2003

2004

2005

2006

2007

2008

Note: Total Literate  = Values of Male Literate  + Values of Female Literate

Total Illiterate = Values of Male Illiterate + Values of Female Illiterate

B. Create a Pie chart to compare data from above table for Total (column number
3).

C. Draw a Trend charts for each male, female and totals separately.

D. Draw a Column Chart for the above data for each (male, female and total)
separately for Literate and Illiterate.

E. Prepare a Pie chart and Column chart for the 10 different plots areas 5, 7, 8, 9,
8, 10, 4, 6, 7 and 3 hectares respectively.

F. Draw a Pie chart for the following data on vehicles registered in the RTO
department during 2007-08 in your city.

Vehicle Bus Trucks Auto Rixa Cars Two    Heavy
Type Wheelers Vehicles

Number of 575 5889 12345 9765 23456 65
Vehicles

G. Draw a Column chart for the following data.

Marks 0-20 21-40 41-60 61-80 81-100 Total

Number
of 113 180 350 232 125 1000

Students
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   ANSWERS

1. d 2. d 3. a 4. b 5. c 6. c

7. c 8. c 9. c 10. a 11. b 12. a

13. b 14. c 15. d
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ACCOUNTING

SOFTWARE PACKAGE :

TALLY

Introduction

5

 
After studying this chapter you will be

able to use Tally Accounting Software

for:

• Creating Book of Accounts.

• Print Profit and Loss Account

• Print Balance Sheet as on date

• Prepare Bank Reconcilation

statement as on date

• Print  MIS Reports on Accounting

We have discussed various aspects of
computerisation of Accounting in earlier previous
chapters. Here, we will discuss one of the general
two accounting software packages, which are often
used in the business applications. They are Tally
9.0 by Tally Solution Pvt. Ltd. and EX Next
Generation by Tata Consultancy Services. The aim
of this chapter is not to teach an accounting
package, but to focus on how the features of
accounting software are implemented in each of
these packages.

The Tally Accounting package has different
modules related to Accounting Systems in the
package. It also describe as to how various phases
of accounting cycle can be incorporated in the flow.
It also co-relates the manual phases of accounting
cycle with each of these modules and describes
how different reports can be generated at the end
of each of these modules.

Features of accounting software

Tally is an accounts and inventory management
software which has many other features too. With
the latest version of this software Tally 9 you can-

1. do all basic accounting functions,

2. manage your stores,

3. do the job costing,

4. manage payroll,
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5. get many MIS (Management information reports which are useful
for day-today functions,

6. file your tax returns like prepare balance sheet, profit and loss
statement, VAT forms, TDS returns, Service tax returns, e-TDS filing,
Excise forms, FBT reports and forms,

7. maintain budgets, scenarios,

8. calculate interest on pending amount,

9. manage data over different locations and synchronize it and many
more other features.

5.1 STEPS IN INSTALLATION OF C.A.S

For installation of computerised accounting system the following steps
are required:

1. Insert CD in the system ;

2. After inserting CD select the option in following steps ;

a. Select any (C: or E: or D: ) from My Computer icon on the desktop.
Double click on install.exe

OR

b. Select start > run > type the file name E:\install.exe

3. After the above process the default directories of application , data
and Configuration opens in a window. In case, the user wants to
change the default directories then it can be changed by providing
the desired drive and file name/directory name for example :
D:\software name, instead of  C :\accounting software (default name)

4. Click on install and installation process begins, accounting software
displays the Message of successful installation, then this CD can
be removed.

5.2 USE OF ACCOUNTING SOFTWARE

Tally is a widely used accounting software which can be used for book
keeping purposes by any size of organisation. In the accounting software
Tally user can create any independent set of accounts to be maintained

Figure 5.1 : Tally Software
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by a company, partnership firm, individual or even a Branch account.
To work with Tally first you will start with Gateway of Tally as it  is the
control centre of the software. Here under, now we explain various
components of Gateway of Tally.

5.2.1 GATEWAY OF TALLY

Gateway of Tally is the control centre of Tally. Following are the
components of gateway (Figure 5.2).

• Product Info: Software name & version (eg: Tally 9.0)

• Horizontal Button Bar: It contain two sets of Button with hot key.

 Report management: Print, e-mail etc.

 Language: To set up language for display.

• Current status: It means current date, current period, selected
company etc.

• Tally Menu: At right part of the Gateway screen of Tally menu
shows the list of options. We can select an item to initiate a task.

• Vertical Button Bar: The button bar shows several buttons with
function key/hot key to provide quick and direct access to various
options and tasks.

Figure 5.2 : Gateway of Tally
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• Tally Calculator/Command Line: While working with Tally, if we
press Ctrl+N Calculator is activated to make arithmetical
calculations. The same can also be pasted in any numerical field.

• Current Screen Bar: At the bottom, you get the Current Screen bar
showing the following details about the current screen being display.

Starting date
of the period

Ending date
of the period

Current date

Figure 5.3:  Periods and date Entries

• Current Period: In the current period user enters the starting date
of the financial year and closing date of the financial year. The
Figure 5.3 shows how user enters starting opening and closing
date of accounting period.

• Current Date: Current date is date of your last working. It is also
known as voucher date. In the Figure 5.3, on the left side of Gateway
you can get the following information about Current Period, Date,
Active Company and Selected Company (Figure 5.4).

• Active Company: When you have selected multiple companies, the
last selected company becomes the active company.

• Selected Companies: In selected companies Tally displays the list
of all selected companies along with the date of last voucher entered.

Figure 5.4 : Active and Selected Companies
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5.2.2 COMPANY CREATION

In order to create a Company by using Gateway of Tally, initiate the
following steps:

• Click on the <Select Cmp>

• You get Company info and click on <Select company>

• If you click on <Shut Cmp> option, then you click on <Create
Company>

To create a Company profile in Tally, click Create Company at
Company info menu (Figure 5.5) to get Company Creation screen
(Figure 5.6).

In the Company Creation screen (Figure 5.6) the user should fill
the necessary information:

• COMPANY NAME: Enter the Name of the Company at Name field.
This name is displayed at all company selection lists and internal
documents.

• COMPANY MAILING ADDRESS: Enter the Name of the Company
at Name field (same as Company Name) which is printed in all
External documents.

Figure 5.5: Company Creation
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• COMPANY ADDRESS: Enter the Complete mailing address line by
line which is mentioned in internal and external document of the
company.

• I.T. NUMBER: Enter the Income Tax number allotted by Income Tax
Department.

• ACCOUNTING MODULE: To maintain Financial Accounts only, at
Maintain field, Select Accounts Only.

• FINANCIAL YEAR: At the Financial year field; entered the Beginning
and closing date of the financial year.

• SAVING THE COMPANY PROFILE: Finally, Tally ask for your
confirmation to save the Company Profile. Tally Save the Company
Profile in data bank.

SELECTION OF ACTIVE COMPANY AND START
FROM GATEWAY OF TALLY

The last selected company (Figure 5.2) becomes the Active Company
and such company is shown in the bold letter of Gateway screen and
we start creation chart of Accounts. (Figure 5.7)

Figure 5.6: Screens for Company Creation
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5.2.3 CHART OF ACCOUNTS

Chart of Accounts is the segmentation of Liabilities and Assets of
Balance Sheet and Income & Expenses of Profit and Loss Account. In
the accounting software such chart of accounts is classified into two
categories, such as Ledger Accounts, Accounts Group.

• Ledger Account: Ledger Accounts represents the assorted,
summarised and balanced transactions of similar nature. For
example, the ledger account Conveyance represents the set of
transaction related to conveyance expenses and their summarised
net figure. All Accounting transactions are linked to Ledger account.

• Account Group:  Account Group is a convenient method of
organising the Ledger Accounts into a tree-structured hierarchical
view for better the understanding and interpretation.

5.2.3.1  Hierarchy of Account Head

In the accounting system accounts is the segmentation of liabilities
and assets of balance sheet and income and expenses of profit & loss
account. It represents the hierarchical arrangement of account groups
and ledger accounts.

5.2.3.2  Group of Account

Group of account is a method of organising the large number of ledger
accounts into sequential arrangement for recording and summarisation
of accounting data.

Figure 5.7: Selections for Data Entry Options for Active Company
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In accounting software the pre-defined groups and these existing
groups cannot be altered. In the account groups there are 28 pre-
defined groups, out of these groups 15 are primary groups and 13 are
sub-groups.

• Primary Group: It is a basic grouping of the set of sub-groups into
major account heads according to their listing in balance-sheet
and profit and loss account.

• Sub-Group: A sub-group is a set of accounts opened in the ledger of
recording of related transactions. For example, to record a refund
of loan accounting to Rs. 1,000 to Ansal first click on <Loan
Liabilities> and the <list of ledger> will appear . Here we click on
<Ansal> to open this account for recording.

5.2.3.3 Account Group of Balance Sheet

• ACCOUNTS GROUP OF LIABILITIES

 Capital: Ledger Account for Owner’s Capital may be placed under
the capital group, for example, Partners capital account, Equity
share capital, Preference share capital.

Figure 5.8 : Groups and Ledger
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 Reserves and Surplus: It is a sub-group of capital account. All
reserves are placed under Capital group, for example, General.
Reserve, Capital Reserve, etc.

• ACCOUNT GROUP – LOANS (LIABILITIES) – It contains following
sub-groups:

 Bank Overdraft: In computerized accounting system, Current
Bank Account, Bank Overdraft, and Cash Credit is sub-group of
Loan (Liabilities) because Bank Overdraft and Cash Credit
operation on day-to-day basis should be placed under this group.

 Secured Loans: Secured Loan’s are fully secured loan against
security like (mortgage, hypothecation, pledge, etc ) should be
placed under this group .

 Unsecured Loans: Such loan’s are without any security: Example
of such loans are: Loan from outside parties, Directors, Friends
and Relatives, etc.

• ACCOUNTS GROUP – (CURRENT LIABILITIES)

 Duties and Taxes: Under this head all duties and taxes that
you collect or pay through sales service and purchase
transactions.

 Provisions: In this head all provisions made for meeting the
future liabilities such as provision for tax , proposed dividends
(like Bad Debts, etc ).

 Sundry Creditors: Sundry Creditors are all trade creditors/
suppliers and creditors for expenses. For example, if you
purchase, on credit basis then create one ledger account for
sundry creditors.

 Other Current Liabilities: Place all other current liability
account like employees contribution for Employees State
Insurance/Provident Fund/Tax Deducted at Source (TDS), etc.

• ACCOUNT GROUP OF ASSETS:

  ACCOUNTS GROUP (FIXED ASSETS)ACCOUNTS GROUP (FIXED ASSETS)ACCOUNTS GROUP (FIXED ASSETS)ACCOUNTS GROUP (FIXED ASSETS)ACCOUNTS GROUP (FIXED ASSETS)

 Fixed assets: Fixed assets directly related with immovable
properties like Patent, Trade Right, W.I.P, Goodwill, Building,
Plant, Equipment, Furniture, etc

• ACCOUNTS GROUP (INVESTMENT)

 Investment: Investment ledger account relates to the investment
in Share Bonds, Govt. Securities and Investments in other company

• ACCOUNTS GROUP (CURRENT ASSETS): Those assets which
consumed in operations are known as current assets. Examples of
current assets are Stock on hand, Deposits, Loan and Advances,
Sundry Debtors, Bank Account, Cash in hand.
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 Stock on Hand: Such ledger accounts show Raw Material, Work–
in-Progress and Finished goods.

 Loans and Advances: Such loans and advances are of non-
trading nature, for example, Advance against Salary, Loan to
employee, Advance for Fixed Assets.

 Sundry Debtors: Sundry Debtors are directly related to the parties
to whom goods has been sold on credit.

 Bank Account: It includes bank deposits made by the company
such as balance of current and saving account, fixed deposits
security deposits, rental deposits, etc.

 Cash in Hand: Cash Ledger account directly relates with cash
transactions, Cash in transit, patty cash, and cash at bank.

 Miscellaneous Expenditure: For limited company, preliminary,
pre-operative and similar expenses (to the extent not written-off
to the profit and loss account placed here. Also the accumulated
loss as of the  company and negative balance of profit  & loss
account is also placed in this category.

• PROFIT AND LOSS ACCOUNT

 Sales Account: For different sales accounts, the segregation is
based on tax slabs or type of sales. This also becomes a simple
mechanism for preparation of tax returns. For example, Sales
account is classified as following such-groups: domestic sales,
export sales, You may even open  sales returns account under
the group domestic sales to view net sales after returns (or the
returns may be directly recorded through journal against the
specific sales account).

 Purchase Account: This is similar to sales accounts, except for
the purpose of the transaction.

 Direct Income [Income Direct]  All trade income accounts fall
under sales accounts. You may wish to use this group for
accounts like servicing contract charges that follow after the
sales of equipment.

 Indirect Income [Income Indirect]  These are the miscellaneous
non-sale income accounts, e.g., rent received and interest
received.

 Direct Expenses [Expenses Direct] These accounts determine
the Gross Profit of the company.

 Indirect Expenses [Expenses Indirect] - These include all other
administrative, selling or non-direct expenses.

 Tally automatically opens the profit and loss account which is a
reserved primary account. You may use this account to record
adjustment entries through journal vouchers.e.g., transfer of profit
or loss to capital or reserve account.
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5.2.4 ACCOUNT MASTER

• ACCOUNTS GROUP CREATIONS

Select Accounts info at Tally Main Menu (Figure 5.9) to get <Accounts
info Menu>, which contains options for all Accounts Masters.

  After selecting  Create option under Single Group to reach to the
Account Group creation screen. Now enter as shown in Figure 5.10,

 Account Group Name:  At name field, enter unique Account
Group Name.

 Parent Group Name: At under field, select the Parent Group
from list of Group.

Figure 5.9 Account Groups

Figure 5.10 : Account Group
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• ACCOUNTS LEDGER CREATION:  Tally automatically creates two
ledgers, one Cash and another Profit and Loss Accounts. You have
to create all other Ledger Accounts (Figure 5.11).

 Account Ledger Name: - Enter a unique Name of the ledger

 at Under field select the parent Group of the ledger from list of
Group.

 In the Opening Balance field enter the opening balance at the
Books Beginning from Date .

Figure 5.11 : Account Ledger

Figure 5.12 displays the user Account Group and Ledger after
creation. The next step is the Creation of necessary ledgers. via creation
of vouchers.

5.2.5 VOUCHER ENTRY

After creation of accounts the user enters accounting voucher entry in
the books of accounts. In the computerized accounting system, the
transactions are recorded through a voucher entry. Normally, a
transaction is supported by a document that may be a supplier’s bill,
pay-in-slip, pay register entry of cheque book, etc. Thus, basically
voucher contains details of a transaction. In accounting software,
Voucher creation displays its own screen which is self-explanatory.
The vouchers are three types —:

 Memo Voucher:  Memo voucher is a non accounting voucher.
It does not affect accounts of the user. These entries are stated/
recorded in a separate register, but not as a part of ledger.
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 Post Dated voucher:  Some accounting software allows the user
to enter the voucher for future transactions which are usually
similar as the previous once.

 User defined Voucher: In accounting software there are 23 pre-
defined vouchers. It allows the user to define or create new
accounting or inventory vouchers as per the requirement. In the
voucher entry, entry can be classified into three basic categories.

• Opening Entry: In order to begin the new financial year, balances
of accounts of the previous year are brought forward. For this opening
entry in the journal is recorded. It is to record the opening balance
of various accounts that are being transferred from the books of the
previous year to the books of the new financial year. All those
accounts which shows the assets of a business are debited and all
the accounts showing amounts owed by the business (liabilities)
are credited. If capital amount is not given, it can be easily as
certained by deducting liabilities from assets (capital = assets –
other liabilities) and Capital account is also credited. The entry
would be :

• Closing Entry:  The closing entries for completing the profit and
loss account are :

1. Debit Profit and Loss account.
Credit the various Expenses account appearing in the Trail
Balance.

2. Debit account showing incomes or gains

Credit the profit and loss account

This will close the profit and loss account. Entries required to make
the trading account and profit and loss account are known as closing
entries because their effect is to close the books of account for the year
concerned.

Cash account Dr

Cash at Bank account Dr

Sundry Debtors account Dr

Stock account Dr

Furniture account Dr

Office Equipment account Dr

   To Sundry Creditors account

   To Capital account
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• Adjusting Entry: The Adjusting entry is recorded to relate the
figures to the trading period. Suppose, premises have been sublet
on March 31, and three months’ rent, has been received in advance
amounting to Rs. 9000. While preparing accounts up to 31st March,
one should take into account only one month’s rent for preparing
the profit and loss account (accounting period concept); the rest
two month’s rent, already received is for the next year and will be
credited to profit and loss account next year. The adjusting entry
will be :

Rent Account         Dr.

To Advance Rent Account

Rent Received in advance Account is a ‘Liability’ and is shown in
the balance sheet.

Method of Voucher Numbering: This is, perhaps, one reason for
your opting for a new voucher type. For this purpose, the following
medhods are available:,

• Manual

This method will allow you to number vouchers yourself. However
it does not check for sequence of the numbers and permits you to
specify anything you wish in the voucher number field. However,
you may choose to prevent entry of duplicate numbers. If you do,
enable the next field ‘Prevent Duplicates’ — options Prevention of
Duplicates is possible if you enable the option at the time of creation.
You may enable it later (by alteration) only if there are no
transactions of this voucher type.

• Automatic

This method is both; flexible and exhaustive. Automatic system
instructs Tally to number the vouchers of this type incrementing
automatically.

Starting number

Give the number for the first voucher. Usually it is 1. You can set it to
any number you want. Tally will auto-increment from this number for
subsequent vouchers. However, the numbering of vouchers also depends
on other variables supplied by you, which follow hereafter.

In the voucher entry, Tally create certain rules to trap mistakes.
These rules are validated during voucher entry and any violation is
trapped immediately.  Tally divides a voucher in three basic categories,

• Contra Voucher: Contra voucher is used for Fund Transfer between
Cash and Bank account only. For example, Rs 5,000 Cash withdrawn
from Bank of India .

Cash A/C Dr 5,000.00

To Bank of India 5,000.00

(Cash withdrawn from bank )
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• Receipts Voucher  :- All Inflow of money is recorded through Receipt
Voucher. Such receipts may be towards any Income such as receipts
from debtors, loan/advance taken or refund of loan/advance for
example: Rama and Co. to whom goods were sold earlier on Credit,
paid against Bill No 54 for Rs 4,500 Cash Discount is Rs 500.

Cash A/C Dr. 4,500.00

Cash Discount A/C Dr.    500.00

To Rama & Co. Cr. 5,000.00

(Cash Payment Received against Bill no 54)

• Payment Voucher: All Outflow of money is recorded through
Payment Voucher. Such payment may be towards any purchase,
Expenses, due to creditors, loan/advances, etc. For example: - Salary
paid to A.K Gupta through Bank.

Salary A/C Dr 15,000.00

To Bank Cr 15,000.00

(Salary Paid to Mr A.K Gupta through Bank)

• Journal Voucher: Journal is an Adjustment voucher, normally used
for non cash transaction like adjustment between the Ledgers. For
example :-

Deprecation  A/C Dr 5,000.00

To  Machinery 5,000.00

(Being Deprecation charged on Machinery)

Display: Some top level reports like Balance Sheet, Profit and Loss
Account etc may be available at main menu, while other reports are
available through Display option at main menu .

Figure 5.12 Voucher Entry
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5.2.6 TRIAL BALANCE

This report shows the trial balance of a Primary Group.

Select Display > Trial Balance.

In Primary Group trial balance (Figure 5.13), Click F1: obtain detail
trial balance and trial balance shows the closing balance of accounts
group/Ledger.  After all voucher entry have been done, it can be seen
how every amount that is placed on the debit side of an account has a
corresponding entry on the credit side of some other account. This is
the technical aspect of the principle of double system. This being the
case, that the total of the debit balances hold agree with the total of all
the credit balances. In fact all businesses periodically tabulate the
debit and credit balances separately in a statement to find out whether
the total of debit balances agree with the total of credit balances or
not. Such a statement is known as the trial balance.

5.2.7 BALANCE SHEET AND PROFIT AND LOSS ACCOUNT

The Profit and Loss account is constructed by simply posting all items
of income and expense from the journal entry. The current year’s profit
is determined by balancing the accounts and carried forward to the
appropriation section of the profit and loss account. All balances
remaining in any ledger account after the profit and loss account is
drawn up are listed in the balance sheet .Generally the assets and
liabilities are stated in decreasing order of permanence.

All expenses (direct or indirect) are related to profit and loss account
and revenues and incomes are credited to it. If an expense has been
incurred but not yet paid for, is a liability for the unpaid amount and
must be created before the account can be said to show a true picture.

Figure 5.13 : Trial Balance
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BALANCE SHEET OF M/S XYZ LTD AS ON 31-03-2009

Figure 5.14 : Balance Sheet

Description Amount Description Amount

Share Capital Fixed assets

Authorised Capital Goodwill

Paid up Capital Land and Building

Reserve and Surplus Plant and Machinery

Capital Reserve Furniture and Fixture

Other Surplus Investment

Secured Loans Govt securities

Debentures Share Bond and Debenture

Loans from Bank Current Assets

Other Loans Loan and Advances

Unsecured Loans Sundry Debtors

Fixed Deposits Cash and Bank

Advances from Bank Stock in Trade

Other Loans Accrued Interest

Current Liabilities Loan and Advances

Sundry Creditors Bill of Exchange

Advances from Bank Miscellaneous Expenditure
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Provision for Tax Commission on Underwriting

Provision for P. dividend Discount on Share

Other Provision Development Expenditure

Profit and Loss Account (loss)

  Total Liabilities Total Assets

5.2.8 DISPLAY OF REPORT

Once all the transactions are entered, you can generate different
statements like trial balance, balance sheet and profit and loss account.
There are no intermediate steps of entering subsidiary books and
ledgers. Thus the process of accounting becomes quite easy and simple.
At the same time speed also improves and consistency is maintained.
Also no redundant data is stored at multiple places. Also the respective
register such as purchase register, sales register, journal proper are
automatically maintained on the basis of data entered in the form of
vouchers. These registered can be viewed by

• Selecting Gateway of Tally > Report >Display>Accounts Books >Sales

register.

• Selecting Gateway of Tally > Report >Display>Trial Balance.

• Selecting Gateway of Tally > Report >Display>Cash flow.

• Pressing  Alt + P or selecting print option for button bar

5.2.9  A SMALL PROJECT WITH BANK RECONCILIATION

STATEMENT (BRS)

The following are the steps to construct BRS in Tally:

• Bring up the monthly summary of any Bank Book. (You can do this
from the Balance Sheet, Trial Balance, or Display/Account  Books/
Bank Books, and selecting a Bank).

• Bring your cursor to the first month (typically April), and press
Enter. This brings up the Vouchers for the month of April. Since
this is a Bank Account, an ‘additional’ button F5: Reconcile will be
visible on the right, Press F5.

• The display now becomes an ‘Edit’ screen in ‘Reconciliation’ mode.
The primary components are: A column for the ‘Bankers Date’.

• The ‘Reconciliation’ at the bottom of the screen,

• Balance as per Company Books

• Amounts not reflected in Banks

• Balance as per Bank
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Gateway of Tally>Display>Accounts Books>Cash and Bank

Book>Bank Account>Ledger>Press F5

The Balance as per Company Books reflects your Balance as on the
last date (in our example case, April 31).

The amount not reflected in bank is the debit and credit sums of all
those vouchers whose Bank Date in either BLANK, or GREATER that
April 30 (i.e. these vouchers have not yet been reflected in the bank
Statement).

The Balance as per bank is the Net Balance.

You will find, as you mark of the individual vouchers by setting the
‘Bank Date’, that the Reconciliation at the bottom of  screen keeps
reflecting those changes instantly.

Upon completion, press+A (or press Enter as many times as necessary
to skip over the unmarked vouchers), and accepted the screen. The
next time you reconcile, you will be presented only with those vouchers
with remain unrecognised. Thus, the task keeps becoming simpler.

5.3 NEED AND SECURITY FEATURE OF THE
SYSTEM

Every accounting software provides data security; safety and
confidentially; so every software provides of data security in three ways:

• Password security

• Data Audit

•   Data Vault

Figure 4.15 : Bank Reconciliation Statement

Particular of

Payment/receipt

Mention the date

of Cheque cleared

Debit/Credit

amount
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Password Security Password is widely accepted security control to
access the data. Only the authorised person can access the data. Any
user who does not know the password cannot retrive information from
the system. It ensures data integrity. It uses a binary encoding format
of storage and offers access to the database.

Data Audit: Audit feature of accounting software provides the user
with administrator right in order to keep track of unauthorised access.
to the database. It audit for the correctness of entries. Once entries
are audited with alternations, if any the software displays all entries
along with the name of the auditor user and date and time of alteration.

Data Vault: Software provides additional security for the inputed
data and this feature is referred as data vault. Data vault ensures
that original information is presented and is not tampered. Data vault
password cannot be broken. Some software uses data encryption
method.

Function Key CombinationFunction Key CombinationFunction Key CombinationFunction Key CombinationFunction Key Combination

Windows Functionality Availability

F1 To select a company At all masters menu screen

To select the Accounts Button At the Accounting/Inventory
and Inventory buttons Voucher creation and

alteration screen

F2 To change the menu period At almost all screens in TALLY

F3 To select the company At almost all screens in TALLY

F4 To select the Contra voucher At Accounting/Inventory
Voucher creation and alteration
screen

F5 To select the Payment voucher At Accounting/Inventory
Voucher creation and alteration
screen

F6 To select the Receipt voucher At Accounting/Inventory
Voucher creation and alteration
screen

F7 To select the Journal voucher At Accounting/Inventory  Voucher
 creation and alteration screen

F8 To select the Sales voucher At Accounting/Inventory  Voucher
creation and alteration screen

F8 To select the Credit Note voucher At Accounting/Inventory Voucher
(CTRL+F8) ercreation and alteration screen

F9 To select the Purchase voucher At Accounting/Inventory Voucher
creation and alteration screen

F9 To select the Debit Note voucher At Accounting/Inventory Voucher
(CTRL+F9) creation and alteration screen
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F10 To select the Reversing Journal At Accounting/Inventory Voucher
voucher creation and alteration screen

F10 To select the Memorandum voucher At Accounting/Inventory Voucher
creation and alteration screen

F11 To select the Functions and Features At almost all screens in TALLY
screen

F12 To select the Configure screen At almost all screens in TALLY

Special Key CombinationSpecial Key CombinationSpecial Key CombinationSpecial Key CombinationSpecial Key Combination

Windows Functionality Availability

ALT + 2 To Duplicate a voucher. At List of Vouchers – creates a voucher
similar to the one where you positioned
the cursor and used this key
combination.

ALT + A To Add a voucher. At List of Vouchers – adds a voucher
after the one where you positioned
the cursor and used this key
combination.

ALT + C To create a master at a voucher At voucher entry and alteration
screen (if it has not been already screens, at a field where you have to
assigned a different function, as in select a master from a list. If the
reports like Balance Sheet, where it necessary account has not been
adds a new column to the report). created already, use this key

combination to create the master
without quitting from the voucher
screen.

ALT + D To delete a voucher. At Voucher and Master (Single)
To delete a master. alteration screens. Masters can be
(if it has not been already assigned deleted subject to conditions, as
a different function, as explained above). explained in the manual.

ALT + E To export the report in ASCII, SDF, At all reports screens in TALLY.
HTML OR XML format.

ALT + I To insert a voucher. At List of Vouchers – inserts a voucher
before the one where you positioned the
cursor and used this key combination.

ALT + O To upload the report at your website. At all reports screens in TALLY.

ALT + M To Email the report. At all reports screens in TALLY.

ALT + P To print the report. At all reports screens in TALLY.

ALT + R To remove a line in a report. At all reports screens in TALLY.

ALT + S To bring back a line you removed At all reports screens in TALLY.

using ALT + R.

ALT+ V From Invoice screen to bring At Invoice screen/Quantity Field/

Stock Journal screen. Press Alt + V to select the Stock Journal.
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Windows Functionality Availability

ALT + W To view the Tally Web browser. At all reports screens in TALLY.

ALT + X To cancel a voucher in Day Book/ At all voucher screens in TALLY.

List of Vouchers.

ALT + R To Register Tally. At Licensing Menu in TALLY.

CTRL + A To accept a form – wherever you use At almost all screens in TALLY, except

this key combination, that screen or where a specific detail has to be given

report gets accepted as it is. before accepting.

CTRL + B To select the Budget. At Groups/Ledgers/Cost Centres/

Budgets/Scenarios/Voucher Types/

Currencies (Accounts Info) creation and

alteration screen.

CTRL  + C To select the Cost Centre. At Groups/Ledgers/Cost Centres/

Budgets/Scenarios/Voucher Types/

Currencies (Accounts Info) creation and

alteration screen.

To select the Cost Category. At Stock Groups/ Stock Categories/

Stock Items/ Reorder Levels/ Godowns/

Voucher Types / Units of Measure

(Inventory Info)  creation/alteration

screen.

CTRL+ E To select the Currency. At Groups/Ledgers/Cost Centres/

Budgets/Scenarios/Voucher Types/

Currencies (Accounts Info) creation and

alteration screen.

CTRL + G To select the Group. At Groups/Ledgers/Cost Centres/

Budgets/Scenarios/Voucher Types/

Currencies (Accounts Info) creation and

alteration screen.

CTRL + I To select the Stock Items. At Stock Group/ Stock Categories/ Stock

Items/ Reorder Levels/ Godowns/

Voucher Types / Units of Measure

(Inventory Info)  creation/alteration

screen.

CTRL + L To select the Ledger. At Groups/Ledgers/Cost Centres/
Budgets/Scenarios/Voucher Types/
Currencies (Accounts Info) creation and
alteration screen.

CTRL + O To select the Godowns. At Stock Group/ Stock Categories/ Stock
Items/ Reorder Levels/ Godowns/
Voucher Types / Units of Measure
(Inventory Info)  creation/alteration
screen.
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Windows Functionality Availability

CTRL + Q To abandon a form – wherever you At almost all screens in TALLY.
use this key combination, it quits that
screen without making any
changes to it.

 CTRL+Alt+R Rewrite data for a Company. From Gateway of Tally screen.

CTRL + S Allows you to alter Stock Item master. At Stock Voucher Report and Godown
Voucher Report.

CTRL + U To select the Units. At Stock Groups/Stock Categories/
Stock Items/Reorder Levels/Godowns/
Voucher Types/Units of Measure
(Inventory Info)  creation/alteration
screen.

Ctrl + V To select the Voucher Types. At Groups/Ledgers/Cost Centres/
Budgets/Scenarios/Voucher Types/
Currencies (Accounts Info) creation and
alteration screen. Special Function Key
Combination

Special Key CombinationSpecial Key CombinationSpecial Key CombinationSpecial Key CombinationSpecial Key Combination

Windows Functionality Availability

ALT + F1 To close a company. At all the menu screen.
To explode a line into its details. At almost all report screen.
To view detailed report. At almost all screens in TALLY.

ALT+ F2 To change the system period. At almost all screens in TALLY.

ALT + F3 To select the company info menu. To create/alter/shut a Company.
At Gateway of Tally screen.

ALT + F4 To select the Purchase Order At Accounting/Inventory
Voucher Type. Voucher creation and alteration screen.

ALT + F5 To select the Sales Order At Accounting/Inventory Voucher
Voucher Type. creation and alteration screen.

To view monthly and quarterly At almost all report screens in
report. TALLY.

ALT + F6 To select the Rejection At Accounting/Inventory Voucher

Out Voucher Type. creation and alteration screen.

To change the Sales Order

Voucher Type.

ALT + F7 To select the Stock Journal  At Accounting/Inventory Voucher

Voucher Type  creation and alteration screen.

To accept all the Audit lists  At TallyAudit Listing screen

ALT+ F8 To select the Delivery Note At Accounting/Inventory Voucher

Voucher Type. creation and alteration screen.

To view the Columnar report. At Ledger Voucher screen.
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Windows Functionality Availability

ALT + F9 To select the Receipt Note At Accounting/Inventory Voucher

Voucher Type. creation and alteration screen.

ALT + F10 To select the Physical Stock At Accounting/Inventory Voucher

Voucher Type. creation and alteration screen.

ALT + F12 To filter the information based At almost all report screens.

on monetary value.

CTRL+ Advanced Config. At Gateway of Tally.

ALT+F12

Key Combination used for navigationKey Combination used for navigationKey Combination used for navigationKey Combination used for navigationKey Combination used for navigation

Windows Functionality Availability

PgUp Display previous voucher during At voucher entry and alteration

voucher entry/alter.  screens.  

PgDn Display next voucher during At voucher entry and alteration

voucher entry/alter. screens.  

ENTER To accept anything you type You have to use this key at most

into a field. areas in TALLY.

To accept a voucher or master. At the receivables report – press

Enter at a pending bill to get

To get a report with further transactions relating to this bill (e.g.,

details of an item in a report. original sale bill, receipts and payments

against this bill, etc.).

ESC To remove what you typed into a field.

To come out of a screen. At almost all screens in TALLY.

To indicate you do not want to

accept a voucher or master.

SHIFT + Collapse next level details. At Voucher Register screen and

ENTER Trial Balance report.

SHIFT + To explode a line into its details. In almost all Reports: At a Group/

ENTER Stock Group/Cost Category/Godown/

Stock Category – displays Sub Groups

and Ledgers/Stock Items/Cost Centres/

Secondary Godowns/Secondary Stock

Categories. At a Voucher – displays its

entries and narration.At a Stock Item-

displays its godowns and batch details.At

Voucher Register screen – displays the

next level details.At Trial Balance report

- displays the next level details.

CTRL + To alter a master while making At voucher entry and alteration

ENTER an entry or viewing a report. screens At all reports.
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SummarySummarySummarySummarySummary

• In computerised accounting system, accounting transactions are journalised

by two methods (1) manually (2) computerised. In the present computerized

accounting system are more and more effective in comparison of manual

system of accounting. There are different type of accounting softwares in

market but Tally 9.0 is more effective accounting software. Tally 9.0 software

have a different features these are :

i) Gateway - Gateway is the starting of Tally. In other words we can say

that gateway is the gate to enter in Tally.

ii) Company creation - Before inputing accounting transactions, first we

create a company through company creation.

iii) Chat of accounts - Chart of accounts is the segmentation of Liabilities

and Assets of Balance Sheet and preparation of Profit  and Loss account.

iv) Account master - Account master basically used for account group

and ledger .

v) Voucher entry - After creation of account user inputs accounting

voucher entry in the book of accounts. In computerised accounting

system all entries are inputed through a voucher entry.

vi) Trial Balance - Trial balance is the statement of different closing

balances of ledger.

vii) Balance Sheet - The balance sheet is constructed by simply posting all

items of liabilities and assets for the finalisation of journal entry.

• Report printing - Report printing is the last step of accounting process.

• Accounting software can be used to successfully maintain the financial

transactions of any organisation. Besides data maintenance, these prove to

be very efficient when we have to generate accounting reports, which are

crucial for decision making in an organisation. These software packages

have many more features, which can be explored and used depending on

the type of transaction details you require.
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EXERCISE

Q. 1. MULTIPLE CHOICE QUESTIONS

A. To create group which menu is used?

a. Gateway of Tally > master >accounts info > create

b. Gateway of Tally > master >accounts info > alter

c. Gateway of Tally > master >accounts info > display

d. Gateway of Tally > master >accounts info > edit

B. To create ledger which menu is used ?

a. Gateway of Tally > master >accounts info >ledger > create

b. Gateway of Tally > master >accounts info > ledger >alter

c. Gateway of Tally > master >accounts info > ledger >display

d. Gateway of Tally > master >accounts info > ledger>edit

C. Which short cut is used to shift “company information menu” form gateway of
Tally?

a. Alt + F3

b. Alt + Escape

c. Shift + F3

d. Shift + F1

D. In which group will you record the expense of light bill of Factory?

a. Direct income

b. Direct Expense

c. Indirect income

d. Indirect Expense

E. While recording the voucher entry if it is necessary to create a new ledger for

that which commands is used in Tally?

a. Ctrl + C

b. Ctrl + G

c. Alt + C

d. Alt + G

F. While creating ledger if you want to create new group which key is pressed?

a. Ctrl + C

b. Ctrl + G
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c. Alt + C

d. Alt + G

G. ……………… works as a platform to work with Tally

a. Gateway of Tally

b. Outway of  Tally

c. Company information

d. All the above

H. How many characters are used to create company’s short name?

a. 2

b. 4

c. 3

d. 5

Q. 2. ANSWER THE FOLLOWING QUESTIONS

1. How do you begin using Tally accounting software?

2. What menu option is available on the gateway of Tally screen?

3. What is the use of Button bar in Tally accounting package?

4. What are the contents of Balance Sheet in Tally?

5. What do you mean by Account Info?

6. Explain the process of Company Creation?

7. “Report generating is not a easy task” Is this statement true or false Explain?

8. Describe the various contents of Profit and Loss Account?

9. Describe the process of creating a Group company and how would you Display
and Alter a Group account?

10. Describe Tally 9.0 and what are the new features of 9.0, and explain the various
items of the Tally screen?

Q. 3. SKILL REVIEW

1. From the following transactions of Ashirwad Ltd, post the voucher entries in

the respective ledger accounts, prepare a trial balance and balance sheet.

i. Started a business with cash Rs 40,000

ii. Goods of Rs 10,000/- were purchased at 10% trade discount

iii. Goods of Rs 5,000/- were sold with a profit of 40% to Arjun

iv. Commission received Rs 500

v. Cash deposited Rs 7,000 in a bank
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vi. Return of goods Rs 1,500

vii. Salary paid Rs 2,500

viii. Wages paid Rs 350

 ANSWERS

1. a 2. a 3. a 4.  d 5. c 6. b

7. a 8. b
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DATA BASE

MANAGEMENT SYSTEM

FOR ACCOUNTING

Introduction
After studying this unit you will be able

to:

• Understand how to Structure

database as per requirement.

Design and create database

tables.

• Make use of Microsoft Access for

simple database applications

involving creation of back-end

database and the front-end

forms for capturing, processing

and retrieval of data.

6

 

One of the major factors for realising the need of
Computerised Accounting System is the
overwhelming quantity of data in our
organisations.  The conventionally used paper filing
system, text documents, and even spread-sheets
may not suffice for the growing needs of tracking
this voluminous and critical information. A simple
solution to this situation is available in the form
of a Database Management System (DBMS) (e.g.
‘Access’, ‘Oracle’, ‘SQL Server’, etc.) that provides
a variety of software tools for organising,
processing and querying data in a flexible manner.

As we now proceed to look into practical
applications of computers in generating, storing,
processing, and retrieving of accounting
information, we will make an assumption that you
are fairly conversant with the accounting framework
and operating procedure – i.e. you have the required
domain knowledge. We also assume that you have
adequate exposure to handling of computers and
the concepts of database. However, we do not wish
to make knowledge of the database management a
pre-requisite for understanding of this chapter,
and hence, we will restrict ourselves to the simpler
and easy to comprehend ‘MS Access’ program for
developing some practical accounting applications.
In doing so, we will focus on the three major
components of Access, namely, ‘tables’, ‘queries’
and ‘forms’. Having done that, we will examine
the methods of generating reports. This basically
builds on the concepts of DBMS already learnt by
you in class XI.
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8.1 UNDERSTANDING AND DEFINING THE
DATABASE REQUIREMENT

With the continuous improvements in computer’s processing speed,
storage capacity, networking techniques, operating systems, etc, the
capabilities of computer applications have also gone up many folds.
Various computer applications that are commercially available today
not only provide fairly comprehensive tools for all conceivable needs
but also have become extensively user friendly. So, when we look
forward to putting into use database applications such as ‘Access’, we
really do not need much of programming skills. Nevertheless, any
programming knowledge may improve our efficiency and effectiveness
in handling such applications. On the other hand, before we develop
any database application, we ought to have a complete understanding
of our requirements expected from the application. This is one area
where application itself may not extend much help. Further, the correct
understanding of our requirement also has a bearing on the choice of
Database Management Systems (DBMS) - i.e. whether to go for a ‘desktop
database’ or to choose the ‘server database’.

Box - 6.1Box - 6.1Box - 6.1Box - 6.1Box - 6.1

In most of the cases, database is not directly accessible to users. Any

addition, modification or retrieval of information from database is done

by the user-friendly programs. Database is thus rightly referred to as

‘back-endback-endback-endback-endback-end’ while the interactive program is termed as ‘frfrfrfrfront-endont-endont-endont-endont-end’ of a

database application.

While the desktop databases – residing on standard personal computers
– are oriented toward single-user applications, ‘server databases’ are
geared toward multi-user applications. Understandably the ‘server
database’, containing additional provisions for ensuring reliability and
consistency of data in a multi-user environment, are substantially costlier
than the ‘desktop database’. Hence, it is imperative to do a careful
analysis of our requirements before investing in a database solution.
Some of the questions that need to be answered in this regard are:

• What all data is required to be stored in the database?

• Who will capture or modify the data, and how frequently the data
will be modified?

• Who all will be using the database, and what all tasks will they
perform?

• Will the database (backend) be used by any other front-end
application?

• Will access to database be given over LAN (Local Area Network)/
Internet, and for what purposes?

• What level of hardware and operating system is available?

6.1 UNDERSTANDING AND DEFINING THE
DATABASE REQUIREMENT

With the continuous improvements in computer’s processing speed,
storage capacity, networking techniques, operating systems, etc, the
capabilities of computer applications have also gone up many folds.
Various computer applications that are commercially available today
not only provide fairly comprehensive tools for all conceivable needs
but also have become extensively user friendly. So, when we look
forward to putting into use database applications such as ‘Access’, we
really do not need much of programming skills. Nevertheless, any
programming knowledge may improve our efficiency and effectiveness
in handling such applications. On the other hand, before we develop
any database application, we ought to have a complete understanding
of our requirements expected from the application. This is one area
where application itself may not extend much help. Further, the correct
understanding of our requirement also has a bearing on the choice of
Database Management Systems (DBMS) - i.e. whether to go for a ‘desktop
database’ or to choose the ‘server database’.
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If our requirement entails approach to database by many users, or if it
involves simultaneous updating of data by different users, then perhaps
server databases such as ‘Microsoft SQL Server’, ‘Oracle’ or ‘IBM DB2’
will provide desired solutions.

Although carrying high price tags, a server-based database can
give you several advantages in terms of flexibility for the choice of
front-end applications, powerful performance independent of platform,
and scalability to handle rapidly expanding number of users as well as
amount of data.

Box - 6.2Box - 6.2Box - 6.2Box - 6.2Box - 6.2

Quite often, same database is required to be used by different

applications. For example, an organisation may have automated

attendance recording system which will record the arrival and

departure time of employees. A variety of such systems (e.g. Card-

swipe, Biometric, etc.) are available in the market, and all of them

come with their own (back-end) database and requisite (front-end)

programs.  This attendance information may be required for generating

salary bills of the employees. The payroll application of the organisation,

with its own (back-end)(back-end)(back-end)(back-end)(back-end) database and (front-end)(front-end)(front-end)(front-end)(front-end) program, will also

access the database of attendance recording application.

Box - 6.3Box - 6.3Box - 6.3Box - 6.3Box - 6.3

Access 2007 usually comes as part of Microsoft Office 2007. However,

it can also be purchased separately as a standalone program. In order

to run this program, your computer should have a minimum configuration

of 500 MHz Processor, 256 megabyte RAM, 1.5 gigabyte Hard disk,

and Windows XP Operating system.

Comparatively, the desktop databases offer an inexpensive and simple
solution to many of our business data storage and processing
requirements. The ‘Microsoft Access’ is one such database - which
comes with the licensed copy of Microsoft Office Professional – providing
one of the simplest and most flexible DBMS solutions today, besides
giving the advantages of familiar ‘Windows’ look and  integration with
other Microsoft Office products such as ‘Excel’.

Before opting for any of the database management system, it will be
necessary to ensure that your hardware as well as operating system
meets the minimum system requirements of the desired DBMS. As
stated earlier, we will be enumerating examples of ‘Access’ applications,
and hence it is imperative that your computer lab is equipped with the
licensed copy of ‘MS Access’ with compatible configuration of the
hardware. The illustrations contained in this book are based on Access-
2007, which may feel a little different from what you are working with
in case your application is of a different version.
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Even on same version of the ‘Access’, marginal differences may
appear in the illustrated diagrams and the views on your computer
and this may happen on account of variations in the customised settings
of the application. However, these variations are not expected to hamper
your understanding of the contents of this chapter.

6.2 IDENTIFICATION OF DATA TO BE STORED IN
TABLES

By now we understand that a database is simply an organised collection
of data with ‘tables’ as its fundamental building blocks. Tables allow
us to create the framework for storing information in the database.
Each column (also called ‘field’) of the table corresponds to a specific
characteristic (or ‘attribute’ in database terms) of the stored
information. Each row (also called ‘record’) corresponds to a particular
instance of the information.

Box - 6.4Box - 6.4Box - 6.4Box - 6.4Box - 6.4

In Access 2007, the entire database is encompassed in a file (with

extension .accdb) which can be stored in your hard-drive or CD. There

can be multiple tables (each storing a specific set of data) with in this

file. Then there are multiple fields in each table according to different

categories (types) of data within the table. And at every instance

(occurrence) of a collection of data covering all fields, a row/record

gets created.

Box - 6.5Box - 6.5Box - 6.5Box - 6.5Box - 6.5

Identification of various attributes of a database is generally considered

as part of requirement analysis. requirement analysis. requirement analysis. requirement analysis. requirement analysis. Such a process may entail database

designer to elicit needed information from those with the domain

knowledge.

We may get a better understanding of database design by referring
to practical example of an accounting problem. We may take up the
case of payroll accounting, concepts of which have already been examined
while studying spreadsheet applications in the earlier chapter(refer
chapter 3). You have already seen how different employees draw
different amounts of pay based on the nature and levels of their
employment, even while subjected to a definite pattern of ‘pay rules’
prevalent in the organisation. Since pay rules vary widely from
organisations to organisations, the database design for them will also

A set of tables often with well established relationships between
them constitutes the database covering total spectrum of stored
information. The term ‘database design’ can be used to describe the
structure of different parts of the overall database.
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differ considerably. For our illustration in this chapter, we will consider
the simplified pay pattern for an assumed organisation XYZ Pvt. Ltd.

Let us begin by identifying various attributes of information that
are required to be stored in our Payroll database. We may have a set of
attributes pertaining to employee’s personal details such as: ‘Employee
ID’, ‘Name’, ‘Designation’, and ‘Location’. On the other hand we may
also deal with such attributes pertaining to employee’s pay as: ‘Basic
Pay’, ‘Dearness Allowance (DA)’, ‘House Rent Allowance (HRA)’,
‘Transport Allowance (TA)’, ‘Provident Fund (PF) Deduction’, etc. We
may also want to know the attributes of ‘Gross Salary’ and ‘Net Salary’
which is obtained by subtracting ‘PF Deductions’ from ‘Gross Salary’.
However, ‘Gross Salary’ and ‘Net Salary’ attributes may not require
being stored in the database as they are merely computational outcomes
from other attributes. We may also require some attributes concerning
pay formulations such as ‘% Rate of DA’ which may fluctuate month to
month, ‘% Rate of HRA’ varying with the location of employee, and ‘TA
Slabs’ varying with the designation of employee.

Box - 6.6Box - 6.6Box - 6.6Box - 6.6Box - 6.6

At this stage you may like to know the limitations of ‘Excel’ in payroll

accounting. If you look back at payroll example in Excel spreadsheet,

you will notice that you have created pay information of a set of

employees for a particular month. For generating information concerning

next month, you will have to change employee specific data such as

‘Actual Basic Pay’, ‘days of attendance’, etc in respective cells.

However, the moment you do this, the information of previous month

will be lost. Understandably, ‘Excel’ is merely providing a template for

certain calculations concerning salaries, and storing single (monthly)

instance of the derived information. Excel eliminates redundant data

and hence multiple instances of information cannot be stored in a

single Excel sheet. You may avoid this situation by effecting changes

in a different copy of the sheet. In this manner you are creating different

spread sheet for different months. This is a cumbersome task, and

furthermore the information in such a case will not be residing in a

single table, or a set of related tables, from where it may be retrieved

for generation of ‘annual income’ or ‘income tax’ information.

Now the main question is how to store these attributes in our
database tables. Shall we make all of above attributes as part of one
table, or shall we opt for multiple tables.  The ‘Access’ as such will not
put any constraint on the number of tables we opt for, or the type of
data we chose to put in any table. It will have to be entirely our decision,
based on logical structuring of data that we seek to apply. You may
also apreciate the fact that the purpose of a database is not so much
for the storage of information, as for its quick retrieval. Hence, you
ought to structure your database in such a manner that it can be
queried quickly and efficiently.
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6.3 LOGICAL STRUCTURING OF DATA IN TABLES

Suppose, we seek the simplest structure of a single table containing
all attributes listed above. The rows of this table (see Figure-6.1) will
contain both employee’s personal details as well as employee’s pay
details for every instance of the salary drawn by him or her. Since, the
information will be generated on monthly basis, multiple records will
be created for each employee in the table. Understandably for any
particular employee, we may expect variations in the pay attributes
recorded under different rows - i.e. different pay components and the
resulting gross/net salary may vary from month to month. However,
we do not expect monthly variations in the personal attributes of the
same person under different rows. Evidently thus, the structure of
single table may not be an efficient one as it will entail unwarranted
recording of the same personal data multiple times.

MonthMonthMonthMonthMonth EmpEmpEmpEmpEmp Desig.Desig.Desig.Desig.Desig. Locat.Locat.Locat.Locat.Locat. %DA%DA%DA%DA%DA %HRA%HRA%HRA%HRA%HRA BasicBasicBasicBasicBasic DADADADADA HRAHRAHRAHRAHRA TTTTTAAAAA GrossGrossGrossGrossGross PFPFPFPFPF NetNetNetNetNet

& Y& Y& Y& Y& Yearearearearear NameNameNameNameName RateRateRateRateRate RateRateRateRateRate SalarySalarySalarySalarySalary Ded.Ded.Ded.Ded.Ded. SalarySalarySalarySalarySalary

Nov. Ram Chief Delhi 26 30 25000 6500 7500 7000 46000 5000 41000
2007 Kishore Manager

Nov. Kishan Manager Faridabad 26 20 22000 5720 4400 5000 37120 3000 34120
2007 Sharma

Nov. Rupali Senior Meerut 26 15 20000 5200 3000 3500 31700 2000 29700
2007 Varma Engineer

Nov. Surjeet Engineer Meerut 26 15 16000 4160 2400 3500 26060 2000 24060
2007 Singh

Dec. Ram Chief Delhi 26 30 25000 6500 7500 7000 46000 7000 39000
2007 Kishore Manager

Dec. Kishan Manager Faridabad 26 20 22000 5720 4400 5000 37120 3000 34120
2007 Sharma

Dec. Rupali Senior Meerut 26 15 20000 5200 3000 3500 31700 3000 28700
2007 Varma Engineer

Dec. Surjeet Engineer Meerut 26 15 16000 4160 2400 3500 26060 3000 23060
2007 Singh

Jan. Ram Chief Delhi 30 30 25000 7500 7500 7000 47000 6000 41000
2008 Kishore Manager

Jan. Kishan Manager Faridabad 30 20 22000 6600 4400 5000 38000 2000 36000
2008 Sharma

Repeating personal data Pay formulation parameters Pay data

Figure 6.1: Single table for all attributes

With the understanding of the limitations of a single table, let us
now examine a better approach involving creation of multiple tables.
For example, we may have separate tables for personal attributes (i.e.
name, designation, location etc.), pay formulation parameters (i.e. %
DA rate, % HRA rate, etc.) and the pay attributes (i.e. basic pay, DA,
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HRA, TA, etc.). Personal details table may be used for recording personal
attributes of every employee, consuming only one row of data (i.e. record)
for each employee. The pay details table may contain records of pay
attributes for all employees, with a new row of data created for an
employee for every instance of the monthly salary drawn by him or
her. Other tables may also be created for recording different parameters
used in pay formulations of employees. Thus, we may have separate
tables for storing the ‘% DA rate’ for different months, ‘% HRA rate’ for
different locations, and the fixed quantum of ‘Transport Allowances’
for different designations of employees.

In order to establish relationship between any two tables, we will
have to insert columns with matching values in the two related tables.
Thus, we may have ‘employee name’ appearing in both ‘personal table’
as well as in ‘pay table’. After establishing a relationship between
these two tables, rows with a common value in ‘employee name’ field of
both the tables get related. The two common fields used in a relationship
between tables are called the key fields. In our example, any ‘employee
name’ in the personal table appears only once (i.e. unique row); and
hence this field of personal table is a primary key of the relationship.
On the other hand, an ‘employee name’ in the pay table appears in
multiple rows; and hence this field of pay table is a foreign key of the
relationship. The Figure-6.2 below illustrates the relationship of some
such tables, wherein the lines connecting rows of two tables represent
relationships.

MonthMonthMonthMonthMonth % DA% DA% DA% DA% DA
and Yand Yand Yand Yand Yearearearearear RateRateRateRateRate

Nov. 2007 26

Dec. 2007 26

Jan. 2008 30

Figure 6.2: Multiple tables for different attributes

Locat.Locat.Locat.Locat.Locat. % HRA Rate% HRA Rate% HRA Rate% HRA Rate% HRA Rate

Delhi 30

Faridabad 20

Meerut 15

Emp NameEmp NameEmp NameEmp NameEmp Name Desig.Desig.Desig.Desig.Desig. Locat.Locat.Locat.Locat.Locat.

Ram Kishore Chief Manager Delhi

Kishan Sharma Manager Faridabad

Rupali Varma Senior Engineer Meerut

Surjeet Singh Engineer Meerut

MonthMonthMonthMonthMonth EmpEmpEmpEmpEmp BasicBasicBasicBasicBasic DADADADADA HRAHRAHRAHRAHRA TTTTTAAAAA GrossGrossGrossGrossGross PFPFPFPFPF NetNetNetNetNet

& Y& Y& Y& Y& Yearearearearear NameNameNameNameName SalarySalarySalarySalarySalary Ded.Ded.Ded.Ded.Ded. SalarySalarySalarySalarySalary

Nov. Ram 25000 6500 7500 7000 46000 5000 41000
2007 Kishore

Nov. Kishan 22000 5720 4400 5000 37120 3000 34120
2007 Sharma

Nov. Rupali 20000 5200 3000 3500 31700 2000 29700
2007 Varma

Nov. Surjeet 16000 4160 2400 3500 26060 2000 24060
2007 Singh

Dec. Ram 25000 6500 7500 7000 46000 7000 39000
2007 Kishore
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For our practical example, let us take the multiple-tables route. We
will have altogether five tables. Our first table, with the name
‘TabEmpDetails’, will store employee’s personal attributes in the fields
of ‘EmpName’, ‘Designation ID’ and ‘Location ID’. In addition we will
also have a field of ‘EmpID’ for storing unique values of employee
number. So this field will be identified as Primary Key for the
‘TabEmpDetails’ table; and thereby database will not permit storing of
two similar values in this field. The ‘DesignationID’ field will merely
store the ID of employee’s Designation, further details of which will be
stored in a separate table. Understandably, this field will have multiple
repetitions of some of the values. This field will form one of the foreign
keys of ‘TabEmpDetails’ table with the establishment of its relationship
with the table containing details of Designations. The ‘LocationID’ field
will get similar treatment with another table containing details of
Locations.

You may notice that we have used combinations of shortened words
for identification of table name and the names of its different fields.
This is done so as not to make headings of the table unnecessarily
long, at the same time leaving sufficient scope for easy identification
of intended attributes. You may also mark that no blank (gap) is left in
between a name. We have also used both upper and lower cases for
improving our readability of these names, though Access program as
such is case insensitive. Read Box-6.9 to know more about the naming
convention.

Our second table will be named ‘TabDesignations’ containing fields
of ‘DesgID’, ‘Designation’, and ‘TA’. Evidently, the field of ‘DesgID’
will form the Primary Key for this table. The third table with the name
of ‘TabLocations’ and containing fields of ‘LocationID’, ‘Location’ and

Box - 6.7Box - 6.7Box - 6.7Box - 6.7Box - 6.7

Avoiding duplication of information is key criteria of database design,

which is achieved by breaking up of information into separate but

related tables; and this process is called nornornornornormalisationmalisationmalisationmalisationmalisation. We will

also have to establish links between different tables so as to reconstruct

the original information; and these links in database terms are called

relationshipsrelationshipsrelationshipsrelationshipsrelationships. The database created on the basis of such relationships

between different data tables is called relational databaserelational databaserelational databaserelational databaserelational database.

Box - 6.8Box - 6.8Box - 6.8Box - 6.8Box - 6.8

The process of matching rows in two tables based on their primary

and foreign keys is called a JoinJoinJoinJoinJoin. Joins along with Structured QueryStructured QueryStructured QueryStructured QueryStructured Query

LanguageLanguageLanguageLanguageLanguage (SQL) serve as valuable tools for manipulating tables. But,

these topics are beyond the scope of this book, and hence not

elaborated further.
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‘RateOfHRA’ will have ‘LocationID’ as its Primary Key. Our fourth
table will be used for storing the percentage rate of DA for different
months of salary and it will be named as ‘TabDARates’. It will have
fields of ‘MonthID’, ‘SalMonth’ and ‘RateOfDA’ with the field of
‘MonthID’ forming the Primary Key. Now our last table will be used for
storing the salary information that will be generated for different
employees in different months. This table, named as ‘TabMonthlySalary’
will contain fields of ‘SalaryID’, ‘MonthID’, ‘EmpID’, ‘Basic’, and
‘DedForPF’ (Deduction for Provident Fund). The field of ‘SalaryID’ will
be used for making each salary record as unique data and hence it will
form the Primary Key of the table. The ‘MonthID’ (forming relationship
with ‘TabDARates’) and ‘EmpID’ (forming relationship with
‘TabEmpDetails’) will be the two foreign keys of this table.  In this
table, the field of ‘Basic’ will be entered by the Pay-clerk for every
instance of salary generation for an employee, depending upon the
level of employee and his or her attendance record for the month. The
Pay-clerk will also record the amount of PF deduction based on the
choice given by individual employee, subject to prevalent rules. You
may notice that out five tables, only the ‘TabMonthlySal’ table will
grow every month with the addition of as many records as the number
of employees drawing salary for the given month.

By now, you may have noticed that we have not given any fields in
any of the table for storing attributes of ‘DA’, ‘HRA’, ‘TA’, ‘GrossSalary’
and ‘NetSalary’. These fields are computed fields; and as such the
Pay-clerk is not required to enter any data for these fields. Then why
store them unnecessarily. Rather we will generate these fields in a
Query, which is another Access object designed to extract data form
one or more tables. Queries also allow computational facilities and
present the outcome in a tabulated manner, as we shall see in a short
while.

Box - 6.9Box - 6.9Box - 6.9Box - 6.9Box - 6.9

For writing a field name you can use up to 64 characters including

letters, numbers and blank spaces. However it is advisable to avoid

blanks as it entails irritating and unnecessary use of additional

identifiers while using names in SQL and programming components

(e.g. “Emp ID” will be written as [Emp ID] or Emp_ID, whereas it could

have been easily written as EmpID in both database as well as

programming). A name cannot start with a blank. You can include

punctuation characters except a period (.), an exclamation mark (!), or

brackets ([]). You cannot use a field name twice in the same table. It is

also advisagle to avoid use of standard words that define Access

functions and properties or are part of VB language. Same rules apply

for naming objects like Tables, Queries and Forms; however, no two

objects of the same type can have same name.
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6.4 CREATING DATABASE TABLES IN MICROSOFT
ACCESS

Before we take up the task of database design using Access, we will
have to first start up the Microsoft Access Application. For this, click
on the Star tStar tStar tStar tStar t button on the Windows Taskbar. Now point to Al lA l lA l lA l lA l l

ProgramsProgramsProgramsProgramsPrograms; then point to Microsoft OfficeMicrosoft OfficeMicrosoft OfficeMicrosoft OfficeMicrosoft Office; and then click MicrosoftMicrosoftMicrosoftMicrosoftMicrosoft

Office Access 2007Office Access 2007Office Access 2007Office Access 2007Office Access 2007.  (Henceforth in this chapter we will notify such
sequential operations in a simplified manner as: Start > All ProgramsStart > All ProgramsStart > All ProgramsStart > All ProgramsStart > All Programs

>  Micr>  Micr>  Micr>  Micr>  Microsoft Ofosoft Ofosoft Ofosoft Ofosoft Office > Micrfice > Micrfice > Micrfice > Micrfice > Microsoft Access 2007osoft Access 2007osoft Access 2007osoft Access 2007osoft Access 2007). You will be taken to the
‘Getting Started with Microsoft Access’ Screen as shown in Figure-6.3.
This screen is divided into three sections. The ‘Template Categories’
section on the left is for previewing and downloading standard database
templates. In the centre you will see the ‘New Blank DatabaseNew Blank DatabaseNew Blank DatabaseNew Blank DatabaseNew Blank Database’ section
for starting straightaway with a new database. On the right side is the
‘Open Recent DatabaseOpen Recent DatabaseOpen Recent DatabaseOpen Recent DatabaseOpen Recent Database’ section for opening the existing database files.

Click on BlankBlankBlankBlankBlank

DatabaseDatabaseDatabaseDatabaseDatabase under
central section. This
will open up a dialogue
box on the right
section asking for
database file name.
This dialogue box
could have also been
opened by Clicking on
the O f f i c e  b u t t o nO f f i c e  b u t t o nO f f i c e  b u t t o nO f f i c e  b u t t o nO f f i c e  b u t t o n

located at the upper
left corner of the
screen and then
Clicking NewNewNewNewNew at the
drop down menu (see
Figure - 6.3). Enter the

file name ‘PayRollApplication’ and then click on the CreateCreateCreateCreateCreate button as
shown in Figure – 6.4.

Box - 6.10Box - 6.10Box - 6.10Box - 6.10Box - 6.10

If you have so far worked only with Microsoft Office 97-2003 or its

earlier versions, then the window style that you may find now may

look little unfamiliar. However, this style is now common in all Microsoft

Office 2007 applications. Herein Microsoft makes use of a new results-

oriented user interface through which commands and features that

were often buried in complex menus and toolbars are now easier to

find. The user interface now includes task-oriented tabstabstabstabstabs that contain

logical groups of commands and features in a standard area called

RibbonRibbonRibbonRibbonRibbon.

Figure 6.3: Getting started with Microsoft Office Access
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Instead of the default location
for your database file, you can
also identify your own location
by clicking on the Browse icon
given on the right side of file
name. In New File dialogue box,
you can also accept the
suggested name (in default
folder My Documents) and later
on rename the file and move it
to any other folder of your choice.
File name can be of any length,
and it can include spaces and
even most of the punctuation
marks. Also note that even if you do not type the default extension
“.accdb” with the file name, it will be automatically added by the
application.

Clicking  CreateCreateCreateCreateCreate button
on the New file dialogue
box takes you directly to
the new database window
with the TabTabTabTabTab for
DataSheetDataSheetDataSheetDataSheetDataSheet opened up.
The Figure 5 illustrates
different components of
this active database
window of Access. In the
left side Navigation PaneNavigation PaneNavigation PaneNavigation PaneNavigation Pane

you will see that a default
table (Table 6.1) has
already been created and
the same is also opened up
in the working area of the
window.

Figure 6.4: Dialogue Box for Creating New

Database File

Box - 6.11Box - 6.11Box - 6.11Box - 6.11Box - 6.11

‘Access’ as such is a fully complete application development system

that includes Visual Basic (VB) Programming language and several

other tools for setting up sophisticated applications. Even if you do not

know many of the programming concepts, you can still maximise use

of Access with the help of Access WWWWWizarizarizarizarizardsdsdsdsds that will guide you through

several steps for automatic creation of a database of your choice as

well as linked queries and forms. For better understanding of underlying

concepts, we will mostly use the design tools, and in some cases the

route of Wizards as well as.

Figure 6.5: Illustration of the Active Database Window
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We can straight away start working on this table assuming it to be
our first table. All we have to do is to type an employee name (say ‘Ram
Kishore’) in the second column and click enterenterenterenterenter (or use TabTabTabTabTab) to move to
third column; type a designation ID (say ‘1’) followed by enter;enter;enter;enter;enter; and
finally move to fourth column and type a location ID (say ‘1’) -  as
illustrated in Figure - 6. In this case, Access will automatically set a
data type for each field based on the type of data entered into each
column. You will see that headings of these colums are named as
‘Field1’, ‘Field2’ and ‘Field3’. Move the mouse pointer over the column
heading ‘Field1’ and then double-click to select the column heading.
Type ‘EmpName’ and press enter to change the column name from
‘Field1’ to ‘EmpName’. Similary, change the names of columns ‘Field2’
and ‘Field3’ to ‘DesgID’ and ‘LocationID’. You might have noticed by
now that the first column of the table has the name ‘ID’ which was
created automatically. This is an AutoNumber field in which the field
value is assigned automatically by Access as we enter a new record.
You may see your first record starting with a number different from
the expected ‘1’. Even this number will be replace by the next number
if you delete the record and start afresh. Ignore this limitation as it
may not have any impact on our application. Move the mouse pointer
over ‘ID’ heading; double click to select this heading, and change its
value to ‘EmpID’.

The structure of the ‘Table1’ that you see presently in the Datasheet
View is already complete. At this stage, you can chose to enter the
values of the other records as well. If you are not contended with the
width of any column in your table then with the insertion point
positioned in any record of this column click Home Tab > More (underHome Tab > More (underHome Tab > More (underHome Tab > More (underHome Tab > More (under

RecorRecorRecorRecorRecords Grds Grds Grds Grds Group) > Column Woup) > Column Woup) > Column Woup) > Column Woup) > Column Widthidthidthidthidth. In the dialogue box that appears
with the present value of column width, you can enter a different
value and click Ok; else click BestFit to set the width of column to

Figure 6.6: Creating a Table by Adding Records
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accommodate the longest entry (See Figure 6.7). You can also do this
operation in a simple manner using mouse while in Datasheet View.
Position the pointer on the right column boundary of the selected
column in the header row till the pointer changes to a vertical line
with a left-right-pointing arrow; then double click the left mouse-button
to get the best fit.

Figure  6.7 : Column width adjustment

Did you notice that our first table is still named ‘Table1’ and it has
not been saved yet. Click on the SaveSaveSaveSaveSave button on the Quick AccessQuick AccessQuick AccessQuick AccessQuick Access

toolbar on left hand top corner of window. A Save AsSave AsSave AsSave AsSave As dialogue box will

Figure 6.8 : Saving of the Table with intended Name
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appear with the default table name of ‘Table1’ as shown in Figure - 6.8.
Replace the name with ‘TabEmpDetails’ and press enterenterenterenterenter or clik OKOKOKOKOK

button to save the table with the intended name.

Now let us look at this table in Design View. Click on the View
button placed on the left end of the ribbon (in View group) under the
Datasheet Tab as indicated in Figure - 6.8. The design view of the
current table will appear in the working area of the window as shown
in Figure – 9. In Design View, you can tell Access which all fields will
go into the table by entering desired attributes in the column titled
‘Field Name’. The type of data corresponding to each attribute can be
identified in the column ‘Data Type’. Presently in our case for
‘TabEmpDetails’ table, the field name as well as data type are already
filled up for all intended fields. You may also notice a icon of ‘Key’
appearing before the ‘EmpID’ field indicating it to be the Primary Key
of the table.

For the benefit of laterday referencing, you may choose to record a
brief description of different attributes in the column ‘Description’.
Filling up of description of fields is optional, and has no bearing on the
design of table. Even then it is desirable, especially if your database is
likely to be used by other programers as well. Besides the data type,
there are several other properties that can be set independently for
each field. Appearing as ‘Field Properties’ at bottom part of the design

Figure 6.9 : Design View of the Table
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view, these parameters of a field will vary with the choice of data type.
A narration of each property (when you click the desired property) also
appears in a hint box on right hand side, which makes understanding
of field properties quiet simple. However, we will stick to default
properties of all fields, and ignore this area altogether.

Having fully completed the structure and data of our first table and
also having understood the various conccepts related to its design, we
can now move on and create rest of the four tables. Click on Create
Tab > Table Button as illustrated in Figure – 10. The Data Sheet view
of the default table (Table1) will appear again. You can choose this
view or the Design View to create the rest of the tables and save them
under intended names. For your conveniene, the field names and data
types of all five tables are summarised as under:

Sl. Field Name Data Type Description
No.

1. TabEmpID

EmpID AutoNumber Unique employee ID – Primary Key.

EmpName Text

DesgID Number

LocationID Number

2. TabDesignations

DesgID AutoNumber Unique Designation ID – Primary Key.

Figure 6.10 : Creating New Table
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Designation Text

TA Number Transportation Allowance – fixed as per
designation.

3. TabLocations

LocationID AutoNumber Unique Location ID – Primary Key.

Location Text

RateOfHRA Number % Rate of House Reent Allowance.

4. TabDARates

MonthID AutoNumber Unique MonthID – Primary Key.

SalMonth Text With values as ‘Jan-2007’, “Feb-2007” etc.

RateOfDA Number % Rate of Deanress Allowance.

5. TabMonthly Salary

SalaryID AutoNumer Unique SalaryID – Primary Key.

MonthID Number

EmpID Number

Basic Number Basic pay based on level & attendance of
employee.

DedForPF Number Deduction for PF opted by employee & as
per rules.

Having completed the designs of all data tables, we will now move on
to the task of establishing relationships between different tables. Click
on the Databse ToolsDatabse ToolsDatabse ToolsDatabse ToolsDatabse Tools Tab and then RelationshipsRelationshipsRelationshipsRelationshipsRelationships button under Show/Show/Show/Show/Show/

Figure 6.11 : Creating Relationship between Table
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HideHideHideHideHide group as shown in Figure - 6.11.  In the working area, a ShowShowShowShowShow

TableTableTableTableTable dialogue box will appear as shown in Figure - 6.12. In case you

do not see this dialogue  box click on Design > ShowDesign > ShowDesign > ShowDesign > ShowDesign > Show TableTableTableTableTable. In the

Show TableShow TableShow TableShow TableShow Table dialogue box, select a table and clik AddAddAddAddAdd button to add it

in the relationship window. Add all the five tables in this manner.

Close the Show Table dialogue box by clicking on CloseCloseCloseCloseClose button.

Figure 6.12 : Adding of Tables for Establishing relationships between them

In the working area you will see all five table objects, each detailing

the fields within them. You can reposition these table objects any

where within the relationship window. To do this, point the mouse

pointer in the caption area of the selected table object, hold down the

left mouse button and then drag the mouse to shift table to its new

location as shown in Figure -6.13. Now to create a relationship between

TabMonthlySalary and TabDARates, position the mouse pointer over

MonthID in the TabMonthlySalary table object, hold down the left mouse

button, drag the pointer right to MonthID in the TabDARates, and

then release the mouse button. A Edit RelationshipsEdit RelationshipsEdit RelationshipsEdit RelationshipsEdit Relationships dialogue box

will appear as soon as you release the mouse button. You will notice

that the dialogue box shows relationship type as One-To-Many

(see Figure-6.13).
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Access has determined the relationship type based on the fields
selected for joining the two tables. Click on the CreateCreateCreateCreateCreate button. A black
line will appear joining the two tables at the common field. This line,
also referred to as Join Line, establishes the relationship between
TabMonthlySalary and TabDARates using the common field of MonthID.
Remember,  MonthID forms Primary Key in TabDARates and Foreign
Key in TabMonthlySalary and hence is the relationship One-To-Many
type.  You may now repeat above steps to establish other relationship
between the tables as indicated in Figure - 6.13. The overall relationship
between different tables are summarised as under:

Figure 6.13 : Relationship between different Tables

Table Related Table Common Field Relationship Type

TabDARates TabMonthlySalary MonthID One-To-Many

TabEmpDetails TabMonthlySalary EmpID One-To-Many

TabDesignations TabEmpDetails DesgnID One-To-Many

TabLocations TabEmpDetails LocationID One-To-Many

6.5 CREATION OF QUERY IN MICROSOFT ACCESS

As discussed in Section 4.0, we will now get on to the task of handling
computational fields of ‘DA’, ‘HRA’, ‘TA’, ‘GrossSalary’ and ‘NetSalary’
using Queries. The Queries provide the real power to a database in
terms of its capabilities to answer more complex requests (or
queries). In case of Access, Queries provide the capability of combining
data from multiple tables and placing specific conditions for the
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retrieval of data. In its simplest form, you may consider a Query to be
another tabular view of your data showing information from one or
more tables.

Click on Create > Query Design. A Show TableShow TableShow TableShow TableShow Table dialogue box will
appear with a Query Table in the background as shown in Figure – 6.14.
In case you do not see this dialogue  box click on Design > ShowDesign > ShowDesign > ShowDesign > ShowDesign > Show

TableTableTableTableTable. In the Show TableShow TableShow TableShow TableShow Table dialogue box, select a table and clik AddAddAddAddAdd

button to add it in the relationship window. Add all the five tables in
this manner. Close the Show Table dialogue box by clicking on CloseCloseCloseCloseClose

button. In working area above the Query Table, you will see all five
table objects (with complete list of their fields) along with the one-to-
one relationship that has been established between tables earlier. You
can reposition these table objects in the manner discussed earlier. In
the portion below Table objects, you will see blank columns that
represent columns in the Query results datasheet. These columns (see
Figure – 6.14) are also referred to as the Design GridDesign GridDesign GridDesign GridDesign Grid.

Figure 6.14 : Creation of Query
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In the first column of the design grid, click on the Table row. A
dropdown button will appear on this cell. Click on the button to get the
dropdown list of tables and click on ‘TabMonthlySal’. Now in the same
column, click on Field row and get the dropdown list of all fields in
‘TabMonthlySal’. Click on the ‘SalaryID’ field. In this manner the
SalaryID (from TabMonthlySal) has been selected for view in the Query.
The above operation could have also been done simply by double clicking
the ‘SalaryID’ in the list box of  TabMonthlySal object. You could have
also done this by positioning the mouse pointer on the identified field
of a table object, held down the left mouse button, and dragged it to
the field row of the desired column of the design grid, and then released
the mouse button.

You shall take care to fill different fields from Table object into the
Design Grid in the same order in which you want to display these
fields in the Query Results data sheet. Now select any of the described
methods to fill other columns of the design grid in the specified order
with fields of Month ID (TabMonthlySalary), SalMonth (TabDARates),
EmpName (TabEmpDetails), and Basic (TabMonthlySalary) as
illustrated in Figure - 6.15. In case you may not require the need of
displaying MonthID, you may click on this field at the row marked as
‘Show’ to uncheck the show-check-box. At this stage, if you click on
the RunRunRunRunRun button under ResultsResultsResultsResultsResults group of DesignDesignDesignDesignDesign Tab, you will see the
result of Query displayed with the fields of SalaryID, SalMonth,
EmpName, and Basic. Clicking of ‘Run’ actually tells the Access to

Figure 6.15 : Creation of different Fields in the Query Table
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execute all instructions stored by you in the Query, and to display the
results. You may adjust the column widths by any of the methods
described earlier for Tables. Click on the SaveSaveSaveSaveSave button on the Quick
Access toolbar. At the Save As disalogue box, type QueryMonthlySalary
and click OKOKOKOKOK to save our Query.

Evidently our Query is not complete as we are not seeing the
computational fields and the field of DedForPF in the DataSheet ViewDataSheet ViewDataSheet ViewDataSheet ViewDataSheet View.
Go back to the Design Grid view by clicking on Design View under
Home Tab. In the Design Grid, Click on the Field row of the first balnk
column (after Basic) and type ‘DA: [Basic]*[TabDARates.RateOfDA]/
100’. In this expression, the word ‘DA’ coming before the colun(:) will
be treated as the name of the computational field which will appear as
heading of the column. The rest of the typed part will form the actual
expression which will be evaluated and its value displayed on clicking
of Run command. You may notice that in our expression for ‘DA’, we
have made use of ‘Basic’ field which is already forming a part of Query
by taking it within the square parenthesis ([ ]). We have also made use
of ‘RateOFDA’ field which is not appearing in the Query columns; and
for this we recorded the corresponding Table name as well as Field
name separated by a period (.) within the square parenthesis. It may
be easily comprehendable that the operator ‘*’ and ‘/’ stand for
multiplication and division respectively. At this stage if you click on
the ‘Run’ command, you will notice the last field for ‘DA’ with its
computed values for different employees as per the % DA Rates for
different months.

Come back to the design view (by Clicking Design ViewDesign ViewDesign ViewDesign ViewDesign View button
under ViewsViewsViewsViewsViews Group)  and repeat above listed procedure to fill up the
next field of Query for computing HRA using the expression ‘HRA:
[Basic]*[TabLocations.RateOfHRA]/100’. The next column in the
Query is for the TA field, which is to be included as such from the
Table ‘TabDesignations’ using any of the methods enumerated earlier.
Next, create the field for ‘Gross Salary’ by typing the expression
‘GrossSalary: [Basic]+[DA]+[HRA]+[TA]’. Now we can also include the
field of ‘DedForPF’ from the ‘TabMonthlySalary’. Finally, we shall
include the field of NetSalary using the simple expression ‘NetSalary:
[GrossSalary]-[DedForPF]‘. At this stage, save your Query as instructed
earlier and also run the ‘Run’ command to look back the outcome of
your effort in the Data Sheet View.

While Figure -6.15 gives an illustration of the Design View of our
Query, the Figure - 6.16 shows the Datasheet View of the Query. Your
view may be little different based on the actual data that you have
entered in different tables. As shown in Figure 6.16, you may notice
that the total dataset  of the Query is composed of all data rows
corresponding to the Table ‘TabMonthlySalary’. You may restrict the
dataset to any restricted values for any of the specified field. For
example, we may want only the data corresponding to November 2007,
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for which the MonthID is ‘6’. With this objective, click on the Criteria
row under MonthID field and type ‘=6’ as shown in Figure - 6.17.  Now
if you click on ‘Run’ command, you will see the data records
corresponding only to the month (SalMonth) of Nov 2007’.

Figure 6.16 : Datasheet View of the Query

Figure 6.17 : Setting of Criteria and Sorting of Data in a Query
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For a better presentation, you may also like to sort the records in
ascending or descending order against a chosen field of the Query.
Thus, we may like to arrange the records of Nov.2007 as per
alphabatically ordered names. For this, click on the Sort row below
the EmpName field. Now Click on the pull down button that appears
on the end of the cell and select AscendingAscendingAscendingAscendingAscending (see Figure – 6.17).   Run
the Query and notice that the records are alphabatically arranged as
per names of the employees.

6.6 CREATION OF FORMS IN MICROSOFT ACCESS

So far, we have learned the concepts behind organising the information
in a database using Tables and retrieving such information using
Queries.  Now we will look into the mechanisms for placing information
into the tables as and when the need arises.  The Microsoft Access
provides two primary mechanisms to achieve this goal.  The first method,
which we are already familiar with, is to simply bring up the table in a
window by double-clicking on it and adding information to the new
blank row at the bottom.  We can also make changes in any other row
as one would do in case of a spreadsheet. You can save the changes in
the table by clicking on the SaveSaveSaveSaveSave button on the Quick Access toolbar.

 Box - 6.12Box - 6.12Box - 6.12Box - 6.12Box - 6.12

The Access 2007 provides facility for creation of a Simple Form
wherein you can enter information for one record at a time. Access

also provides tools for creation of a Split Form which shows the

underlying datasheet in one half of the section and a Form in other

half for entering information in the record selected in the datasheet.

The two views in this form are synchronised so that scrolling in one

view causes the scrolling of other view to same location of the record.

As second mechanism for information handling (i.e. for addition,
modification and deletion), the Access provides a user-friendly ForForForForFormsmsmsmsms

interface that allows users to enter information in a graphical form,
and this information transparently passes to the underlying
database. This method is more user-friendly for the data entry operator,
though it may entail a little more work on the part of the database
designer. 

For our Pays Roll Application, let us create a simple Form for the
Table TabMonthlySalary – which is one table likely to be used more
frequently by the bill clerk. In the Navigation Pane of
PayRollApplication, Click once on the TabMonthlySalary. Having
selected the intended Table thus, Click on Create Create Create Create Create Tab     and then on
ForForForForForm  m  m  m  m  under Forms Group.  The Form View of the TabMonthlySalary
will appear in the working area of Window showing first record of the
Table as illustrated in Figure 18. At the bottom of the Form you will
see Navigation bar with buttons for ‘First Record’, ‘Previous Record’,
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‘Next Record’, ‘Last Record’ and ‘New Record’. In the middle of Navigation
bar, you will also see the number of current record (e.g. 1 of 24). Click
on the buttons for Next Record a few times to scroll through a few
records in Form View. You may also click other buttons to understand
their functions. If you click on New Record button, you will notice that
a new record will get displayed with ‘SalaryID’SalaryID’SalaryID’SalaryID’SalaryID’ displaying (New) while
all other fields remaining blank. You may recall that SalaryID is the
Primary Key of this table with AutoNumber as its data type.

Figure 6.18 : Creation of Forms

We can make some changes in the size of data boxes and their
location within the Form. With this objective, let us first change the
view of Form to Design View by clicking on Home > Design ViewHome > Design ViewHome > Design ViewHome > Design ViewHome > Design View. In
the Design View, click on any of the Text Boxes. Move the mouse pointer
to right end of the highlighted boundary of the Box till a Left-Right
arrow appears. Press the Left Mouse button, and holding it there move
the mouse towards left to reduce the width of Text Box to desired size.
You will notice that the sizes of all Text Boxes have reduced
automatically. Now select all text boxes by clicking once on each box
while pressing the Shift key. Now move the Mouse pointer over any of
the box till a sign with four arrows (similar to a + sign) appears. Press
the Left Mouse button, and holding it there move the mouse towards
right to shift the Text Boxes to a more central location.
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We know that in TabMonthlySalary, the field of MonthID is a Foreign
Key. In order to have meaningful values in our final Query (i.e.
QueryMonthlySalary), this field shall contain only those values that
are already stored in TabDARates. We can impose this condition in the
Form while we are in Design View. Click and select the MonthID Text
Box. Keeping the mouse pointer within this Box, click the right mouse
button and select Change To > Combo Box Change To > Combo Box Change To > Combo Box Change To > Combo Box Change To > Combo Box as illustrated in Figure –19.
You will notice that the Text Box of MonthID field will change to a
Combo Box with a pull down button appended at the end of box. With
the MonthIDMonthIDMonthIDMonthIDMonthID ComboBox still selected, click on the Property SheetProperty SheetProperty SheetProperty SheetProperty Sheet

Button under Tools Group. This will open up the Property Sheet of the
MonthID Combo Box as shown in Figure - 6.20. In the DataDataDataDataData Tab of
Property Sheet (which may be already open before you), click on the
combocombocombocombocombo button against ‘Row SourceRow SourceRow SourceRow SourceRow Source’ property to see the pull down list
of Tables; and select ‘TabDARates’. Note that you will be able to see
the Combo option under ‘Row Source’ property, only if, the ‘Row Source
Type’ property is selected as ‘Table/Query’. Ensure that the ‘Bound
Column’ property has a value of ‘1’, which corresponds to the First
Column – i.e. ‘MonthID’ – of the ‘TabDARates’. Having thus reset the
property of MonthID field of the form, change the view to Form View.
You will notice that the Form now shows a Combo Box against the
MonthID field and in its pull down list only those MonthIDs will appear
which are already stored in the TabDARates. You may realise that in
TabMonthlySalary, the field of EmpID also needs to be given similar
treatment; and its values shall be restricted to the values of ‘EmpID’
given in the TabEmpDetails.

Figure 6.19 : Changing of Textbox to a Combo Box in the Form Design View
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Many more changes can possibly be done in our Form to make it
more user-friendly. However, these may entail the use of ‘Macro Builder’,
‘Query/Expression Builder’ and ‘Code Builder’.  These topics are beyond
the scope this book, though you may explore them gradually after
developing familiarity with presently covered areas of Access
programming. You may also develop suitable designs of Forms for other
Tables of the Payroll application.

6.7 CREATION OF REPORTS IN MICROSOFT
ACCESS

Information stored in a Table or Query can be easily printed while it is
in Datasheet view. This can be done by using PrintPrintPrintPrintPrint command given
under Office Button on left hand top corner of the window. Even a
Form view can be directly printed in similar manner. A Report is also
used for the print purpose, though it allows for more flexibility in
selecting the fields to print, and to have more control on the overall
layout and format of the print output. The Report in Access is thus
another object which is designed to print information from the database
on to the screen, or to a file or directly to the printer.

Here also you can take the elaborate route of step-by-step design as
was done in case of Tables, Query or Form. However in this case, you
may find the Report WReport WReport WReport WReport Wizarizarizarizarizard d d d d becoming a more favorable tool as it
guides the designer through a series of dialogue boxes to create the
most suitable Report.

Figure 6.20 : Setting the Properties of Combo Box
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Evidently in our case, we will be interested in generating the Report

for the ‘QueryMonthlySalary’. With this intent, Click on

‘QueryMonthlySalary’ in the Navigation Pane, then click on CreateCreateCreateCreateCreate

Tab, and then on Report WReport WReport WReport WReport Wizarizarizarizarizard d d d d under Reports Group. In the dialogue

box that appears with QueryMonthlySalary Query already selected,

move all fields from the Available FieldsAvailable FieldsAvailable FieldsAvailable FieldsAvailable Fields List Box to the Selected Fields

List Box using appropriate ArrowArrowArrowArrowArrow button as shown in Figure - 6.21.

Click NextNextNextNextNext to see the second dialogue box asking for Grouping Levels.

Here select ‘SalMonth’ and click on the Arrow button (else double click

the ‘SalMonth’) to print data in groups of different salary months (See

Figure – 6.21). Click NextNextNextNextNext to reach the third dialogue box asking for

sorting order of the records. Here you can click on the Pull-down Arrow

next to the first text box and then select ‘SalaryID’ from the drop down

list so as to arrange the records in ascending order of the salary ID

within each data group - as illustrated in Figure - 6.22. Click Next to

see the dialogue box for layout of the Report. Retain the default ‘Stepped’

layout but change the orientation of Report to ‘Landscape’ so as to see

all the columns of the Report in a single page view (see Figure - 6.22).

Again Click NextNextNextNextNext to see the dialogue box for selecting style of Report.

You may choose any style and later on experiment with the others as

well. One more click of NextNextNextNextNext will take you to the dialogue box seeking

the name of Report object. Type ReportMonthlySalary and click on

the FinishFinishFinishFinishFinish button to see the Report appearing in working area of window

in its Print Preview form.

Figure 6.21 : Report Wizard Dialogue Boxes
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You may notice that the extent of data in above designed Report is
limited as per the Criteria laid down in our Query
‘QueryMonthlySalary’. By changing the Query suitably, we can modify
the Report for generating monthly as well as annual Pay Rolls. We can
also change the Criteria of our Query to get individual Report for each
month (i.e. Pay Slip) or for the whole of year (i.e. Annual Statement).

Figure 6.22 : Report Wizard Dialogue Boxes

Figure 6.23 : Adding of Sum Expression in the Report
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We may like to improve the Report further by getting sum total of
all the values under different columns for each group. For example,
we may want to see the total Basic of all employees for November 2007
group. For such modification, open the Report in Design View by Clicking
on HomeHomeHomeHomeHome Tab and then clicking on Design ViewDesign ViewDesign ViewDesign ViewDesign View under Views Group.
In the design view as shown in Figure - 6.23, select the field Basic by
clicking it once. Now click on TotalsTotalsTotalsTotalsTotals under ‘Grouping and Totals’
Group of DesignDesignDesignDesignDesign Tab. In the pull down menu that appears, click on
‘Sum’. You will notice that an expression ‘=Sum([Basic])’ will appear
below the Basic Text Box. You can repeat above steps with other fields
containing numerical (both stored as well as computed) values. Now if
you click on View button (i.e. click Design  > Report ViewDesign  > Report ViewDesign  > Report ViewDesign  > Report ViewDesign  > Report View), you will
see the sum total of each column (with in each group) appearing in the
report as illustrated in Figure 6.24.

Figure 6.24 : Print Preview of Monthly Salary Report

At this stage, close the Report by clicking on the Cross button
immediately above the report. Save the application once again by
clicking on the SaveSaveSaveSaveSave button under Quick Access Bar. Our PayRoll
Application in Access has been completed and saved. You may now
close your application by clicking on the CloseCloseCloseCloseClose button under ‘OfficeOfficeOfficeOfficeOffice

ButtonButtonButtonButtonButton’ or by simply clicking on the Cross button at right-hand top
corner of the window.

2018-19



182

Computerised Accounting System

SummarySummarySummarySummarySummary

• Database Management System (DBMS) provides a variety of software tools
for organising, processing and querying data in a flexible manner.
MS-Access, Oracle, SQL Server, IBM-DB2 are examples of DBMS software.

• In DBMS, data is organised in tables (similar to a file). A table has a
number of rows (or records) and columns (or fields or attributes). Each
row contains a record of information, for example of an account head or a
party or a transaction as per the need. The information in a row consists
of a sequence of columns or attributes, such as transaction number,
transaction date, etc, or it could be party’s name, party’s address, etc.

• One of the tasks in analysis of requirement is to identify and list out the
information required including its elements. These elements of information
become columns (attributes) in appropriate tables.

• Data (set of attributes) should be logically structured so as to put them in
various tables. The goal of such structuring is to reduce data redundancy,
to achieve data consistency as well as to enhance efficiency for adding,
updating and querying operations on database.

• Normalisation is the process for removing data redundancy.

• Since the data stored in different tables may be related, such relationship
is implemented by establishing links between tables. The database created
on the basis of such relationships between different tables is called
relational database.

• Relationship between tables is established with the help of primary key
and foreign key. Primary key consists of minimum possible one or more
than one attributes of a table, which uniquely identifies each row of that
table. Foreign key consists of set of attributes, which from primary key in
another (related) table.

• Most of Computerised Accounting Systems are multi-user systems. These
systems use ‘server database’ unlike single-user (or desktop) systems using
‘desktop database’. In a multi user system, a user interacts with the
software though the user interface, which is also termed as ‘front-end’.
Database, which is kept on a server, is termed as a ‘back-end’.

• MS-Access is an example of ‘desktop database’. Oracle, SQL Server, IBM-
DB2 is examples of ‘server databases’, Desktop databases may be satisfactory
for SOHO (Small Office Home Office) organisations as they offer inexpensive
and simple solutions to many of business data storage and processing
requirements.

• In order to provide security and consistency of data, database is not directly
accessible to users. Any addition or retrieval of information from database
is done by user-friendly programs. Database is thus rightly referred to as
‘back-end’ while the interactive program, that includes user interface, is
termed as ‘front-end’ of a database application.
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EXERCISE

Q1. MULTIPLE CHOICE QUESTIONS

1.  ‘DBMS’ stands for:

a. Drawing Board Management Software

b. Dividend Based Marking System

c. Data Base Management System

d. Data Base Marking Software.

2.  MS Access is a:

a. Word processing Software

b. Presentation Software

c. Spread sheet Software

d. Data Base Management Software.

3. The term ‘field’ as applied to database table means:

a. Vertical column of the table

b. Size  of the table

c. Horizontal row of the table

d. Name of the table.

4.  The term ‘record’ as applied to a database table mean:

a. Vertical column of the table

b. Size of the table

c. Horizontal row of the table

d. Name of the table.

5. The common fields used in a relationship between tables are called:

a. Joint fields

b. Main fields

c. Key fields

d. Table fields.

6. The existence of data in a Primary key field is:

a. Not necessarily required

b. Required but need not be unique

c. Required and must be unique

d. All of above
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7. The existence of data in a secondary key field is :

a. Not necessarily required

b. Required but need not be unique

c. Required and must be unique

d. All of above

8. SQL stands for:

a. Simple Questions Language

b. Simple Que line up

c. Singular Quantity Loading

d. Structured  Que Language

9. The default extension of MS Access (2007) file is :

a. .accbd

b. .exl

c. .doc

d. .exe

10. Wizards in MS Access means

a. Person who developing progamme

b. Tools for simplifying the programme usage

c. Relating between tables

d. Reporting generated by programme.

11. ‘Join line’ in the context of Access Tables means:

a. Graphical representation of relationship between tables

b. Lines bonding the data within table

c. Line connecting two fields of a table

d. Line connecting two record  of a table.

12. In order to retrieve select data meeting a specified criteria from two different

tables of  Access database, we may make use of :

a. Table

b. Query

c. Form

d. Report.
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13. To expect a well formatted printable data  from Access database, we may use:

a. Table

b. Query

c. Form

d. Report.

Q2. ANSWER THE FOLLOWING QUESTIONS

1. What do you understand by DBMS. Give names of two commarly available
DBMS softwares?

2. Differentiate between ‘Desktop database’ and ‘Server database’. List the
criteria that may help you in selecting appropriate database?

3. With suitable example illustrate the meaning of ‘attributes’ as applied  to
database?

4. Why do we seek to split up in formation into different tables rather than
confine it to a single table?

5. What do you understand by terms ‘key field’ , ‘primary key’ and ‘secondary
key’ in a database?

6. List the conventions that you will follow, while naming different fields of a table?

7. What are the uses of ‘query’ object in Access program?

8. What do you understand by ‘Form’ object in Access and how are they useful?

9. What is the purpose of ‘report’ object in Access program?

10. What do you understand by database? What are the ways in which data is
stored and queried in an Access database?

11. What are the advantages of Access over Excel?

12. Describe in brief the function of ‘Table’, ‘Query’, ‘Form’ and ‘Report’ object of
Access program?

Q3. SKILL REVIEW

1. You are starting to plan ahead for you job search. You decide to maintain a
database of company information in Access.

2. Search for at least eight companies. You wish to apply for include company
name, address, telephone and fax numbers. If possible, also include the name
of contact person in their human resorce department.

3. Create job search company safer, accounting database.

4. Open the company information table.

5. Enter at least records for the companies you researched.

6. Adjust column widths, as necessary.

7. Sort the records in ascending order of Name of Company.

8. Preview Table

2018-19



186

Computerised Accounting System

9. Format all record to a smaller font size.

10. Change the page layout so that entire table fit on the page.

11. Close company information table.

12. Close Job Search Company, acedb database.

     ANSWER

    Q.1.
1.  c. 2. d. 3. a. 4. c 5. c 6. c. 7.  a

8. d. 9. a. 10. b. 11. a. 12. b. 13. d.
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